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Copyrights and Trademark Notices
Copyright © 2017 Telestream, LLC. All rights reserved. No part of this publication may 
be reproduced, transmitted, transcribed, altered, or translated into any languages 
without the written permission of Telestream. Information and specifications in this 
document are subject to change without notice and do not represent a commitment 
on the part of Telestream.

Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, Lightspeed, 
ScreenFlow, Switch, Vantage, Wirecast, Gameshow, GraphicsFactory, MetaFlip, and 
Split-and-Stitch are registered trademarks and MacCaption, e-Captioning, Pipeline, 
Post Producer, Tempo, TrafficManager, VidChecker, and VOD Producer are trademarks 
of Telestream, LLC. All other trademarks are the property of their respective owners.

QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the Bonjour logo, 
and the Bonjour symbol are trademarks of Apple, Inc.

MainConcept is a registered trademark of MainConcept LLC and MainConcept AG. 
Copyright 2004 MainConcept Multimedia Technologies.

Microsoft, Windows 7 | 8 | Server 2008 | Server 2012, Media Player, Media Encoder, .Net, 
Internet Explorer, SQL Server 2005 Express Edition, and Windows Media Technologies 
are trademarks of Microsoft Corporation.

This product is manufactured by Telestream under license from Avid to pending patent 
applications.

This product is manufactured by Telestream under license from VoiceAge Corporation

Dolby and the double-D symbol are registered trademarks of Dolby Laboratories.

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.
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Third Party Library Notices
The following notices are required by third party software and libraries used in Episode. 
The software may have been modified by Telestream as permitted by the license or 
permission to use the software.

X264

Episode includes software whose copyright is owned by, or licensed from, x264 LLC.

SharpSSH2

SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. Redistribution and 
use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

SQLite

The SQLite website includes the following copyright notice: http://www.sqlite.org/
copyright.html. In part, this notice states:

Anyone is free to copy, modify, publish, use, compile, sell, or distribute the original 
SQLite code, either in source code form or as a compiled binary, for any purpose, com-
mercial or non-commercial, and by any means.

Libxml2

Libxml2 by xmlsoft.org is the XML C parser and toolkit developed for the Gnome 
project. The website refers to the Open Source Initiative website for the following 

http://www.sqlite.org/copyright.html
http://www.sqlite.org/copyright.html
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licensing notice for Libxml2: http://www.opensource.org/licenses/mit-license.html. 
This notice states:

Copyright (c) 2011 xmlsoft.org

Permission is hereby granted, free of charge, to any person obtaining a copy of this soft-
ware and associated documentation files (the "Software"), to deal in the Software with-
out restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons 
to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in

all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR 
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARIS-
ING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN THE SOFTWARE.

PCRE

The PCRE software library supplied by pcre.org includes the following license 
statement:

PCRE LICENCE

PCRE is a library of functions to support regular expressions whose syntax and seman-
tics are as close as possible to those of the Perl 5 language. Release 8 of PCRE is distrib-
uted under the terms of the “BSD” licence, as specified below. The documentation for 
PCRE, supplied in the “doc” directory, is distributed under the same terms as the soft-
ware itself. The basic library functions are written in C and are freestanding. Also 
included in the distribution is a set of C++ wrapper functions.

THE BASIC LIBRARY FUNCTIONS

Written by: Philip Hazel
Email local part: ph10
Email domain: cam.ac.uk
University of Cambridge Computing Service,
Cambridge, England.

Copyright (c) 1997-2010 University of Cambridge. All rights reserved.

THE C++ WRAPPER FUNCTIONS

Contributed by:   Google Inc.

Copyright (c) 2007-2010, Google Inc. All rights reserved.

http://www.opensource.org/licenses/mit-license.html
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THE "BSD" LICENCE

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of con-
ditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google Inc. nor the 
names of their contributors may be used to endorse or promote products derived from 
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBU-
TORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARIS-
ING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSI-
BILITY OF SUCH DAMAGE.

Boost C++ Libraries

The Boost C++ Libraries supplied by boost.org are licensed at the following Web site: 
http://www.boost.org/users/license.html. The license reads as follows:

Boost Software License—Version 1.0—August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization obtaining a 
copy of the software and accompanying documentation covered by this license (the 
“Software”) to use, reproduce, display, distribute, execute, and transmit the Software, 
and to prepare derivative works of the Software, and to permit third-parties to whom 
the Software is furnished to do so, all subject to the following:

The copyright notices in the Software and this entire statement, including the above 
license grant, this restriction and the following disclaimer, must be included in all cop-
ies of the Software, in whole or in part, and all derivative works of the Software, unless 
such copies or derivative works are solely in the form of machine-executable object 
code generated by a source language processor.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT 
SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE 
FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHER-
WISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE 
OR OTHER DEALINGS IN THE SOFTWARE.

http://www.boost.org/users/license.html
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Libevent

The libevent software library supplied by monkey.org is licensed at the following 
website: http://monkey.org/~provos/libevent/LICENSE. The license reads as follows:

Libevent is covered by a 3-clause BSD license.   Below is an example. Individual files may 
have different authors.

Copyright (c) 2000-2007 Niels Provos <provos@citi.umich.edu> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived 
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.

IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLI-
GENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project

The FreeType Project libraries supplied by freetype.org are licensed at the following 
website: http://www.freetype.org/FTL.TXT. The license reads in part as follows:

Copyright 1996-2002, 2006 by David Turner, Robert Wilhelm, and Werner Lemberg

We specifically permit and encourage the inclusion of this software, with or without 
modifications, in commercial products. We disclaim all warranties covering The Free-
Type Project and assume no liability related to The FreeType Project.

 Finally, many people asked us for a preferred form for a credit/disclaimer to use in com-
pliance with this license. We thus encourage you to use the following text:

Portions of this software are copyright © 2011 The FreeType Project (www.free-
type.org). All rights reserved.

http://monkey.org/~provos/libevent/LICENSE
http://www.freetype.org/FTL.TXT
http://www.freetype.org
http://www.freetype.org
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Samba

Samba code supplied by samba.org is licensed at the following website: http://
samba.org/samba/docs/GPL.html. The license is a GNU General Public License as 
published by the Free Software Foundation and is also listed at this website: http://
www.gnu.org/licenses/. Because of the length of the license statement, the license 
agreement is not repeated here. 

Ogg Vorbis

The Ogg Vorbis software supplied by Xiph.org is licensed at the following website: 
http://www.xiph.org/licenses/bsd/. The license reads as follows:

© 2011, Xiph.Org Foundation

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

•Redistributions of source code must retain the above copyright notice, this list of con-
ditions and the following disclaimer. 

•Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

•Neither the name of the Xiph.org Foundation nor the names of its contributors may be 
used to endorse or promote products derived from this software without specific prior 
written permission. 

This software is provided by the copyright holders and contributors “as is” and any 
express or implied warranties, including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose are disclaimed. In no event shall the 
foundation or contributors be liable for any direct, indirect, incidental, special, exem-
plary, or consequential damages (including, but not limited to, procurement of substi-
tute goods or services; loss of use, data, or profits; or business interruption) however 
caused and on any theory of liability, whether in contract, strict liability, or tort (includ-
ing negligence or otherwise) arising in any way out of the use of this software, even if 
advised of the possibility of such damage.

LibTIFF

The LibTIFF software library provided by libtiff.org is licensed at the following website: 
www.libtiff.org/misc.html. The copyright and use permission statement reads as follows: 

Copyright (c) 1988-1997 Sam Leffler

Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation 
for any purpose is hereby granted without fee, provided that (i) the above copyright 
notices and this permission notice appear in all copies of the software and related doc-
umentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in 
any advertising or publicity relating to the software without the specific, prior written 
permission of Sam Leffler and Silicon Graphics.

http://www.libtiff.org/misc.html
http://samba.org/samba/docs/GPL.html
http://samba.org/samba/docs/GPL.html
http://www.xiph.org/licenses/bsd/
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THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, 
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY 
OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, 
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT 
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

zlib

The zlib.h general purpose compression library provided zlib.net is licensed at the 
following website: http://www.zlib.net/zlib_license.html. The license reads as follows: 

Copyright (C) 1995-2010 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will 
the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial 
applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you 
wrote the original software. If you use this software in a product, an acknowledgment in 
the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepre-
sented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly, Mark Adler

LAME

The LAME MPEG Audio Layer III (MP3) encoder software available at 
lame.sourceforge.net is licensed under the GNU Lesser Public License (LGPL) at this 
website www.gnu.org/copyleft/lesser.html and summarized by the LAME developers at 
this website: lame.sourceforge.net/license.txt. The summary reads as follows:

Can I use LAME in my commercial program? 

Yes, you can, under the restrictions of the LGPL. The easiest way to do this is to:

1. Link to LAME as separate library (libmp3lame.a on unix or lame_enc.dll on windows).

2. Fully acknowledge that you are using LAME, and give a link to our web site, 
www.mp3dev.org.

3. If you make modifications to LAME, you *must* release these modifications back to 
the LAME project, under the LGPL.

*** IMPORTANT NOTE ***
The decoding functions provided in LAME use a version of the mpglib decoding engine 
which is under the GPL. They may not be used by any program not released under the 
GPL unless you obtain such permission from the MPG123 project (www.mpg123.de). 
(yes, we know MPG123 is currently under the LGPL, but we use an older version that 
was released under the former license and, until someone tweaks the current MPG123 
to suit some of LAME's specific needs, it'll continue being licensed under the GPL).

http://www.mpg123.de
http://www.gnu.org/copyleft/lesser.html
http://lame.sourceforge.net/license.txt
http://www.mp3dev.org
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MPEG Disclaimers
MPEGLA MPEG2 Patent

ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 6312 S. Fiddlers Green circle, Suite 400E, Greenwood Village, Colorado 
80111 U.S.A.

MPEGLA MPEG4 VISUAL

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO (i) ENCODE VIDEO IN 
COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO 
THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-
COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED 
TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY 
OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE 
HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE <HTTP://WWW.MPEGLA.COM> FOR ADDITIONAL DETAILS.

HTTP://WWW.MPEGLA.COM
HTTP://WWW.MPEGLA.COM
HTTP://WWW.MPEGLA.COM
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Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
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Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream via telephone at (530) 470-1300.

Part number: 221487

Publication date: May 2017
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Preface
To obtain product information, technical support, or provide comments on this guide, 
contact us using our web site, email, or phone number as listed in .

Telestream Contact Information

Resource Contact Information

Technical Support | 
Information | 
Assistance | FAQs | 
Forums | Upgrades

Web Site: http://www.telestream.net/telestream-
support/episode/support.htm

Support Web Mail. http://www.telestream.net/
telestream-support/episode/contact-support.htm

Telestream Web Site: www.telestream.net

Sales and Marketing Email: info@telestream.net

Telestream
848 Gold Flat Road
Nevada City, CA. USA 95959
530-470-1300

International 
Distributor Support

Web Site: www.telestream.net

See the Telestream Web site for your regional authorized 
Telestream distributor.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document, or other Telestream documents—or if 
you've discovered an error or omission, please email us.

http://www.telestream.net/telestream-support/episode/contact-support.htm
http://www.telestream.net/telestream-support/episode/contact-support.htm
http://www.telestream.net/telestream-support/episode/support.htm
http://www.telestream.net/telestream-support/episode/support.htm
http://www.telestream.net
mailto:info@telestream.net
http://www.telestream.net
mailto:techwriter@telestream.net
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About Episode
About This Guide
This guide describes how to use Episode. Both the Windows and Mac versions are 
included in the same guide for the convenience of users who deploy Episode on both 
platforms. Most screen shots and other illustrations include both versions, Windows on 
the left or the top, and Mac on the right or the bottom. Differences in the text are noted 
with the operating system in parentheses: (Win) or (Mac). Any text not labeled with the 
OS applies to both versions, which is the case for most of the text.

Note: This guide is intended for users of the Episode graphical user interface. Users of 
the command line interface (CLI) or XML/RPC/JSON interface should refer to the 
Episode Advanced User’s Guide.

About Episode
Episode is a powerful application for transcoding video and audio files. It supports a 
wide variety of media formats (both input and output), and enables you to modify 
frame rate, audio levels, and other metrics, and perform many quality-improvement 
operations.

Episode can ingest media files for transcoding directly from local disks, as well as 
network file servers and hardware-based media systems. Episode can save transcoded 
media files locally or on network file servers.

Episode is scalable: It can be installed on multiple computers to form a transcoding 
cluster for parallel transcoding power and maximum speed via Telestream’s unique 
Split-and-Stitch™ distributed encoding technology.

■ Episode’s Major Features

■ Three Episode Editions

■ Episode Components

■ Extended Media Format Support
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Episode’s Major Features
Telestream Episode is an all-in-one, multi-format, cross-platform video and audio 
encoding application for post-production and new media workflows. The following list 
summarizes the most essential Episode features:

• Transcodes many compressed and HD formats: 
AVC-Intra • Blackmagic • D-10/IMX • Discard • DNxHD • DNxHR • DV • DVCProHD 
• H.263 • H.264 (MainConcept) • H.264 (x264) • HDV • HEVC • Image Sequences 
(DPX/JPEG/TGA/TIFF) • JPEG2000 • MJPEG-1/2/4 • Pass Through • RGB Levels • Targa 
Cine YUV • VP9 • Windows RGB • WMA • WMV • XAVC • XDCAM HD • YCbCr Codec, 
and many other formats. ProRes is available for MacOS X and also Windows Server 
2012, for Episode Engine. 

• Now includes 2K and 4K image resizing.

• Both Mac and Windows support 64-bit processing.

• Allows advanced conversions such as NTSC-PAL standards conversion and telecine 
insertion and removal.

• Includes full 4:4:4:4 pro format support for optimum picture quality. 

• Provides an easy-to-use graphical workflow builder with pre-made templates that 
monitors Watch Folders, automatically transcodes files as they are dropped in, and 
delivers them to specified output folders. 

• Supports Adobe Premiere Pro with a plug-in panel that allows you to import and 
select Episode encode and deployment tasks from within Premiere.

• Includes one-click clustering with built-in file sharing and parallel batch processing 
so you can assign multiple Episode instances on networked computers to work on 
transcoding tasks simultaneously, enhancing transcoding speed.

• Provides Split-and-Stitch distributed and segmented encoding that you can use to 
split up a large video file into smaller, segmented encoding tasks that operate in 
parallel. The video segments can be worked on by several nodes in a cluster and 
then stitched back together to more quickly provide finished output.

• Includes fully configurable advanced preprocessing filters, such as black and white 
restoration, HSV and gamma correction, noise removal, image sharpening, as well 
as audio normalization, balance, fade in/out, and others.

• Allows previewing a brief sample of the video output with current settings.

• Allows adding bumper and trailer intro and outro movies to content.

• Permits adding picture-in-picture animation or movie watermarks.

• Greatly improved audio channel mapping with automatic and preconfigured selections. 
Supports 5.1 and 7.1 channel surround sound encoding and easy up/down conversion.

• Optional, licensed Pro Audio option adds support for Dolby AC-3. 

• AAC (HE and LC) audio codec is supported in Episode without Pro Audio.

• Improved closed caption support.
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Three Episode Editions
Episode is offered in three editions, plus an enhanced audio option, to better meet your 
encoding requirements:

Episode—encodes your video files one file at a time and includes many workflow 
options, clustering capabilities, and codecs. For details on supported input and output 
media formats, see Media Containers/Formats.

Episode Pro—adds support for encoding files in parallel, provides the VC-1 codec, 
image sequences, multi-bit rate (MBR) streaming file support and additional output 
formats: GXF, MPEG-2 Transport Streams, and MXF. 

Episode Engine—includes all the formats of Episode Pro and adds maximum parallel 
encoding, plus Split-and-Stitch encoding to fully utilize the power of high-
performance, multi-core computers.

Pro Audio Option—enhances any edition of Episode by adding support for AMR, 
Dolby AC-3, and ATSC A/52.

Episode Components
Generally, you can think of Episode as a desktop program with a graphical user 
interface used to configure workflows and encode media. However, Episode also 
consists of several underlying services—a set of several independent, cooperative 
processes (programs without a user interface):

• Episode Assistant Service performs various user interface support tasks, such as 
processing workflow changes, exporting files, and so on.

• Episode IOserver Service makes files available to other nodes in the cluster.

• Episode Node Service communicates with other nodes in the cluster and starts 
EpisodeWorker processes to perform encoding tasks.

• Episode Client Proxy Service provides the interface between client programs 
including Episode (the graphic user interface program), programs utilizing the 
XML-RPC interface, and the command line interface (episodectl).

• Episode XML-RPC and JSON Services interface between client programs which 
implement the XML-RPC or JSON interface and communicate with Episode Engine.
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Extended Media Format Support
Support for media formats (input and output) can also be extended by installing other 
Telestream components, such as Flip4Mac Windows Media Components.

Episode can also ingest files from Telestream's Pipeline—a powerful, network-based, 
real-time media processing—appliance. For more details, see the Pipeline topic on our 
Web site: www.telestream.net.

QuickTime Reference File Support
Editing systems, such as Avid and Final Cut Pro, can export clips or sequences as 
QuickTime Reference files instead of fully self-contained movies. Generally, the 
reference files are considered intermediate files used to save space and speed up 
processing time. 

QuickTime Reference files include audio, but they do not contain video. Instead, they 
contain pointers and metadata describing the locations and characteristics of video 
and other files. Video editing, processing, and playback systems can process QuickTime 
Reference files as long as the media files they point to remain in the locations specified 
by the reference files and those locations are accessible by the processing systems. 

Episode accepts and processes QuickTime Reference files, subject to the following 
requirements:

• All files referred to by the QuickTime Reference files must remain in their specified 
locations and those locations must be accessible by Episode

• Flatten Video Tracks must be enabled

• Fill Spaces with Black must be enabled

• Render All Video Effects must be enabled

• Premix Audio Tracks must be enabled

• Clips and sequences must contain a single video or audio essence type—mixed 
codec sequences are not supported.

• The timeline must not contain long-GOP media, such as XDCAM clips.

• Data tracks are not exported 

http://www.telestream.net


33
Installing Episode
Use this chapter to install, upgrade, or uninstall Episode, Episode Pro, or Episode Engine 
for Windows or for MacOS X.

During installation and upgrade, it is important to review and perform the tasks in each 
topic in order:

■ Platform Requirements

■ Pre-requisite Subsystems (Windows only)

■ Downloading and Installing Episode

■ Installing an Episode Cluster

■ Installing the Episode Premiere Plug-in

■ Configuring Episode

■ Licensing Episode

■ Upgrading Episode

■ Downgrading Episode

■ Removing Episode from your Computer

Note: Be sure to review and meet platform requirements before installation. 
Telestream recommends that you do not install Episode on a computer that is currently 
hosting FlipFactory, Vantage, or other media processing applications: intense disk and 
CPU consumption can interfere with proper operation of both programs. 
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Platform Requirements
Episode supports the following Windows and Mac platforms. Make sure that your 
computer meets these minimum requirements before installing Episode.

Windows
All Episode editions for Windows have the following minimum system requirements:

• Windows 7, 8.1, 10, or Server 2012 R2: 1.5 GHz, 64-bit, 8 GB RAM

• 256 GB hard drive, 300 MB minimum for program installation

• Bonjour Print Services for Windows v2.0.2

• .NET Framework 3.5 SP1

• .NET Framework 4.5.2

• Online Help Browser Requirements

– Internet Explorer: Version 8 or later

– Firefox: Version 6 or later

Mac
All Episode editions for Mac have the following minimum system requirements:

• Intel-based Mac

• Mac OS X 10.10 and higher

• Minimum 8 GB RAM

• 256 GB hard drive, 300 MB minimum for program installation

• Online Help Browser Requirements: Safari

Cluster Platform Requirements
When running Episode in a mixed-platform cluster, jobs requiring QuickTime are only 
submitted to nodes running on the same platform as the submitting node because 
QuickTime does not support the same codecs across platforms.

All computers in an Episode cluster must be on the same subnet.
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Pre-requisite Subsystems (Windows only)
The following subsystems are required before installing Episode for Windows:

Bonjour for Windows
Episode requires Bonjour for Windows. Before installing/updating Bonjour, stop 
Episode installation if it is in process (if Bonjour is not installed, the Episode installer will 
not complete). Obtain Bonjour Print Services for Windows v2.0.2 or later from Apple’s 
Web site (support.apple.com/kb/dl999), and install it. 

.Net Framework
Episode for Windows requires .Net Framework 3.5 Service Pack 1and .NET Framework 
4.5.2. Before installing/updating .Net, stop Episode installation if in process. Obtain .Net 
from Microsoft’s Web site (microsoft.com).

Next, proceed to Downloading and Installing Episode.

Note: If you stopped installation to install a subsystem, restart the installer.

Desktop Experience
Episode uses the Media Foundation Libraries, which require Windows Desktop 
Experience to be installed. If your operating system is Windows Server 2008 or 2012 
(any revision), enable Desktop Experience in Server Manager. The following procedure 
describes Server 2012. For a more detailed procedure or for the Server 2008 procedure, 
search Server Manager Help for Install Desktop Experience. 

1. Start the Server Manager and click Add roles and features.

2. In the left panel select Local Server.

3. In the right panel, scroll down to ROLES AND FEATURES, click the TASKS drop-
down, and choose Add Roles and Features.

4. Click Next at the wizard information panel, and then select Role-based or feature-
based installation.

5. Click Next twice to select the local server and bypass the Server Roles page.

6. In the left panel, select Features, expand User Interfaces and Infrastructure, and check 
the Desktop Experience checkbox. 

7. Click the Add Features button, if necessary, to install the Desktop Experience 
features. Then click Next.

8. Check Restart Destination Server automatically if required, and click Install. The 
Desktop Experience features will install, and the server will restart.

http://support.apple.com/kb/dl999
http://www.microsoft.com/downloads/details.aspx?FamilyID=ab99342f-5d1a-413d-8319-81da479ab0d7&DisplayLang=en


Installing Episode
Downloading and Installing Episode

36
Downloading and Installing Episode
The following topics separately describe Windows and Mac procedures for 
downloading Episode installers:

■ Downloading the Installer for Windows

■ Downloading the Installer for Mac

Downloading the Installer for Windows
The Episode installer is located on Telestream’s Web site (www.telestream.net/episode/
overview.htm) as a zip file.

When you install Episode, it installs the program and related software, then creates a 
program entry in All Programs > Telestream > Episode. It also places an Episode 
shortcut on the desktop.

Note: If your computer is not connected to the Internet, download the installer using 
an Internet-connected computer and move the installer to the target computer.

To download and install Episode (after verifying that you have met the platform 
requirements and installed the required subsystems), follow these steps:

9. Download the installer zip file (Episode_V_MM_DD_YYYY.zip) to your desktop or 
other folder.

10. Right-click on the folder and select Extract All to run the Extraction Wizard and 
follow the steps to extract the installer files.

11. When extraction completes, Windows displays the extracted files in the new folder 
(Episode_V_MM_DD_YYYY).

12. Open and read the Release Notes text file.

13. Double-click the installer file (Episode<Version>setup.exe) to run the Episode Setup 
WIzard.

14. Follow the steps in the Episode installer to install Episode for Windows.

Note: Be sure to read the entire End-User License Agreement, and only click the I 
accept the terms in the License agreement button and continue if you do agree with 
the entire terms of the agreement.

If installation is interrupted because of a missing or obsolete subsystem, install/update 
the subsystem and then restart the installer.

http://www.telestream.net/episode/overview.htm
http://www.telestream.net/episode/overview.htm
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Downloading the Installer for Mac
Episode for MacOS X is available from www.telestream.net as a disk image (dmg) file.

Note: If your computer is not connected to the Internet, download the installer using 
an Internet-connected computer and move the installer to the target computer. You 
may be asked for an administrator name and password during installation. If you don’t 
have an administrative account, you’ll need to obtain one.

Episode installers are located on Telestream’s Web site (www.telestream.net/episode/
overview.htm).

To download and install Episode after verifying that you have met the platform 
requirements and installed the required subsystems, follow these steps:

1. Download the installer dmg file (EpisodeX.X.X.XX.dmg) to your computer. (X.X.X.XX 
= 3 digit version and 2 digit build number—for example, 7.1.0.26 is version 7.1.0, 
build 26).

2. When you download or open the .dmg file with Safari, MacOS X automatically 
mounts the dmg (if necessary) and runs the installer. When you download a dmg 
file using another Web browser, mount the file yourself.

3. Double-click the dmg to open it.

4. To install Episode, drag the Episode icon onto the Applications icon. When 
installation is complete, close the dmg.

The first time you launch Episode, it displays the license agreement, which you must 
agree to before using Episode.

Note: Be sure to read the entire End-User License Agreement, and only click on I 
accept the terms in the License agreement if you agree with the entire terms of the 
agreement.

http://www.telestream.net
http://www.telestream.net/episode/overview.htm
http://www.telestream.net/episode/overview.htm
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Installing an Episode Cluster
Installing multiple copies of Episode (where each installation is referred to as a node) as 
a cluster requires that all computers in the cluster must be part of the same subnet or 
reachable by IP address or DNS host name of the cluster master. 

Follow the steps for installing Episode on each computer that comprises the cluster.

During operation, each node automatically identifies and communicates with each 
other instance in the cluster.

Each node that you intend to use as an encoder (rather than editing workflows and 
submitting them to other nodes) must be registered.

Note: If you have multiple computers running on an XSAN or other shared storage 
system, Episode may invoke its IO Server and send the media over a slower network 
connection. To prevent this behavior, make sure the shared storages have the same 
mount points on all computers. For more information, see Episode clustering and file 
sharing don’t work.

Installing the Episode Premiere Plug-in
Follow these steps to install the Episode Exporter 2.0 for Premiere Pro CC: 

1. Install Premiere Pro CC on your computer according to Adobe’s instructions.

2. Install Episode on the same computer according to the instruction guide. 

3. Install the Episode Exporter 2.0 on the same computer.

Once installation is complete, the Episode Exporter is ready to use with Premiere Pro CC 
and should simply be present and functioning when you open Premiere Pro CC the 
next time.

Note: The local Episode instance can be a non-licensed copy working in demo mode 
joined to a licensed cluster which performs the encoding. The local Episode can join a 
cluster as a node on the same subnet or join via IP address or host name on a different 
subnet. Submitting a job to a cluster from a local Episode instance that is not a 
member of the cluster does not work; all jobs submitted to a cluster must be 
submitted by a member of the cluster.
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Uninstalling the Episode Premiere Plug-in
On Windows, if you need to uninstall the plug-in, use Control Panel > Programs and 
Features, select the Episode Premiere Pro Plug-in, and select Uninstall.

On the Macintosh, you need to run a special uninstaller program:

1. Open a Terminal window.

2. Type the following to access and run the uninstaller program:

a. cd Library/Application Support/Adobe/Episode/
b. sh uninstall.sh

The plug-in will be removed, but any epitasks you’ve created will remain.

Configuring Episode
In most cases, no special setup is required after you install Episode on either a Windows 
or a Mac system. However, some versions of Windows may require the following 
additional setup steps. 

Windows Server 2012 DEP Setup
When using Windows Server 2012, you may encounter an issue in which the Episode 
application does not have permission to run. To resolve this, you can set the Windows 
Data Execution Prevention (DEP) option to allow Episode to run.

1. Open the Windows System control panel.

2. Select Advanced System Settings. The System Properties panel opens.

3. In the System Properties panel, select the Advanced tab and click Settings. The 
Performance Options panel opens.

4. In the Performance Options panel, select the Data Execution Prevention tab.

5. In the Data Execution Prevention tab, select the top option: Turn on DEP for 
essential Windows programs and services only. This allows programs that are not 
part of the Windows operating system, including Episode, to run without DEP 
monitoring.

Alternatively, if you need the extra security provided by DEP for your other programs, 
you can leave DEP on but enter Episode as an exception that gets excluded from DEP 
monitoring: 

6. Follow the steps above, but select the bottom option in the DEP tab: Turn on DEP 
for all programs and services, except those I select. 

7. Click Add, browse for Episode, and double-click on Episode.exe. The default path 
for Episode is C:/Program Files/Telestream/Episode 7/bin/Episode.exe. When 
properly selected, Episode appears with a check mark in the DEP panel list.

8. Click OK to save the new setting and close the Performance Options panel, and also 
click OK to save and close the System Properties panel. 
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Running Episode as an Administrator
In order for Episode Windows services to run correctly, the Episode user usually needs 
to have Local Administrator or Administrator privileges. If you already have these 
privileges, no further action is required. If you are unsure and need to check or change 
your privileges, follow these steps:

1. In the Windows User Accounts control panel, click Manage User Accounts.

2. In the User Accounts panel, click your user name and then Properties. The Group 
Membership panel opens. If you cannot display this panel, your system 
administrator may need to make this change for you.

3. In the Group Membership panel, select the Administrator button. This assigns 
administrator privileges to your user account.

Running Episode as a Non-Administrator User
For security purposes, your organization may not allow your user account to have 
administrator privileges. 

If Episode is not running under a user with administrator privileges, you cannot make 
changes in Preferences.

When not running Episode as an administrator, an administrator can set Windows to 
run only the Episode services as an administrator from a non-administrator user 
account, although this method of accessing Episode is not recommended and may 
produce unexpected results. 

To set up non-administrator access, an administrator can specify the administrator user 
directly in Episode > Using the Named Storage Tab, or outside of Episode, using the 
Windows Services control panel. The user should now be able to run Episode without 
being an administrator, and Episode itself will log in with administrative rights.
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Licensing Episode
An unlicensed copy of Episode is fully functional and allows you to build workflows and 
submit media for transcoding testing. In a cluster, you can also use unlicensed copies of 
Episode to build workflows and submit media to other nodes which are licensed, for 
transcoding.

Note: Copies of Episode in a cluster that are only used to edit workflows and submit 
jobs do not require that you purchase a license.

However, when encoding without a registered license, Episode places a watermark on 
the video in the output file, and video pass through is not allowed. Episode encodes 
audio files for up to 30 seconds or one half of the duration if less than 30 seconds.

If you need an Episode license, you can get it by contacting Telestream and following 
this procedure: Entering a License Key in Episode.
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Entering a License Key in Episode
These procedures describe entering a license key in Episode:

■ Entering a License Key in Episode for Windows

■ Entering a License Key in Episode for Mac

Entering a License Key in Episode for Windows
Use this section to enter a license Episode for Windows.

1. Select Tools > Preferences and click on the License tab.

2. Click Add to display the Add License panel.

3. Enter the serial number into the Serial Number field.

4. Click OK to activate the license for this copy of Episode, and close the dialog. Then, 
click OK to close the Preferences window.

5. Quit Episode (File > Exit) and re-start it to use it in activated mode.

Click Add to enter a license.

Click OK after entering the license.
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Entering a License Key in Episode for Mac
1. Select Episode > Preferences and click on the License tab.

License Tab

2. Click Add (+) to display the Add License panel.

Add License Panel

3. Enter the serial number into the Serial Number field.

4. Click Activate to activate the license for this copy of Episode, and close the dialog. 
Then close the Preferences window.

5. Quit Episode (Episode > Quit Episode) and re-start it to use it in activated mode.

Click Add (+) to enter a license.



Installing Episode
Upgrading Episode

44
Upgrading Episode
Until Episode support ends on January 31, 2018, upgrades to the latest version may be 
available from Episode Support: http://www.telestream.net/telestream-support/
episode/support.htm. Discounted upgrades from Episode to Vantage may also be 
available. Visit the Telestream site at www.telestream.net/episode/overview.htm and 
click Learn More.

Downgrading Episode
When you upgrade Episode, the license for the old version remains installed even after 
the upgrade. This makes downgrading relatively easy. 

To downgrade Episode to the previous version:

1. Uninstall the upgraded version.

2. Re-install the previous version.

3. The license for the previous version should now be operational. If you later choose 
to upgrade again, the upgrade license is still present and usable; just install the 
upgrade. 

To summarize, after an upgrade, both the old and new licenses remain present on your 
computer, but only the currently operational license is shown. This allows you to easily 
downgrade and upgrade at will by simply uninstalling and re-installing the version you 
need. Licenses are not deactivated or removed until you do so explicitly.

Troubleshooting
If you are unable to activate the older license after downgrading from the current 
Episode to the previous version, follow these procedures:

On Windows delete the following new license file, and restart the app to activate the 
old license again:

C:\Users\$currentuser\AppData\Roaming\Telestream\Episode [new version]\AppState 
\ActivatedLicenses.osl

On Mac OS X delete the following new license file, and restart the services to activate 
the old license again:

~/Library/Application Support/Episode/NodeLicenses

Alternatively, you can uninstall the old Episode version, re-install the new Episode 
version, and deactivate the new version serial number. With the new version 
deactivated, you can uninstall the new version, and then install the old version and its 
license should be operational.

http://www.telestream.net/episode/overview.htm
http://www.telestream.net/telestream-support/episode/support.htm
http://www.telestream.net/telestream-support/episode/support.htm
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Removing Episode from your Computer
These procedures describe uninstalling Episode:

■ Removing Episode from Windows

■ Removing Episode from Mac

Removing Episode from Windows
To uninstall Episode from your Windows computer, display Control Panel > Add/
Remove programs. Select Episode and click Remove.

Note: If uninstalling Episode fails, open the Services control panel and manually stop 
each Episode service, then retry.

If you have installed an Episode cluster (individual copies of Episode on more than one 
Windows computer), perform this task on each computer where Episode is installed. 

For details about removing Episode for MacOS X nodes, see the topic below (Removing 
Episode from Mac).

Removing the Episode program from a computer does not remove any workflows 
you’ve made, or any media you’ve saved on the computer.

Removing Episode from Mac
To uninstall Episode from your Macintosh, follow Automatically Deleting Episode or 
Manually Deleting Episode.

Automatically Deleting Episode
To delete Episode, and automatically delete associated files and folders, follow these 
steps (the EpisodeCleanup.command script is located in the Episode.app. package). 

1. To display the package contents, control-click on the Episode.app file (/
Applications/Episode) and select Show Package Contents from the menu.

2. In the new Finder window, navigate to /Contents/Resources and double click on 
Episode.Cleanup.command script to run it.

3. Follow the text instructions in the Terminal window to run the script.

4. Open a Finder window, and navigate to and delete the /Applications/Episode.app 
file.
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Manually Deleting Episode
To manually delete Episode and associated files and folders, open a Finder window and 
delete the following folders and files:

Note: The ~ character (tilde) in front of a path indicates that this path is in your active 
user’s folder.

/Applications/Episode.app
~/Library/Caches/net.telestream.episode7
~/Library/Application Support/Episode/Assistant.plist
~/Library/Application Support/Episode/Assistant.xml
~/Library/Application Support/Episode/IOServer.plist
~/Library/Application Support/Episode/IOServer.xml
~/Library/Application Support/Episode/Node.plist
~/Library/Application Support/Episode/Node.xml
~/Library/Logs/Episode
~/Library/Preferences/net.telestream.Episode.Workspace.episubmission
~/Library/Preferences/net.telestream.episode.plist

~/Library/Caches/net.telestream.episode7
~/Library/Caches/net.telestream.episode
~/Library/Application Support/Episode 7
~/Library/Logs/Episode 7
~/Library/Logs/Episode
~/Library/Preferences/net.telestream.episode7.plist
~/Library/Application Support/eSellerate
/Library/Preferences/net.telestream.episode7.plist
/Library/Application Support/MindVision
~/Library/Application Support/Episode/*.plist
~/Library/Application Support/Episode/*.xml
~/Library/Application Support/Episode/*-Cluster
~/Library/Application Support/Episode/*-Private

If you have installed an Episode cluster (individual copies of Episode on more than one 
MacOS X computer), perform this task on each computer where Episode is installed. 

For details about removing Episode from Windows nodes, see the previous topic 
(Removing Episode from Windows).

Removing the Episode program from a computer does not remove any workflows 
you’ve made, or any media you’ve saved on the computer.
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Getting Started
The more you know about Episode, the better it can meet your encoding requirements.

The best way to get up and running quickly is to jump right in. In these short guided 
tours, you'll learn how Episode is designed to work.

When you've completed the tours, you'll be ready to design and implement workflows 
for the kinds of encoding work you want to perform.

You'll be able to submit media manually and automatically, and Episode goes to 
work—transcoding and delivering your media—in the right format, to the right place, 
at the right time.

■ Tour 1: Episode Concepts

■ Tour 2: Encoding Your First Media File

■ Tour 3: Editing Workflows

■ Tour 4: Automating Workflows with Watch Folders

■ Tour 5: Cluster Encoding
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Tour 1: Episode Concepts
This tour introduces the main components of Episode. If you haven't yet done so, start 
Episode and take a minute to explore the panels of Episode’s main window.

Main Episode Windows Display

Episode’s main window includes five main panels:

The Media Browser on the left is a two-level panel where you can create and browse 
bookmarks of key directories on your local computer and network servers. These 
bookmarks allow you to gain quick access to the media files and folders you use in your 
encoding workflows.

The top center Library Tasks panel provides tabs for Workflows, Sources, Encoders, and 
Deployments (you’ll be introduced to these in Tour 2). 

Directly below the Library Tasks panel is the Workflow panel, where you can view, create 
and edit workflows—combining tasks into a workflow, which specifies (among other 
things) how to encode a source file and where to save the output file or files. 

The right panel is the Inspector panel, where you review and configure the settings of 
the currently-selected task to customize your workflow.

Status panel.

Media browser panel. Library Tabbed Tasks panel. Inspector panel.

Workflow panel.
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The Status panel displays all of your jobs and their details. On the Mac, the Status panel 
opens in a separate window when you click Submit or select Window > Show Status.

Main Episode Mac Display

Workflows
The way you specify how you want to encode your media in Episode is the workflow. A 
workflow describes where new source files to encode are located, how files are 
encoded, and where the newly-encoded file or files are saved. When a new file is 
identified, a job is created for each source file, containing all the tasks in the workflow. 
Then Episode goes to work - decoding the source file, encoding it per your Encode task 
configuration, and deploying the file to the location you’ve specified.

At a minimum, a useful workflow consists of three tasks: a source, an encoder, and a 
deployment. You can customize all three types of tasks to accomplish your specific 
transcoding purposes.

Media Browser panel. Library Tasks panel. Inspector panel.

Workflow panel.
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Typical Three-task Workflow

A source task may consist of a single file or a list of files. It may also use a Watch Folder 
on local disk, an FTP server, or a network server. New media files placed in this directory 
are retrieved (localized) and encoded. 

Typical Watch Folder Source Task

A Watch Folder (named “Incoming” in the figures) is checked at regular (user-settable) 
intervals for new files. When a file is saved in the Watch Folder, it is identified and a job 
is scheduled for encoding. However, writing the entire media file to the folder takes 
time and the file cannot be encoded until the file transfer is complete, so Episode polls 
the file to see when it has been completely written and released. Only then is the 
encoding job submitted.

While it is possible to set up multiple Watch Folders to watch the same folder, this is 
both inefficient and error-prone. It is better to set up a single Watch Folder for the 
folder you want to watch and connect multiple encoders to that Watch Folder in one 
workflow. 
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Watch Folder with Default Settings
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Encoder Tasks
Each encoder task contains a specification of how a source file should be encoded, 
providing the output file format, which codecs should be used for encoding video and/
or audio data, what filtering operations should be applied to the data and whether or 
not encoding should be performed as a Split-and-Stitch job.

While a workflow always contains a single source task (which may contain multiple 
files), the source can be connected to an arbitrary number of encoder tasks, so that 
each source file is transcoded into multiple output files.

Settings files from earlier Episode versions can be used, but you should always verify 
that they have been correctly imported. For example, if the settings specify the use of 
AAC audio and you don't have the Pro Audio Option, you must adjust the encoder 
accordingly. You should also save legacy settings files to the Library and then drag 
them from the Library to use them; this upgrades the files to the current settings file 
format and changes any discontinued settings to the closest available alternative. 

Typical Encoder Task

Split-and-Stitch Encoding
In Split-and-Stitch jobs, the source media is split into several segments, which are 
encoded in parallel utilizing all available nodes in your cluster. The resulting output 
segments are then stitched back together to form the output file, using all available 
resources to reduce total transcoding time. Formats that have the hinted streaming 
option checked cannot be processed using Split-and-Stitch. These formats are 
automatically encoded as a regular job even if you specify Split-and-Stitch.

Note: In Split-and-Stitch jobs, deployment tasks execute on the same server as the 
stitch task. This is done to minimize network file transfer inefficiencies. The only way to 
disable this feature is to use the XML/RPC interface.

The decision to use Split-and-Stitch depends on what kind of jobs you typically 
encounter. If you have a steady influx of many files, the files will be encoded in parallel 
anyway, so you can make the best use of resources by avoiding the overhead of Split-
and-Stitch. Additionally, if your source files are relatively small, little time will be gained 
from employing Split-and-Stitch.

However, if you have many Episode nodes and you often process single large files, or 
process a few large files simultaneously, and you need them encoded as quickly as 
possible, then Split-and-Stitch is the right choice.

Jobs that shouldn’t be held up by long-running Split-and-Stitch jobs can be run at a 
higher priority, enabling these jobs to go to the head of the queue.
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If you have several Episode installations, you can divide your computers into two or 
more Episode clusters, and dedicate one cluster to high-priority jobs.

Split-and-Stitch Example

Split-
and-Stitch

Split-
and-Stitch
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Deployments
A deployment specifies where the output file from an encoder task is stored. The store 
may be a directory on local disk or a network server, or it may be an FTP-based Internet 
media service. Each encoder task may be connected to multiple deployment tasks, so 
that each output file can be stored in several different places. 

Typical Deployment Task

Tasks
Task is the general term for the activities in a workflow and generally refers to source 
tasks, encoder tasks, and deployment tasks. Episode offers a variety of predefined tasks, 
but you can always modify these tasks (or create your own) and then store these as user 
tasks. Tasks are stored as XML files and can be easily sent to other users.

System tasks are located on your system drive:

• Windows: \Program Files\Telestream\Episode 7\bin\resources\templates\tasks\

• Mac: /Applications/Episode.app/Contents/Resources/templates/tasks/

User tasks are located in:

• Windows: \Documents and Settings\<User>\My Documents\Episode 7\Tasks\.

• Mac: ~/Library/Application Support/Episode/User Tasks/

Predefined System Encoder Tasks
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Nodes
A node is an instance of Episode running on a computer. A node can either run alone or 
it can be associated with a cluster. Any node can create a new cluster, and become the 
master for that cluster. Other nodes joining that cluster become participants. Clusters 
can be accessed on the local subnet or via IP or DNS host name. Jobs submitted at a 
cluster node are routed via the master, which then sends them to a suitable node for 
encoding. 

If a master node leaves a cluster, no additional jobs can be submitted to that cluster 
until the master rejoins the cluster. Also, when the master rejoins, it may not be the 
master, depending on the cause of its leaving the cluster; be sure to check its status 
before submitting jobs.

Cluster Browser Showing Episode Nodes
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Nodes in a cluster can run on both MacOS X and Windows computers. Submitted jobs 
are processed on any available machine according to the job scheduling policy—see 
Setting Preferences.

Note: MacOS X and Windows computers that share a SAN cannot directly share files 
over that SAN because the path structures are different on the two operating systems. 
However, the Named Storage feature of Episode allows files on SANs to be accessed by 
both platforms. Please refer to Using Named Storage on page 134 for details. 

Summary
In this tour, you learned about the main Episode window panels and components: 
workflows, sources and Watched Folders, encoders, deployments, tasks, and nodes.
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Tour 2: Encoding Your First Media File
This tour takes less than 10 minutes and introduces you to using Episode.

Episode provides a wide variety of pre-configured workflows in its workflow library. 
These pre-configured workflows are an easy way to get started, a convenient way to 
encode most media, and allow you to modify the workflow to meet your needs.

Let's encode your first media file, using one of these pre-configured workflows.

1. Select the Workflows tab. 

2. In the menu directly below, select System Workflows > Apple Devices.

Note: If you don’t have enough room to view the list easily, make the main window 
larger or resize your panels to suit your needs.

3. Click and drag the iPhone SD workflow onto the Workflow panel below.

The iPhone SD workflow converts a source file into a format for playback on the iPhone 
and saves the output in the same folder as the source file, with the proper extension. 
This workflow contains a blank source task (far left) and two predefined tasks: an 
encoder task (center) and a deployment task (right).

Typical Episode Workflow

4. Now, let’s add a file to be encoded by this workflow—select it from the Media 
Browser—the panel on the left.

The top part of the browser displays bookmarks, directories that contain your 
media files. Episode by default includes bookmarks for some common media direc-
tories (and you can add your own). To select a file, open a bookmark to display its 
directories and files in the bottom panel. Select the file you want to submit by drag-
ging it onto the File List task in the workflow.

5. Open the Computer bookmark and navigate to a short file of your choice on your 
computer. 

6. Drag and drop the file onto the source box at the far left.

Adding Video to Workflow

Notice that when you drop a media file onto the blank source task, Episode assumes 
you want this workflow to be used for manual submission, so it automatically adds a 
File List task.
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7. Click the Submit button (located at the bottom right corner of the center panel) to 
start the encoding job.

Episode displays the details of all currently-active encoding jobs in the Status panel. In 
the absence of other jobs, your job quickly activates.

Note: If you’re using Episode without a license, Episode displays a License Issue 
window, notifying you that you do not have a license to encode media, and it applies a 
watermark to the video. Click Yes to continue. The Status window opens automatically.

8. Select your job to display its progress (you can also display further details by 
clicking on the triangle).

Status of Jobs

When the job is finished, you can find the output file with an m4v suffix, in the same 
folder as the source file you submitted.

9. Double-click the new output file to play it in QuickTime Player.
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Encoding Multiple Files in the Same Workflow
To encode several files at the same time in the same workflow, select and drag all of the 
source files onto the Workflow Editor (not the source task) panel. Episode adds the new 
file references to the file list (which still includes the existing file), and you can click 
Submit (as before) to encode all files. 

If you want to remove an existing file from the list, click the file list—the file names are 
listed in the far right panel. On Windows, you can click the Delete button next to the file 
name, or right-click on the name and click Remove. On a Mac, you can select a file and 
press Delete or click the minus icon in the bottom right corner of the panel.

Summary
You just learned how to start Episode, how to review a workflow in the Workflow Editor, 
and how to submit a file for transcoding—and transcoded your first file.
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Tour 3: Editing Workflows
As easy as it is to select a pre-configured workflow and encode media, most workflows 
must be modified to meet your particular encoding requirements—adding new tasks, 
making changes to encoding settings, delivering media to a specific directory, etc.

In this tour, which takes less than 15 minutes, you'll learn how to modify workflows by 
adding tasks and changing their settings.

Note: When you make changes to a workflow, Episode displays a diagonal Changed 
banner in the upper right corner of the panel, to indicate that you should save your 
changes.

In addition to encoding one or more files using the same encoder, you can encode files 
with multiple encoders in the same workflow. For example, you can create or modify a 
workflow that simultaneously encodes the same file for iphone and the web.

Adding Encoder Tasks to a Workflow
1. Select the Workflows tab at the top and display the Apple platforms workflows—

select System Workflows > Apple Devices.

2. Drag the iPhone HD workflow to the workflow editor.

3. Select the Encoders tab.

4. From the dropdown menu, select System Encoders, then scroll down and open 
folders, if necessary, to display the encoder you want.

Encoders

5. Drag an encoder task to the workflow editor just below the original iPhone 
encoder. When you drop the encoder template, the new encoder task connects to 
the File List task.
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Adding Encoders to Workflow

6. Now navigate to another encoder (select System Encoders > Web Formats > H264 
MP4 640x360, for example).

7. Drag the H264 task to the workflow editor below the bottom encoder. When you 
drop it, the new encoder also connects to the File List task. 

Notice that the new encoder tasks you just added don't yet have output destina-
tions. Instead of outputting your encoded files back to the source directory, let's 
place the output in another directory.

8. Click and drag the Desktop directory from the Media Browser panel (at the far left) 
and drop it directly onto the deployment task outline to the right of each new 
encoder task to replace it. 

If the encoder already has a destination and you want to add another, drop it below 
the current destination. The new one is added to make the encoder send its output 
to both destinations.

Note: You can also drop tasks on an existing task to replace it with the new one.
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Adding Destinations to a Workflow
Drag the bookmark from here... 

... to here to add it to your workflow.

Drag the bookmark from here... 

... to here to add it to your workflow.
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Editing Encoders
Several pre-configured encoder templates are supplied with Episode, but usually you 
need to adjust their settings to suit your particular application or problem.

9. Select an iPhone HD encoder in the workflow editor. The inspector on the right 
displays the current settings.

Inspector Panel for Encoders

10. Select Video Encoder (Win) or Codec (Mac) in the Output subpanel to display the 
codec parameters in the bottom panel.

11. Change the codec to MPEG-4 using the small (drop-down) arrow at the right of the 
video codec selection.

12. Change the Average Bit Rate to 1600Kbps.
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Saving Encoders
When you change an encoder's settings, the change is immediately effective in the 
current workflow, but the settings in the original encoder template have not changed. 
The next time you add the iPhone HD encoder to another workflow, it has its original 
settings.

This is an easy way to make changes for testing or one-time usage, but if you’ve made 
extensive changes that you want to re-use, you should save the encoder task with its 
new settings to the Library as a different template.

Lets start by renaming the encoder template.

13.  Click on the Task Name field at the top of the inspector, and enter a new name. For 
example, iPhone_1600.

14. Click the Save button at the bottom. Episode displays a dialog.

On Windows, the dialog asks if you want to save the entire workflow, or just the 
encoder task. Click Save Task, confirm the encoder name, and click Save. Episode 
saves the encoder task in User Encoders. Note: if you save any changes to a task 
other than the name, the original task template is modified and saved.

On a Mac, you can determine where to save the encoder (by default, it is saved in 
User Encoders), and also change the name. Click OK to save it.

It may be difficult to find your modified encoder templates among all the others, so you 
can choose User Encoders in the filter menu to display only the encoders you have 
created yourself.

User-modified Encoder Templates
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Saving Workflows
When you make changes to a workflow, you need to save it. When you save a workflow 
(even with the same name as the system template workflow), it is saved in User 
Workflows. To save the workflow using another name, enter the new workflow’s name 
in the Name field at the bottom of the workflow panel.

15. Save your workflow:

– Windows: File > Save Workflow As or Control-Shift-S 

Episode asks if you want to save the entire workflow, or just the encoder task. 
Choose Save Workflow.

– Mac: Save button at the bottom right.

16. Enter a name, and confirm. 

Episode saves your new workflow in Workflows > User Workflows.

Summary
In this tour, you learned how to add new tasks, and learned how to configure them 
using the inspector. You also learned how to save encoders as templates, and how to 
save workflows.

If you want to continue, just jump right into the next tour.
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Tour 4: Automating Workflows with Watch Folders
Manually submitting a file or list of files as input is useful for one-shot encodings, but in 
a production environment you can automatically process source files arriving from 
other users or systems. You can achieve this by using Watch Folders. A Watch Folder on 
local or remote storage is monitored by an Episode workflow. When a file is saved in the 
folder, Episode retrieves the file for processing in the workflow.

Let's configure a workflow with a Watch Folder.

1. Start Episode if it is not already running. 

2. Open Workflows > System Workflows > (choose a workflow).

3. Create a new folder named CaptureMedia on your computer desktop.

4. In the Episode Media Browser panel, click Add Bookmark (+). This creates a new, 
untitled bookmark for a local folder. (You can also create bookmarks for FTP servers 
and network servers).

5. Use the URL Browser (Windows) or the Bookmark Inspector (Mac) Path menu to 
navigate to the CaptureMedia folder. You can also use the drop-down menu to 
create bookmarks on other servers, including an FTP server or network share (and 
SMB server—MacOS X only). 

To connect to other servers, you will need to include your user credentials and a port 
number (default 21). 

If you wish to you use Secure Socket Layer (SSL) encryption for FTP data transfers, select 
an option from the SSL Mode drop-down menu. Off does not use SSL. On enables SSL 
but drops back to unencrypted mode if SSL fails. Force Control uses SSL encryption and 
fails to connect if SSL fails. Force All uses SSL encryption for all traffic.

Adding a Bookmark
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6. To change the name of the bookmark, enter CaptureMedia in the Name field and 
confirm.

7. Drag the CaptureMedia bookmark from the Media Browser panel to the File List task 
in the workflow editor. Because a folder was dragged in as a source task, Episode 
knows you intend to create a Watch Folder.

8. Press Submit to start the workflow polling the Watch Folder for new files. Episode 
displays the Status panel, and your new task is running.

Files that are added to the target directory are automatically submitted to a workflow. 

Summary
In this tour, you’ve learned some advanced tasks—how to make and use bookmarks, 
and how to implement Watch Folders to automate workflow processing.
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Tour 5: Cluster Encoding
If you have multiple copies of Episode running on different computers (nodes) on the 
same network, they can form encoding clusters. In a cluster, encoding jobs are 
distributed to maximize the throughput of the cluster to scale your processing power 
and increase throughput.

Note: When operating as part of a cluster, deployment tasks always execute on the 
same server as the encode task in the job. In Split-and-Stitch jobs, deployment tasks 
execute on the same server as the stitch task. This is done to minimize network file 
transfer inefficiencies. The only way to disable this feature is to use the XML/RPC 
interface.

You can have different editions of Episode in the same cluster, and each one can 
encode as many parallel jobs as its edition allows.

Joining a Cluster
1. If Episode is not running, start it again. 

2. Display the Cluster Browser window to view the clusters on your network:

– Windows: select View > Cluster Browser

– Mac: select Window > Show Cluster Browser

Cluster Browser Window

Notice that your node is identified as currently Working Alone (Mac)/private (Win).

To join a cluster, first make sure you don’t have any jobs running. 

3. Select the cluster you want to join, and choose Join <cluster name> from the drop-
down menu. 

Episode displays a warning: Any jobs currently underway will be stopped. 

4. Click Yes to continue.
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Note: If the cluster you want to access is not on your local subnet, you can access it by 
IP address or DNS host name. Use the gear drop-down menu in the lower right corner 
of the Cluster Browser to select Join or Submit, and enter the address or host name of 
the cluster master.

Joined Cluster 

Your computer has been added to the cluster you selected. You can now submit jobs to 
the cluster, and other machines on the cluster can submit jobs to your machine. The 
jobs are encoded by the best available computer. 

Note: If you want to submit jobs from your machine to the cluster for processing, but 
you do not want to receive jobs from other machines in the cluster, choose Submit 
instead of Join from the drop-down menu.

Summary
In this tour, you learned about scaling up Episode to include several Episode nodes on 
different computers, creating a cluster, and joining each node to the cluster to perform 
large-scale parallel encoding.
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Using Episode
Use this chapter to learn about using the main Episode window and its panels, plus the 
Preview and Cluster windows, setting preferences, and using online help. These topics 
are presented:

■ Episode’s Workflow Window

■ Using the Media Browser Panel

■ Using the Library Panel

■ Using the Workflow Editor Panel

■ Using the Inspector Panel

■ Using the Status Panel

■ Using the Cluster Window

■ Setting Preferences

■ Using the Episode Premiere Plug-in

■ Creating an MBR Streaming Media Project

Note: If you haven’t yet taken the tours in Getting Started, we encourage you to do so. 
It’s a great way to learn the basics of Episode and quickly gain hands-on experience 
using the application. After completing the tours, use these topics as reference, for 
detailed instructions when using Episode.
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Episode’s Workflow Window
The Workflow window () is Episode’s main window, where you perform most of your 
work. You use the Workflow window to create and edit workflows, submit jobs, monitor 
jobs in progress, and manage your source files and output deployments.

The Workflow window is composed of five panels:

• Media Browser

• Library

• Workflow

• Inspector

• Status

You can adjust the size and layout of each of panel by grabbing and dragging its border 
handles to suit your needs (or on the Mac, you can show and hide panels using the 
show/hide icons at the top of the window). 

On the Mac, the Status panel is a separate window that opens when you submit a 
workflow. 

The main window also includes a menu bar at the top, which is discussed in the next 
chapter. 
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Workflow window 

Media Browser panel Library panel Inspector panelWorkflow panelStatus panel
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Using the Media Browser Panel
The left-most panel is the Media Browser panel, a two-level panel where you can browse 
directories and files on your local computer and network servers, and create 
bookmarks for the directories you use most. These bookmarks provide quick access to 
media files and folders to use when creating your workflows. 

Media Browser—Easy Access to Your Media 

You can use the Media Browser panel in the same way you use the Windows Explorer or 
the Mac Finder. 

You can create bookmarks that identify folders on local drives, FTP sites, Wiretap 
servers. You can also create bookmarks for shares and using SMB (MacOS X only) to 
identify network-based media folders. (If the server is not available, of course the media 
files in those directories are not available either.)

Bookmarks and devices are 
listed under their respective 
categories, which you can 
open or close.

Click + to add a new 
bookmark (- to delete  
selected bookmark on Mac) 

Directories and files in the 
selected bookmark.

Enter text strings to filter 
the list.

Click to display icons or list

Select Media to alternately 
show or hide the Media 
Browser. Click Preview to 
open the preview window 
and do a sample encode of 
the selected file using the 
current workflow.
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Storage devices such as internal and external hard drives, USB storage devices, and 
browsable storage on digital cameras are also displayed in the Media browser.

Bookmarks make it easy to submit media for processing. Bookmarks also make it easy 
to configure monitored folders for source tasks and destination directories for 
deployment tasks. Just add the bookmark, configure it with your target directory, and 
drag and drop it in place in your workflow.

You select a bookmark or device to display its files and folders in the bottom half of the 
Media Browser. If the bookmark points to an FTP site, Wiretap server, or network share/
SMB server, it may take a moment to connect.

You can drag media from any bookmark in the Media Browser directly onto the 
Workflow Editor, and then submit it for processing.

On a Mac, you can search for a particular file within a selected bookmark by entering 
part of the name in the search field above the file list.

You can optionally use the arrows (or on a Mac, the show/hide command in the Media 
menu) to expand or collapse the Media Browser panel, which displays on the left side of 
the Workflow window. These topics explain the Media Browser panel:

■ Hiding and Displaying the Media Browser (Mac only)

■ Working with Bookmarks

■ Configuring FTP, Wiretap, and Share/SMB Bookmarks

■ Changing File Views

■ Manually Submitting Files to a Workflow

■ Configuring Source and Deployment Tasks with Bookmarks

Hiding and Displaying the Media Browser (Mac only)
If you need more room to edit a workflow or you’re not using the Media Browser panel, 
you can hide it until you need it again:

• Select Media > Show | Hide Media Browser

• Use the shortcut Option-Command-M

• Click the media icon at the top left of the Workflow window.
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Working with Bookmarks
The Media Browser panel includes buttons and context menus for various bookmark 
functions. You can also access some of these functions in the Media Browser menu at 
the top of the Episode main window.

In Episode, you can bookmark a local folder, FTP, shared, or SMB directory (for network 
and Internet-based locations), and an Autodesk Wiretap directory. These topics explain 
how to work with Bookmarks:

■ Adding a Bookmark

■ Configuring a Bookmark

■ Deleting a Bookmark

■ Working with Bookmark Folders

■ Working with Files in the Media Browser

Adding a Bookmark
To add a bookmark, use one of the following methods:

• Select Media Browser > Add Bookmark

• Click the + Add Bookmark button

• Right-click (Win) or Control-click (Mac) in the Media Browser open area and select 
Add Bookmark.

• Click and drag a folder from Windows Explorer into the top pane of the Media 
Browser (Windows only)

Configuring a Bookmark
Select the bookmark to display its details in the URL Browser (Windows)/Bookmark 
Inspector (Mac) for editing. 

When you update a bookmark’s settings, click OK/Save to save the changes or Cancel/
Revert to abandon your changes.

Configuring a Local Directory bookmark is simple: optionally, change the name, and 
change the location by entering or navigating to and selecting the proper path to the 
directory. 

Configuring FTP, share/SMB and Autodesk Wiretap bookmarks is more complex. For 
details, see Configuring FTP, Wiretap, and Share/SMB Bookmarks.
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URL Browser (Windows) and Bookmark Inspector (Mac)

Deleting a Bookmark
To delete a bookmark, use one of these methods:

• Select the bookmark and press the Delete key.

• Click the Remove Bookmark (-) button (Mac).

• Select Delete (Del-) from the Edit menu (Win), or select Remove Bookmark from the 
Media menu (Mac).

• Right-click the bookmark and select Delete (Win), or Control-click and select 
Remove Bookmark (Mac).

Deleting a bookmark does not delete files or folders. It just removes the shortcut in 
Episode that identifies the source of the bookmark.

Click OK/Save to save changes or 
Cancel/Revert to abandon changes.

Click Edit to view 
and change 
bookmark details
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Working with Bookmark Folders
Right-click (Win) or Control-click (Mac) a bookmark to display a context menu.

Windows Context Menu:

Add as Watch Folder. Add as a Watched Folder source to the current workflow

Add as Deployment. Add the folder as a deployment to the current workflow

Delete Bookmark. Delete the selected bookmark

Refresh. Update the selected bookmark’s folder contents list

Open in Explorer. Open the bookmark in Explorer

Mac Context Menu:

Refresh. Update the selected bookmark’s folder contents list

Reveal. Open the bookmark (if local) in the Finder

Add Bookmark. Add a new, untitled bookmark

Remove. Delete the selected bookmark

Save Bookmark. Save the selected bookmark

Save Bookmark As. Save the selected bookmark under another name

Revert Bookmark. Undo the changes you just made.

When you highlight a bookmark, information about it and additional options display in 
the Bookmark Inspector panel. 

FTP, Wiretap servers, and network share (SMB) servers require configuration in the URL 
Browser to make bookmarks for them (see Configuring FTP, Wiretap, and Share/SMB 
Bookmarks). When these servers are mounted, they are treated as local folders. 
However, the connection is not automatically reinstated if lost or unmounted. For this 
reason, it is better to make bookmarks that connect directly to the remote location.
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Working with Files in the Media Browser
When you click a file in the Media Browser to highlight it, information and additional 
options appear in the Inspector panel, including the option to preview the file in the 
Inspector panel video player for some file types.

To work with a file in the Media Browser bottom panel, right-click the file to view the 
following context menu. (On a Mac only Reveal in Finder appears in the context menu. 
The Preview option is a button above Bookmarks panel.)

Add to Workflow (Win). Adds the file as an input file list to the current workflow.

Preview. Initiates a preview encode of the selected file using the current workflow, and 
places the output file in the default folder specified in Tools/Preferences (Win) or Episode 
Preferences (Mac). 

A Preview window shows an encoding progress bar and presents these controls: 

• Cancel stops the preview encode and closes the Preview window.

• Close when finished automatically closes the window when encoding finishes.

• Close closes the Preview window. 

• Open opens the finished encoded file in your computer’s default video player. 

• Show file in explorer (Win) or Reveal in Finder (Mac) opens the desktop folder and 
highlights the file.

See Previewing Workflow Outputs for a more detailed procedure.

Open in Explorer (Win)/Reveal in Finder (Mac). Opens the folder containing the file.

Open With Associated Program (Win). Opens the file using the program assigned to 
that file type by the operating system.
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Configuring FTP, Wiretap, and Share/SMB Bookmarks
FTP, Wiretap, and SMB/network share bookmarks require more configuration than 
bookmarks for local files systems. (Note that directories on an FTP or SMB/network 
share server running directly on your computer can be configured using a local 
bookmark.)

Episode supports FTPS (encrypted FTP over SSL/TLS) for FTP servers and includes an 
SSL Mode selection controlling how SSL is used.

To configure one of these bookmarks, follow these steps:
1. Click Add Bookmark (+) to create a new bookmark and display it in the URL Browser 

(Win) or Bookmark Inspector (Mac). 

2. In the Inspector/Browser, select the Protocol (Win)/Kind (Mac) menu and select 
Local, FTP, Network Share (SMB), or Autodesk Wiretap. 

3. Configure the settings listed below and click Open/Apply to update the bookmark 
and test your connectivity.

URL Browser (Win)/Bookmark Inspector (Mac) for FTP and Share/SMB
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FTP, Wiretap, and Share/SMB Field Descriptions
Name (Mac). Enter a meaningful name in the text field.

Host (Win)/Server (Mac). Enter the host name or IP address of the server, in the form 
192.168.1.1 | myftpserverdomain.com | myServername. 
Don’t add the smb://, ftp://, or wiretap:// prefix to the server name or IP address.

Share (Win)/Path(Mac). Manually enter the path or navigate to the target folder and 
select it. A network share, for example, C:\folder1\folder2\shared could be named Shared 
assuming Shared is the share name. You can also double-click the folder if it appears in 
the contents box, to add it to the path.

User. Enter the authorized user name to log in to the server. (On a Mac, you should 
include the domain name, for example, AcmeVideo.com/myusername.)

Domain (Win). Enter the domain name for the target share (such as TELESTREAM for 
telestream.net).

Password. Enter password for the user name you supply.

Port. The TCP/IP port number used to connect to the server. Default for SMB: 445, for 
FTP: 21, for Wiretap: 7549.

SSL Mode (FTP only). Controls FTP Secure Socket Layer (SSL) for secure data transfer: 

Off. Disables SSL. All transmissions occur using an unencrypted FTP connection.

On. Enables SSL encryption and falls back to a clear connection if SSL fails.

Force Control. enables SSL encryption and fails to connect if SSL fails.

Force All. Enables SSL encryption and ensures that all traffic is encrypted.

Open (Win). Click Open to attempt to connect. If connection is successful, Episode 
displays the directories in the contents pane.

OK (Win)/Save (Mac). Click OK/Save to update and save the bookmark, or click Cancel/
Revert to cancel the bookmark.

A yellow exclamation icon (below) indicates incorrect server information. If you can 
connect, the Contents list displays the server’s folders. If not, correct the 
configuration and try again. Note: Proxy servers are not supported for FTP. 

Changing File Views
Use the Media Browser Views buttons (in the bottom left corner) to change views in the 
file list.

Icons. Select to view files as icons on a grid. 

List. Select to view files as a list. 

Filtering File Views (Mac). Enter a text string in the search field at the top of the folder 
or file list to filter the list.
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Manually Submitting Files to a Workflow
To manually submit a file to a workflow:

1. Use the Media Browser to open the folder containing the media. 

2. Drag and drop the media files from the Media Browser folder to the Source task, 
which becomes a File List. (You can also drag and drop from an operating system 
folder to the Source.)

3. Click Submit to start processing your workflow.

Note: To add files or a directory from a network location, it is best to create a 
bookmark for that location as described in the next section. Bookmarks completely 
define all information required to access a network location. If you drag a file or folder, 
the location information might be incomplete and the location unavailable.

Configuring Source and Deployment Tasks with Bookmarks
You can easily configure your source and deployment tasks using a bookmark. You can 
add a local, FTP or network share (SMB) directory to a source. You can add a local, FTP, 
Network Share (SMB), or Wiretap directory as a deployment.

Drag and drop the selected bookmark from the Media Browser directly on the source or 
deployment task placeholder. (You can also drag and drop files directly from an 
operating system folder to create local file lists.)

After you add the bookmark to your workflow, you need to configure it for use. For 
configuring source monitors, see Configuring a Watch Folder Source Task. For 
configuring deployment tasks, see Configuring a Deployment Task.

For information on creating and configuring bookmarks, see Configuring FTP, Wiretap, 
and Share/SMB Bookmarks.
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Using the Library Panel
The top center Library panel is tabbed. All of Episode’s workflow resources are stored in 
the library, and organized by Workflows, Sources, Encoders, and Deployments tabs.

Library Panel

Click a tab to see the corresponding lists of system and user resources for each task 
type. For example, to see available encoders, click the Encoders tab, and then click the 
drop-down menu below the tab for a list of system and user Encoder resources.

The Library panel is where you save your configured workflows, and your source, 
encoder, and deployment tasks for use in other workflows. The library is also where you 
browse and display your workflows and individual tasks, making it much easier to 
create and assemble new workflows from predefined tasks without the effort of 
configuring them.

When you see the resource you want to use, click and drag it to a task box in the 
Workflow panel, and the task will use that resource. You can also deploy entire 
workflows (system or user-defined) by dragging and dropping them from the Library to 
the Workflow panel. 

Click to display/Hide the Library panel.

Click to create new, untitled 
source/encoder/deployment 
tasks in the library.

Enter text to filter the 
library items that display.

Resources are itemized by workflows, 
sources, encoders, and deployments.

Items in the selected 
category display here.

Select the 
category 
to display: 
System or 
User

Enter text to filter the 
library items that display.

Resources are itemized by workflows, 
sources, encoders, and deployments.

Items in the selected 
category display here.

Select the category to display: 
System or User

Display as list or icons
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Episode also provides a wide variety of predefined resources in its library. Episode 
provides over 250 predefined encoder tasks for use in your workflows. For a list of all 
library commands, see Library Menu.

The following topics describe library management tasks and topics.

■ Browsing the Library

■ Adding Items to a Workflow

■ Saving Changed Workflows and Tasks to the Library

■ Adding a New Workflow or Task to the Library

■ Removing an Item from the Library

■ Modifying Library Items

■ Renaming Library Items

■ Duplicating Library Items

■ Exporting and Importing Workflows and Tasks

■ Library Context Menu

Browsing the Library
On the Mac only, you can hide or display the Library panel by alternately clicking the 
Library icon (or use the Command-L shortcut, or the Library > Show | Hide menu).

Items in the library are organized by type:

• Workflows

• Source tasks

• Encoder tasks

• Deployment tasks

To view a given type of library item:

Click the tab or select Library > Browse Workflows | Sources | Encoders | Deployments. 

Items of each type are further organized by category. Episode displays the items of the 
selected type, based on the category selected in the Category popup menu, which is 
located directly below the tabs.

All items are categorized as System and User. Items in the System category are provided 
by Episode, and can’t be modified. User items are resources that you’ve created 
yourself. Tasks and workflows are displayed in alphabetical order.

Workflow and Encoder library items are further organized by special categories. For 
example, workflow items have a special Web Formats category. Encoder items are 
subcategorized by file format, usage, and media formats: for example, AAC, XDCAMHD, 
Mobile and Devices, and Streaming.

You can restrict the items that display by using the category menu or entering a search 
term in the search box at top right.
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Adding Items to a Workflow
To add any item in the library to the current workflow, drag the item into the Workflow 
panel (or on Windows, select the item and select the Library > Add to Workflow menu). 
If you drag another workflow from the Library to the Workflow Editor, the previous 
workflow is replaced with the new one.

Changed Banner
Workflows containing unsaved changes display a diagonal Changed banner. 

CAUTION: Changes to workflows are remembered in the workflow editor but are not 
saved until you explicitly save them. 

Saving Changed Workflows and Tasks to the Library
To save a changed workflow to the Library, use one of these methods:

• Select File > Save Workflow As, and select a Library file to replace.

• Right-click the workflow, select Save Workflow As, and select a library file to replace. 

To save a changed task to the Library, use one of these methods: 

• Click the task to highlight it, and click Save at the bottom of the Inspector panel.

• Right-click the task, click Save Task As, and select the library task to replace.

• Click the task to highlight it, and select File > Save Task As and select the library task 
to replace.

• In Windows, you can click and drag a task to a Library tab to save the task. If you 
drag a task to the Workflows tab, the whole workflow is saved.

If you do not save while working, when you quit Episode, a dialog box displays unsaved 
workflows and offers you the chance to save them.

Locations of Saved Workflows
System workflows are stored in these locations: 

• Windows: \Program Files\Telestream\Episode 7\bin\resources\templates\work-
flows\systemworkflows

• Mac: /Applications/Episode.app/Contents/Resources/templates/workflows/

User workflows are stored in these locations

• Windows: \Documents and Settings\User\My Documents\Episode 7\Workflows\

• Mac: ~/Library/Application Support/Episode/User Workflows/\userworkflows
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Adding a New Workflow or Task to the Library
To add a new item to the library from an edited workflow:

1. Select Library > New Source | Encoder | Deployment

Episode creates a new, untitled item of the type selected, and displays its configura-
tion in the Inspector.

2. Configure the item in the Inspector (for details, see the Inspector topic for the 
selected item) and click Save to save the item in the library.

Removing an Item from the Library
To delete an item from the library: 

1. Select the item.

2. Select Library > Remove Item (Control-Delete/Command-Delete). 

3. Click Remove to confirm. 

You cannot delete System items; you can only delete user-created items.

CAUTION: Library items are permanently deleted and cannot be retrieved.

Modifying Library Items
To modify a library item:

1. Select the library item you want to reconfigure.

2. Configure the item in the Inspector.

3. Click Save or Save As to save the item in the library.

System items cannot be saved, but you can modify them and use Save As to save them 
as user items.

Renaming Library Items
To rename a library item:

1. Double-click the item’s name in the library or select the item.

2. Select Library > Rename <Item Type> to edit the name.

You can also rename an item in the inspector. System items cannot be renamed but 
must be duplicated and saved as a user item under a new name.
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Duplicating Library Items
To duplicate a library item:

1. Select the item.

2. Select Library > Duplicate <item> (Control-D/Command-D) to create a new item 
with the same name and an incrementing numeric suffix. 

3. Now, modify the item and rename it.

Exporting and Importing Workflows and Tasks
To export a workflow or an individual task within a workflow as a file, right-click and 
select Export Workflow or Export Task (or select File > Export Workflow or Export Task). 
Workflow files are saved as “episubmission” files, and task files are saved as “epitask” 
files.

You can also import a workflow or task from a previously exported file using the File > 
Import menu.

Library Context Menu
Right-click (or Mac Control-click) a Library panel item to access these commands:

Add to Workflow/+. Adds the selected library task/workflow to the currently edited 
workflow. 

Save As <item>. Save the selected library item as a new item.

Duplicate <item>. Create another instance of the selected library item.

Rename <item>. Rename the selected library item.

Remove <item>. Remove the selected library item from the library.

Delete <item>. (Win) Delete the selected library item. 

Save/Save as <item>.. Saves the currently selected item.

Revert <item>. (Mac) Revert to the last saved version, abandoning all changes since 
the last save.
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Using the Workflow Editor Panel
Directly below the Library panel is the Workflow panel, where you create, edit, and view 
workflows. These topics explain the Workflow Editor Panel:

■ Overview

■ Workflow Panel Context Menu

■ Creating a New Workflow

■ Creating Source Tasks

■ Configuring a File List Source Task

■ Configuring a Watch Folder Source Task

■ Configuring Image Sequences

■ Configuring an Encoder Task

■ Configuring a Deployment Task

■ Setting Workflow Priority

■ Previewing Workflow Outputs

■ Submitting Workflows

■ Using the Cluster Window

■ Passing Through Captions Embedded in the Source

Overview
A workflow in Episode is a series of tasks you assemble in a specific order and configure 
to specify how you want Episode to encode a file and where to save the output. As you 
create workflows, you can name and save them using the File > Save Workflow/As 
menu. 

Workflow Editor with Typical Workflow

Each workflow is a connected set of tasks—encoders and deployments—with an 
optional source. You can configure a workflow to determine how your source files are 
submitted, how to encode them, and where to save the output files.

Click to create a new, 
untitled workflow.

Name of the 
workflow to save.

Use Control-S/Command-S to 
save the workflow.

Click to 
submit the 
workflow for 
processing.

Priority slider or 
value field.
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Workflows are organized left to right with three columns—the sources (clips) to encode 
on the left, the encoders in the middle, and the deployments (destinations) on the 
right. Each box in the workflow is called a task. 

For each workflow, a single source task is permitted. Often it is convenient to save 
workflows without a source task. In this way, standard workflows can be reused, simply 
by placing them in the workflow editor and dragging in a new source. Workflows can 
have multiple encoders and multiple deployments for the output files from the 
encoder.

You can drag and drop local media files from an OS folder, the Media Browser panel, or 
the Library to the source task in the Workflow panel. When you click on a task, its 
detailed information is shown in the Inspector panel.

Note: To add files or a directory from a network location, it is best to create a 
bookmark for that location as described in Configuring FTP, Wiretap, and Share/SMB 
Bookmarks. Bookmarks completely define all information required to access a network 
location. If you drag a file or folder from the OS, the location information might be 
incomplete and the location unavailable.

After creating a workflow, you should provide it a meaningful name using the name 
field at the bottom of the panel, and select File > Save As (Control-Shift-S) or Save 
(Command-S) to save it in the library. Workflows you create are saved in the library’s 
User Workflows category.

You also use the workflow editor to submit media to a workflow for transcoding. You 
can submit media in two ways: manually, by adding it to the source task’s file list, or 
automatically by dragging and dropping files into a directory being monitored by a 
running workflow. (The automatic method works only if the workflow has been 
submitted and is currently running.)

The workflow name you provide displays in the Status window when you submit media 
to it for processing.
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Workflow Panel Context Menu
The workflow context menu offers quick access to workflow options.

To display the workflow context menu:

Right-click (Win) or Control-click (Mac) in the Workflow panel to access these 
commands:

Preview. Displays the Preview window and performs a sample encode of a file. If two or 
more files are in the file list, the latest one added is encoded. See Previewing Workflow 
Outputs for details.

Save Task As. When a task which has unsaved changes is selected, saves the task in the 
library.

Save Workflow (Mac). Saves the existing workflow to the Library, replacing the 
previous version.

Save Workflow As. Saves a workflow to the Library (User Workflows) using the name 
you specify in the save as dialog.

Revert Workflow (Mac). Reverts to the version of the workflow currently saved in the 
Library. All changes made since the last save are lost.

Export Task. When a task is selected, displays the Save As dialog. Enter a name for this 
task or use the existing name, select a location, and click Save to save the task as a 
*.epitask file.

You can save these files as archives, or move them to another Episode installation and 
add them into the library for use in that copy of Episode. 

• Export Workflow. Displays the Save dialog. Enter a name for this workflow or use 
the existing name, select a location, and click Save to save the workflow as a *.epi-
submission file. 

You can save these files as archives, or move them to another Episode installation and 
import them into the library for use in that copy of Episode.

• Delete (Win). Deletes the selected workflow or task.

• Select All (Win). Selects all tasks in the workflow.

• Set as Deployment for All Encoders (Win). When a workflow has multiple encod-
ers, select to add the selected deployment to all encoder tasks. 

• Submit Workflow. Submits the workflow for processing, and displays it as a job in 
the Status panel. 

• Submit as MBR. Submits the workflow for processing as multi-bit-rate jobs and dis-
plays them in the status panel.
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Creating a New Workflow
To create a new workflow:

1. If you’re working with another workflow, click Clear. If you are working on a 
changed workflow, Episode reminds you to save your changes. Episode clears the 
workspace and creates a new, untitled workflow.

2. Name the workflow using the name field at the bottom, and click File > Save As 
(Win) or File > Save (Mac) to save it in the library (User Workflows category).

Note: From now on, to save changes to your workflow, you can right-click (Win) or 
Control-click (Mac) and select Save Workflow As from the context menu. This allows 
you to save over the existing saved workflow or save the workflow under a new name.

Each workflow has three task placeholders: Source, Encoder, and Deployment.

3. Configure your source task by dragging files from an OS folder, from bookmarks, 
from the media browser, or from the library’s Sources tab onto the source task 
template.

4. Configure your encoder tasks by dragging an encoder from the library’s encoder 
tab onto the Encoder task.

5. Configure your deployment tasks by dragging bookmarks from the media browser 
or deployments from library’s Deployment tab onto the deployment task template.

To remove an object from the workflow, select the object, and press Delete.

After configuring your workflow (or even during the design process if you choose), you 
should configure each task. You configure each task by selecting it and updating its 
settings in the Inspector.
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Creating Source Tasks
You can create file list source tasks by adding files from the OS or adding bookmarks 
from the Media Browser—dragging and dropping them onto the source task box in the 
Workflow Editor. When the workflow is submitted for processing, the files are processed 
in a queue. Files in a file list can remain in a processing queue for up to 7 days, after 
which, they time out.

Note: You can only drag and drop files from the OS if they are on local storage. If you 
are using a network volume, you should create and configure a network watch folder 
to accept files from this location.

You can also create watch folder source tasks to continually monitor watch folders and 
submit files in real time, as they are written into the target folder. You can configure a 
watch folder to poll a local directory, or an FTP, network share/SMB, or Autodesk 
Wiretap server location. 

Folders are continually monitored for activity for one year, with the timer restarting 
each time a new file is added; if there is no activity after a year, monitoring stops.

To create a watch folder: 
1. First add a bookmark. 

2. Then select Media Browser > Add Bookmark (+). 

3. Select the new, untitled bookmark to display it in the Inspector panel on the right.
You can name the bookmark, specify the type of watch folder (Local Directory, FTP, 
Network Share (SMB), or Autodesk Wiretap), and manage its files in the Inspector 
panel. Naming is necessary only if you plan to save it in the Library. Just click the 
task to see its Inspector panel.

4. Once the bookmark is created and specified, drag it to the source task in a workflow 
to make it a watch folder.

Note: Episode replaces the existing source when you drag and drop a new source 
folder onto the source task. If you drag and drop a file onto a file source, the new file is 
added to the file list. If you drag and drop a folder, a Watch Folder is created, replacing 
the previous source, if any.

In summary, to encode multiple files using one workflow, you have two options. You 
can place all the files in a single watch folder where Episode will automatically pick 
them up and encode them. Or you can keep all the files in separate (non-monitored) 
folders and drag the individual files you want encoded into a source file list and 
manually submit them for processing.
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Configuring a File List Source Task
To view/edit the details of a file list task:

1. Click the task in the workflow to select it and view its details in the Inspector panel.

2. Make changes in the Inspector. Changes are saved automatically as they are made.

File List Inspector Panel

The following options are available:

• Task Name. Enter a meaningful name in the text field.

• Files. To add files, you can drag and drop files from your bookmarks or the OS 
directly onto a file list task. You delete files from the task by selecting the file in the 
inspector’s File list and clicking the delete (Minus/X) button.

Configuring a Watch Folder Source Task
To configure or view a Watch Folder task in the inspector, click the source task in the 
workflow to display it in the Inspector panel. 

Episode provides the following types of watch folders:

■ Local Watch Folder

■ FTP, Network Share/SMB/Autodesk Wiretap Watch Folder
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Local Watch Folder 
Task Name. Enter a meaningful name in the text field.

Local Watch Folder Inspector
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General
Watch Folder. Click to display the Media Browser dialog, and navigate and select a 
directory to monitor. Folders are monitored for activity for one year, with the timer 
restarting each time a new file is added; if there is no activity after a year, monitoring 
stops.

Pickup Present Files. Check to specify that files already present in the directory when 
the workflow is submitted for execution are encoded. If unchecked, only files added 
after starting the workflow are encoded.

Advanced
Adaptive Safety Threshold. Select the threshold setting to adapt to the update 
behavior of the file system. Off: the Safe delay is strictly used. Normal and Double: 
Episode dynamically adapts the delay to the detected intervals between file updates. 
Use Double if the watch folder often submits unfinished files.

Watch Folder Poll Interval. Specify in seconds how often to check for new files in the 
watch folder.

File Safety Delay. Specify in seconds how long a file has to remain unchanged (file 
transfer is complete) before being submitted.

Recursion Depth. Set how many folder levels directly below the monitored directory 
to poll when searching for files to encode.

Retry Max Attempts. Set how many times to try to monitor the watch folder before 
failing. For example, your computer might be monitoring a Windows share, or an SMB 
folder, but your computer is disconnected from the network.

Encode while ingest. Check to encode TIFO streams from Telestream Pipeline.

File Filter. Click Add to add sets of filter criteria. Use the filter criteria drop-down menu 
and the text entry field to select a term to filter directories, files, or extensions in or out.

Workflow Success Actions. Set actions following a successful encode.

Remove source file. Check to delete the source files after encoding

Move source file. Set a directory where the source files are moved after encoding. Click 
to display the file system browser, and navigate and select a directory. If none is 
specified, the source files are not moved.

Workflow Failure Actions. Set actions following an unsuccessful encode.

Move source file. Set a directory where the source files are moved after failing to 
encode. Click to display the file system browser, and navigate and select a directory. If 
none is specified, the source files are not moved.

Stop other encodes. Stops all other encodes in this workflow.
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FTP, Network Share/SMB/Autodesk Wiretap Watch Folder
Add a bookmark pointing to a folder on an FTP server, network share, SMB, or Autodesk 
Wiretap location as follows:

1. In the Bookmarks panel, right-click and select Add Bookmark. 

2. In the URL Browser (Win) or Bookmark Inspector (Mac), make settings to access the 
bookmark location. Setting details are described below.

3. Click Save at the bottom of the inspector. 

When you make the above settings and save them, you are saving the connection 
details for the bookmark. Episode can then access the remote folder when it runs a 
workflow that contains the bookmark as a Watch Folder. 

To add the bookmark as a Watch Folder follow these steps:
1. Drag the new bookmark to the Source icon in a workflow to create a Watch Folder 

for the bookmarked location. 

2. Edit the settings in the Watch Folder Inspector for the new Watch Folder.

FTP/Network Share (SMB)/Wiretap Server Watch Folder Setup
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Name. Enter a meaningful name in the text field.

Kind. Select File Transfer Protocol (FTP) | Network Share (SMB) | Autodesk (Wiretap) 
from the popup menu. 

Note: When you select Wiretap, the Username, Password, and Save password controls 
are hidden.

Server. Enter the name of the server. (or localhost if running on this computer.) Do not 
use slashes—just enter the server name. For example: ftp.telestream.net

Port. Enter the port number for the server. In most cases the default port is correct.

Username (FTP/SMB only). Enter the username of the FTP account you’re using

Password (FTP/SMB only). Enter the password for this account, if any.

Save Password in Keychain (Mac FTP/SMB only). Check if you want Episode to save 
the password.
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Path. Enter the path to the folder you want to watch. Start the path with a back slash (\). 

Save. Click Save to save the bookmark settings. Once you click save, other settings 
display in the panel. 

General
Watch folder—use the browse button or directly edit the path to select the folder you 
want to watch.

Pickup present files—check this option if you want to pick up and process files 
already in the watch folder.

Advanced
Adaptive Safety Threshold. This is an amount of time Episode automatically adds to 
the Safe Delay wait time to ensure that a file has been completely written to the watch 
location before encoding. Set to Off if you have a fast network or are working locally on 
a fast machine. Set to Normal for a typical network, and set to Double if the network 
tends to be slow or you have trouble with files being picked up and encoding 
attempted before the files are done being written. 

Watch Poll Interval (sec). Enter the number of seconds Episode should wait between 
checks of the watch folder to detect new or updated files. The default is 2 seconds. 

File Safety Delay (sec). Enter the number of seconds Episode should delay after 
detecting no changes in a new or updated file before encoding the file. This ensures 
the file is done being written before encoding.

Recursion depth. Set how many folder levels directly below the watched folder to poll 
when searching for files to encode.

Retry Max Attempts. Enter the successive number of times Episode should attempt to 
connect and properly process the folder before stopping. 

SSL Mode. Enables or disables FTP Secure Socket Layer (SSL) for secure data transfer: 

– Off—Disables SSL. All transmissions occur using an unencrypted FTP connection.

– On—Enables SSL encryption and falls back to a clear connection if SSL fails.

– Force Control—Enables SSL encryption and fails to connect if SSL fails.

– Force All—Enables SSL encryption and ensures that all traffic is encrypted.

Note: Displaying network-accessible folders, and local folders containing significant 
volumes of files (for example, 100 or more) can take considerable time and network 
bandwidth. To prevent problems including failed jobs, consider setting the Watch Poll 
Interval to 10 seconds (or more as necessary), and increasing the File Safety Delay to 3 
times the watch poll interval: In this example, 30 seconds.
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Configuring Image Sequences
Episode Pro and Engine include the ability to encode numbered image sequences, 
such as those produced in compositing or animation, into a movie in virtually any video 
format available in Episode. This feature has been present in the command line for 
quite some time, and now it is available in the user interface as well.

These are the accepted image input file formats: DPX, TGA, TIFF, and JPEG. Formats 
cannot be mixed in the same job. 

There are two methods for creating an image sequence workflow: (1) drag and drop a 
file in an existing sequence on the Source task in a workflow, or (2) set up a Watch 
Source task on a folder that will receive the sequence input files. 

To drag and drop an image sequence:
1. Windows: Select File > New > Source > Image Sequence. 

Mac: Select File > New Task > New Source, and drag the Image Sequence from the 
Sources list to the Source task.
Both: Click Sources and drag the Image Sequence from the Sources list onto the 
Source task. 

The Source task changes to Image Sequence and an untitled Image Sequence 
inspector panel opens.

2. Give the image sequence a Task Name and fill in the other inspector fields (see 
Image Sequence Selections below for details). 

3. Drop an image from the sequence onto the workflow Source task. 

4. Select and configure a video encoder in the workflow Encoder task.

5. Select and configure the workflow Deployment task for the output location.

6. Submit the workflow to start encoding the image sequence.
Episode recognizes all the images in the sequence based on the numbering (all 
must be in the same folder) and processes them in the workflow.

To create an image sequence Watch on a folder:
1. Windows: Select File > New > Source > Watch folder.

Mac: Select File > New Task > New Source > and drag the Watch Folder from the 
Sources list to the Source task.
Both: Click Sources and drag the Watch Folder source onto the Source task. 

2. Check the Image Sequence option in the inspector panel, give the Watch Folder a 
Task Name, select the watch folder, and fill in the other inspector fields. 

3. Select and configure a video encoder in the workflow Encoder task.

4. Select and configure the workflow Deployment task for the output location.

5. Submit the workflow to start watching the folder for image sequences.
When image sequence files are dropped into the source folder, Episode processes 
them.
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Image Sequence Selections
Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default 
value is 1, meaning that one missing number in a sequence is treated as the end of the 
sequence. If set to another number, that number of sequence numbers must be 
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the 
sequence before processing of the file begins. This does not apply to the first file in a 
sequence. This only has practical implications if Encode While Ingest is enabled. Setting 
this to 0 (zero) may significantly decrease the time the encoder has to wait when the 
end of the sequence is reached, but depending on file system and file format, may 
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device 
that produces an image sequence over time. Wait times between received files can be 
specified in the following wait fields. 

Encode while ingest waits (sec). Specifies the number of seconds to wait before 
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to 
wait for files during encode while ingest. The default is 5 times. If no files are received 
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum 
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.

Revert. Restores the Image Sequence settings to what they were before they were 
changed.

Save As. Saves the Image Sequence configuration to a file.
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Configuring an Encoder Task
The encoders task box only accepts encoders. An encoder defines how the source is to 
be transformed (encoded) by the codec using the settings you choose. You drag and 
drop preset encoders from the Encoders tab or from folder. In Windows, you can also 
create a new default encoder with the File > New > Encoder menu.

To add encoders to a workflow:

You can drag and drop multiple encoders into a workflow. As you drag and drop them, 
they all connect to the source task. All files in the source are encoded with each 
encoder in the workflow.

You can also add a new, untitled encoder task to your workflow by selecting File > New 
(Task) > (New) Encoder (Mac: Command-N).

Because of the complexity of configuring an encoder task, it may be simpler and faster 
to select a similar encoder from the library and make changes in the Inspector.

To view and change encoder settings:

Select the encoder and view its settings in the Inspector panel. In the Inspector, you can 
set Format options, including Container, Video Encoder, Audio Encoder, In/Out points 
(on your source file), Timecode to use, Intro and Outro, etc. When you’re done, click 
Save As to save the encoder under a new name.

Configuring a Deployment Task
Deployment tasks are similar to watch folders in that they reference directories, locally 
or on a server. Episode supports multiple deployments per encoder.

If you have several encoders, each of them has its own set of deployment tasks. 
Therefore, if you want all new files in the workflow to be saved in the same directory, 
you should add the same deployment to each encoder. Add the deployment task to 
one encoder, and then right-click (Win) or Control-click (Mac) on the deployment task 
and select Set as Deployment for All Encoders from the context menu.

To deploy the output from a single encoder to multiple locations:

Drag and drop the appropriate deployment from the library near the right edge of the 
target encoder to connect it to the encoder.

To view and change deployment settings:

Select the deployment and display the Inspector panel. 
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Setting Workflow Priority
You can set workflow processing priorities so some workflows process ahead of others.

To set workflow processing priority (-10 to 10):

Use the slider, or enter the value in the field to the left of the Submit button. (Currently-
executing jobs are not affected.)

Previewing Workflow Outputs
The Preview feature takes a sample from the middle of your input media file and 
encodes a small portion of the file using the current workflow to give you a quickly 
encoded output sample. You can examine the sample to ensure the workflow is 
producing the results you desire. 

To generate a preview sample file, follow these steps:

1. Completely configure your workflow as desired, including all filters.

2. On Windows, click the workflow Encoder to set it as the focus.

3. Select View > Preview (Win) or Window > Generate Preview File (Mac).

A Preview window () opens and shows progress as Episode produces a workflow output 
sample file. The output file is placed in the default folder specified in your Preferences > 
General settings. Repeated previews cause incrementing of the preview file name to 
prevent overwriting the file.

Note: Preview jobs are submitted with the highest priority. However, if existing jobs 
are already in process, preview jobs may be delayed until the processing jobs finish.

4. Click the Open button to open the output file in your default video player, or click 
Show File in Explorer (Win) or Reveal in Finder (Mac) to see the file in its folder.

Preview Window

Note: Episode uses your computer’s default video player for viewing Preview outputs. 
To preview outputs, download and install a video player of your choice and set it up in 
your OS to open the video file types you need to view. 
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Telestream’s Switch player (http://www.telestream.net/switch/overview.htm) 
integrates smoothly with Episode, as shown in the following figure where Switch is 
used to preview captions processed using Episode.

Preview of Captions Processed in Episode, Displayed in Switch



Using Episode
Using the Workflow Editor Panel

104
Submitting Workflows
Workflows do not begin encoding media until they are submitted for processing.

To submit media for processing:
1. Display the workflow you want to use in the Workflow panel. (Make sure it is saved).

2. Click Submit to submit it for processing. You can also select (Win) Tools > Submit 
Workflow or (Mac) select File > Submit Workflow (Command-R). 

If this workflow has a file list as a source, the files are queued and each is encoded as 
soon as other jobs ahead of it are complete, or there is a free slot in the cluster you 
are attached to. If the source is an watch folder, the job is activated, and encoding is 
performed whenever there are files to be processed in the watched folder.

Note: You may notice the Submit As MBR selection in the Tools, File, and context 
menus. This submits a job to produce a streaming multi-bit-rate output. However, 
workflows for streaming outputs must follow certain configuration requirements. For 
a complete procedure to create a streaming media workflow and submit it, see this 
topic at the end of this chapter: Creating an MBR Streaming Media Project.
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Using the Inspector Panel
The right-most panel is the Inspector panel. The Inspector displays configuration details 
about selected items and enables you to change their settings.

Note: You can only change user items, not system-defined items.

The Inspector panel’s title and contents change as you select different objects, allowing 
you to review and configure the settings of the selected object—a bookmark, a library 
resource, or a task in your workflow. For example, when you select a bookmark, the 
Inspector displays details for the bookmark, including its name and file path. When you 
select an encoder in the library or the workflow, the Inspector displays the details about 
the selected encoder, such as specifics and selections regarding the format, video, and 
audio. You can also enter metadata, or set up a Split-and-Stitch job.

Split-and-Stitch (at the bottom of the Inspector panel when an encoder is selected) 
allows you to distribute processing of a long source clip to multiple computers in your 
Episode computer cluster. By allowing multiple computers to work simultaneously on a 
piece of the clip and then stitch it back together into a single clip when they are done, 
processing time can be sped up greatly. 

The Split-and-Stitch subpanel allows you to set the minimum duration of a clip before 
Split-and-Stitch will be used and also set the maximum number of video splits or pieces 
to divide the clip into.

To use the Inspector:

Select the workflow task, bookmark, or file you want to inspect, and the display 
automatically changes to show the appropriate Inspector view in the right panel. On 
the Mac, the Inspector panel can be hidden or revealed by clicking the Inspector icon 
(top right) or by selecting Inspector > Show/Hide Inspector (Command-I). 

To save an edited item in the Inspector:

After you edit an item, you can save changes by clicking the Save/Save As button at the 
bottom of the panel or selecting the Save Task As context menu—right-click (Win) or 
Control-click (Mac). On the Mac you can also use the File > Save All menu. If you change 
your mind before saving it, just click the Revert button—this restores the item to the 
last saved version (if the workflow or task was previously saved).

These topics describe the Inspector panels

■ Using the Media Inspector

■ Configuring Source Tasks

■ Configuring Encoder Tasks

■ Configuring Deployment Tasks

■ Configuring Closed Captions
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Using the Media Inspector
The Media Inspector displays when you navigate to and select a media file in the Media 
Browser. The Media Inspector provides a preview player, and displays an icon when you 
are previewing media with only an audio track, along with file details. If Episode cannot 
load the selected file, it displays an error message.

Media Inspector Panel 

The Media Inspector provides the following fields and controls:

File Information
The name, path or URL, size, duration, and other details about the file you’re inspecting 
are displayed.

Video and audio track details are also displayed. This information can assist you in 
applying filters, and setting up encoding configurations.

Note: FTP and Wiretap sources are not analyzed.
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Player Controls
Audio Volume . Hover over the speaker icon to the left of the scrubber to display the 
audio volume control. Drag the volume control button to decrease or increase volume. 
On Windows, you can mute the volume by clicking the speaker icon (a red icon appears 
over the speaker); click the speaker again to turn the audio back on (red disappears). 

Play/Pause . Click the Play button to preview the file at normal speed; click it again to 
pause it. 

Scrub  . Drag the scrubber button to move forward and backward in the file.

Loopback (Win) . Click the Loopback button (to the right of the play bar) to loop the 
file back to the beginning at the end of the preview; click it again to disable loopback.

Forward/Reverse (Mac) . Click or hold down the forward or reverse button to 
advance or reverse the video for as long as the button is held down.
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Configuring Source Tasks
Source task configuration for file lists consists only of setting the name and saving the 
task in the Inspector. For local and network watch folder source tasks, more options are 
available. 

To configure source tasks, click the source task in the Workflow window. The Inspector 
displays the available options:

Task Name. Enter a name for the task before saving.

General
Watch Folder. Use the browse button or directly edit the path to select the folder you 
want to watch.

Pickup present files. Check this option if you want to pick up and process files already 
in the watch folder.

Advanced
Adaptive Safety Threshold. This is an amount of time Episode automatically adds to 
the Safe Delay wait time to ensure that a file has been completely written to the 
watched location before encoding. Set to Off if you have a fast network or are working 
locally on a fast machine. Set to Normal for a typical network, and set to Double if the 
network tends to be slow or you have trouble with files being picked up and encoding 
attempted before the files are done being written. 

Watch Poll Interval (sec). Enter the number of seconds Episode should wait between 
checks of the monitor source folder to detect new or updated files. The default is 2 
seconds. 

File Safety Delay (sec). Enter the number of seconds Episode should delay after 
detecting no changes in a new or updated file before encoding the file. This ensures 
the file is done being written before encoding.

Recursion depth. Set how many folder levels directly below the monitored directory to 
poll when searching for files to encode.

Retry Max Attempts. Enter the successive number of times Episode should attempt to 
connect and properly process the folder before stopping. 

Encode While Ingest. Use this option with Telestream Pipeline to encode TIFO files as 
they are being written to disk. To use this feature, you must have your Pipeline 
delivering its content in a TIFO container to the same location being monitored by 
Episode. 

File Filter. Click Add/+ to add sets of filter criteria. Use the filter criteria drop-down 
menu and the text entry field to select a term to filter directories, files, or extensions in 
or out. Many filter terms are available, including contains, is equal to, begins with, ends 
with, the converse of each of those terms, and so on.
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Source/Watch Folder and Image Sequence Inspector Panels 

Workflow Success Actions

Configure these options to specify how to operate on the source file after the workflow 
completes successfully:

Remove Source File. Check to delete the source file.

Move Source File. Use Browse to specify a location for copying the source file.

Workflow Failure Actions

Configure these options to specify how to operate on the source file if the workflow 
fails on any action:



Using Episode
Using the Inspector Panel

110
Move Source File. Use the popup menu to specify an optional location for copying the 
source file.

Stop Other Encodes. Check to stop other encodes in the same workflow. 

Delete picked up source files (Mac). Choose this option if you want Episode to delete 
the source files after encoding completes.

Move picked up files to (Mac). Choose this option if you want Episode to move files to 
a new location after encoding. This can be very handy if you want to ensure you keep 
already-encoded files separate from files waiting for encoding.

Revert. Select this option before saving to restore the selections in this panel to the last 
saved state before the most recent changes.

Save/Save As. Select to save changes. On Windows, a dialog allows you to save only 
the task or the entire workflow. 

Image Sequence
If the source task is an image sequence, the following selections are presented:

Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default 
value is 1, meaning that one missing number in a sequence is treated as the end of the 
sequence. If set to another number, that number of sequence numbers must be 
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the 
sequence before processing of the file begins. This does not apply to the first file in a 
sequence. This only has practical implications if Encode While Ingest is enabled. Setting 
this to 0 (zero) may significantly decrease the time the encoder has to wait when the 
end of the sequence is reached, but depending on file system and file format, may 
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device 
that produces an image sequence over time. Wait times between received files can be 
specified in the following wait fields. 

Encode while ingest waits (sec). Specifies the number of seconds to wait before 
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to 
wait for files during encode while ingest. The default is 5 times. If no files are received 
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum 
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.

Revert. Restores the Image Sequence settings to what they were before a change.

Save As. Saves the Image Sequence configuration to a file.
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Configuring Encoder Tasks
Encoder tasks include five main categories of configuration that you can edit in the 
Inspector panel: Format, Video Filters, Audio Filters, Split-and-Stitch, and Metadata. 
These categories are presented in expandable subpanels. 

To view a subpanel:

Click the triangle next to it. To close an expanded subpanel, click the triangle again.

Encoder Inspector Panel 

Each subpanel includes extensive selections, including check boxes and data entry 
fields that provide comprehensive control over the encoding process. Some of the 
subpanels contain additional subpanels that can be expanded further to provide 
access to more configuration selections and adjustments. 

For details explaining the details of each selection for each encoder, refer to the file 
formats, video and audio codec, and filter chapters later in this guide. The following 
figure provides an example of a partially expanded Encoder Inspector panel, and the 
following topics present a summary description of each panel.
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Partially Expanded Encoder Inspector Panel 

The following topics describe Encoder task configuration:

■ General Panel

■ Format Panel

■ Setting In/Out Points

■ Configuring Timecode

■ Adding Intro & Outro Clips

■ Using Video Filters

■ Using Audio Filters

■ Enabling Split-and-Stitch

■ Adding Metadata



Using Episode
Using the Inspector Panel

113
General Panel
The General panel at the top only includes the encoder’s name, which you can change 
and then save using the Save/Save As button at the bottom of the Inspector to create 
another variation of an item.

Format Panel
The format panel organizes and displays the following categories:

Container. 

Select the container format of the output file from the dropdown list. The container 
format you select determines which video and audio are available. Container settings 
are listed and described in detail in Media Containers/Formats.

Video Encoder (Codec). Select the video codec for any video tracks in the output file. If 
you uncheck the box, even if video is present in the input file, no video tracks are added 
to the output file.

When you choose the Pass Through option, the video stream is inserted into the output 
file untouched, provided that the format is supported in the output container format 
you selected. For video codec settings, see Video Codecs. 

Audio Encoder (Codec). Select the codec for any audio tracks in the output file. If you 
uncheck the box, no audio tracks are added to the output file.

When you choose the Pass Through option, the audio stream is inserted into the output 
file untouched, provided that the format is supported in the output container format 
you selected. For audio codec settings, see Audio Codecs.

Prepare for Streaming (Win), Audio/Video Streaming (Mac). These selections 
display only when streaming is supported. For media formats (with video/audio 
codecs) that can be streamed (sent out in real time from a server), check these 
selections to enable the output file from Episode to be streamable. 

MOV and MPEG-4 streaming media require special hint tracks that tell the streaming 
server how to packetize the media for transmission.

Streaming settings are listed by container in Media Containers/Formats.

Container and codec combinations that can be streamed:

Supported Streaming Containers and Codecs

Container Video and Audio Codecs

3GPP H.263, H.264, MPEG-4, AAC, AMR

3GPP2 H.263, H.264, MPEG-4, AAC, AMR

MPEG-4 H.264, MPEG-4, AAC

MOV H.263, H.264, MPEG-4, AAC, AMR
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Setting In/Out Points
Check the In/Out Points option to set the encoding in and out times when you only 
want to encode a segment of the source into the output file.

In/Out Points Settings

In/Out Points. Set the in and out times to only encode a segment of the source. 
Timecode is specified as follows: 

• Windows: <hours>:<minutes>:<seconds>:<hundredths sec>

• Mac: <hours>:<minutes>:<seconds>;<frames>

In Windows, nondrop-frame notation is the default (indicated by a colon between 
seconds and hundredths of seconds fields). Click the colon to change it to a semicolon, 
and use drop-frame notation. Click again to change it back.

On the Mac, drop-frame notation is the default (indicated by a semicolon between 
seconds and frames fields). Click the semicolon to change it to a colon, and use non-
drop-frame notation. Click again to change it back.

To enter the entire In/Out point timecode:

Click once to select it and type in the timecode without colons. You can enter each 
value segment manually by clicking directly on a segment to select it and type in the 
numbers. Or you can adjust the number using the up/down arrows to the right of the 
field. Note that you can set in/out points only if the source files contain valid timecode.

If you provide a value without colons, the number is parsed as if there were a colon 
between each pair. For example, 125 is interpreted as 00:00:01;25 because it is treated as 
one second and 25 frames; 175 is interpreted as 00:00:03;15 because it is treated as one 
second and 75 frames, which overflows the frames segment twice over, resulting in 1 
second plus 2 seconds and 15 frames or three seconds and 15 frames total.

On a Mac, you can specify the frames per second, or leave the default, which is 29.97. 

Configuring Timecode
If the source file has a timecode track, the timecode track is automatically added to the 
output file (providing the selected container format supports timecode).

If you want a different timecode track starting value than is in the source or the source 
has no timecode track and you want a timecode track in the output (providing the 
selected container format supports timecode), check Timecode and set the starting 
timecode value. (If you are adding QuickTime timecode to the MOV format, you also 
need to check Add QuickTime Timecode Track in the MOV container settings.)
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Timecode Settings

Time Code. Enter a time code in the format HH:MM:SS:HS/FF to set the starting time for 
the timecode track. Windows uses hundredths of a second (HS) in the last position, and 
Mac uses frames per second (FF). 

For formats that do not support a timecode track, you can combine the timecode filter 
with the burn timecode filter to add the timecode directly to the video track, rather 
than as a separate timecode track. This enables you to use timecodes in any file format. 
See Burn Timecode Filter.

CAUTION: The burn timecode filter permanently changes the video. Once the 
timecode has been added to the video it cannot be removed.

Adding Intro & Outro Clips
To add Intro and Outro clips to your output file:

Check the intro and outro selection and choose from the revealed settings.

Intro and outro clips (bumpers and trailers) are added before and after the main source 
media. They are set to the same format, size and frame rate as the output file but are 
not otherwise transformed. In particular, they are not de-interlaced if the output is 
progressive and vice versa.

These clips must have video and audio tracks corresponding to the video and audio 
tracks of the output. For example, output with both video and audio requires clips with 
both video and audio, but video-only output does not require audio tracks in the clips.

Intro & Outro Settings 

Using Video Filters
You can implement video filters to affect the video in various ways: changing its size, 
frame rate, color, or other metrics. Video filters are applied to baseband video after 
decoding.

The video codec encodes the video after all video filters have been applied, and may 
entail additional changes.
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You can apply one or more video filters to your video. However, be certain that you 
understand when and how to use a filter; some filters are not appropriate for certain 
video formats, and some video filter combinations are not appropriate.  

Video filters (when enabled) are applied in the order they are listed in the inspector.

Video Filters Panel 

Check a video filter to apply it. Next, click on it to select it and display its settings in the 
edit panel at the bottom, and configure the settings to meet your needs. Episode 
automatically saves your settings.

You can undo and redo changes to a setting by selecting Edit > Undo | Redo. 

For details about video filters, see Video Filters.

Using Audio Filters
You can implement audio filters to affect the audio track in various ways: changing its 
volume, speed, sample rate, or other metrics. Like video filters, audio filters are also 
applied in the order they are listed in the inspector. Audio filters are applied to 
baseband audio after decoding.

The audio codec encodes the audio after all video filters have been applied, and may 
entail additional changes.

You can apply one or more filters to your audio. However, be certain that you 
understand when and how to use a filter; some filters are not appropriate for certain 
audio, and some audio filter combinations are not appropriate. On the Mac, audio 
filters are applied in the order in which they are listed in the inspector.

For details about audio filters, see Audio Filters.
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Audio Filters Panel

Enabling Split-and-Stitch
This feature is available when you have a license for Episode Engine. In a Split-and-
Stitch job, the source is split into a number of segments that are encoded in parallel on 
all available nodes in your cluster. The resulting output segments from multiple 
computers are then stitched back together to form a single final output file. This 
method spreads the processing load and greatly reduces the total transcoding time.

Note: Some video formats cannot be processed using Split-and-Stitch. These formats 
are automatically encoded as a regular job even if you specify Split-and-Stitch.
Also, 3GP, MP4, and MOV files cannot be processed using Split-and-Stitch when audio 
or video streaming is enabled.

In Split-and-Stitch jobs, deployment tasks execute on the same server as the stitch 
task. This is done to minimize network file transfer inefficiencies. The only way to 
disable this feature is to use the XML/RPC interface.

To enable Split-and-Stitch jobs:

Expand the panel and check the Split-And-Stitch option. For details, see Getting Started.

Split-and-Stitch Panel

Minimum Split Duration. Enter a an integer value (in seconds) to specify the minimum 
size of split segments (default: 30). The minimum allowed duration is 9 seconds; the 
maximum is 3600.
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Maximum Number of Video Splits. Enter an integer value to specify the maximum 
number of video split segments (default: 16). The minimum number of video splits is 2; 
the maximum is 32.

Split on GOP Size. Enter a number that evenly divides the number of frames in a Group 
of Pictures (GOP) for the media you are processing. This will produce a clean split 
between GOPs rather than in the middle of a GOP for media that is sensitive to where a 
split occurs. For example, if each GOP in your media contains 12 frames, set this number 
to 12. The default setting is 1, which allows a split to occur at any position.

Note: This feature does not work with the Advanced Frame Rate Filter. Also note that 
this feature does not control the GOP size, which is set using settings in the codec. 
Codec settings are made separately when you select an encoder for your workflow. 

Limitations of Split-and-Stitch

Split-and-Stitch does not support video and audio streaming. If video or audio 
streaming is activated, Episode ignores Split-and-Stitch (if selected) and performs a 
regular encode. Similarly, Split-and-Stitch requires files to have timestamps or durations 
specified; if not, Split-and-Stitch is ignored and a regular encode is done.
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Adding Metadata
Metadata is information about a file, such as copyright information, source file names, 
creation date, etc. Many media formats have data fields for metadata. Each format 
supports different metadata fields. The inspector automatically identifies the available 
fields for the output format and displays them.

Metadata Panel

The edit panel displays a Key column (left) and a Value column (right). The Key column 
displays available metadata tags. They are disabled until you enter a value in the 
corresponding Value field. Double-click to activate the text field and enter your value. 
Fields for which you have not entered a value are not added to the output file.
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Configuring Deployment Tasks
You can configure Deployment tasks to write your output files to local directories, FTP 
servers, or network share/SMB servers.

In addition to user-created deployments, Episode provides three different system 
deployments you can use in your workflows.

■ User Deployments

■ System Deployments

■ Configuring User and System Source/Desktop Deployments

User Deployments
You can configure your user deployments to set their names, set their destinations, and 
determine whether to increment file names with an added numeral as new 
deployments with the same name are created or allow new deployments to overwrite 
existing deployment files.

System Deployments
Episode provides several predefined (or system) deployments.

Same As Source and Desktop Deployments

A Same As Source deployment uses the source directory as the output directory for a 
workflow, hence, the name, Same As Source. A desktop deployment places workflow 
outputs on the desktop. 

To implement a Same As Source or Desktop deployment task:

Display the Library panel, select the Deployments tab and navigate to System 
Deployments. Drag and drop the desired deployment resource onto the Deployment 
task template to create a new copy of the task so you can configure it.
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Configuring User and System Source/Desktop Deployments
To configure a deployment, select it in the workflow or in the library. If you select a 
deployment from the library, you must save it as a new task before you can edit it.

Example Deployment Task

Task Name. Enter a meaningful task name. 

Destination Folder. You can navigate to select the location where you want output 
files saved. By default this is the same as the source, or the desktop, depending on 
which deployment you use.

File Name. Use this field to enter text (and optionally, variables) to define how the 
output file name is to be constructed.

• Windows: To display a menu of variables, click the + icon. Click a variable to select 
it. To delete a variable, click to the right or left and use Delete or Backspace. 

• Mac: To display a menu of variables, enter $ in the File Name text field. Double-click 
a variable or use the arrow keys plus Tab or Return to select a variable. To delete a 
variable, select it and press Delete.

If you don’t provide any text or variables, Episode generates the file name in this format: 
source file base name + Workflow ID. For example, Original_File_Name-9045-3AA6-4FAD-
A1BC-29DA158082. If you only enter text, the file name is the name you enter.
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File Name variables and dynamic file name variables are listed in the tables below in red 
for Windows, blue for Mac, and black for both.

File Name Variables (Win and Mac)

Variable Description

$source.filename$
$ Source File Name

Base name of the source file submitted to the 
job.

$source.extension$
$ Source File Extension

Extension of the source file submitted to the job.

$workflow.submission-name$
$ Submission Name

Workflow that processed the job.

$workflow.submission- client$
$ Submission Client

Computer from which job was submitted.

$workflow.submission- host$
$ Submission Host

Master node in the cluster.

$encoder.name$
$ Encoder Name

Name of encoder that processed the job.

$encoder.input-duration-s$
$ Input Media Duration(s)

Input file length, expressed as seconds.

$encoder.input-duration-hms$
$ Input Media Duration(hh-mm-ss)

Input file length, expressed in timecode format.

$encoder.input-pixel-dimensions$
$ Input Media Dimensions(pixel)

Input file frame size, expressed in pixels.

$encoder.input-samplerate$
$ Input Media Samplerate

Input file sample rate, in frames per second.

$encoder.output-bitrate-kbps$
$ Output Bitrate(kbit/s)

Output file bitrate, expressed in kbits/second.

$encoder.output-bitrate-mbps$
$ Output Bitrate(Mbit/s)

Output file bitrate, expressed in Mbits/second.

$encoder.output-duration-s$
$ Output Media Duration(s)

Output file length, expressed as seconds.

$encoder.output-duration-hms$
$ Output Media Duration(hh-mm-
ss)

Output file length, expressed in timecode 
format.

$encoder.output-pixel-
dimensions$
$ Output Media Dimensions(pixel)

Output file frame size, expressed in pixels.

$encoder.output-samplerate$
$ Output Media Samplerate

Output file sample rate, expressed in frames per 
second.
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$deployment.name$
$ Deployment Name

Name of deployment action that processed the 
job.

$source.name$ The root of the source filename.

$source.type$ The suffix of the source filename.

$source.parent-dir-name$ The directory of the source file.

$source.grandparent-dir-name$ The second-level directory of the source file.

$uuid$ The UUID of the job.

$uuid.uppercase$ The UUID, converted to all upper-case letters.

$uuid.lowercase$ The UUID, converted to all lower-case letters.

$workflow.id$ The ID of this workflow.

$workflow.name$ The name of this workflow.

$workflow.spawn-time$ The time this workflow job started.

$workflow.submission-time$ The time this workflow job was submitted.

$workflow.template-id$ The ID of the template for this workflow.

Dynamic File Name Variables

Variable

$dynamic.time$

$dynamic.hr-time$

$dynamic.year.YY$

$dynamic.year.YYYY$

$dynamic.month.name$

$ dynamic.month.short-name$

$dynamic.month.MM$

$dynamic.day.name$

$dynamic.day.short-name$

$dynamic.day.DD$

$ dynamic.hours.HH$

$ dynamic.minutes.MM$

$ dynamic.seconds.SS$

$ dynamic.hostname$

$ dynamic.node-id$

$ dynamic.platform$

File Name Variables (Win and Mac)

Variable Description
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Increment File Names. When checked, output files with the same filename are suffixed 
by an incrementing integer. For example, if the first file is File-encoder.mov, the 2nd is 
File-encoder (1).mov, the 3rd is File-encoder (2).mov, etc. If unchecked, files encoded with 
the same output filename overwrite the existing file without warning.

Maximum Throughput (KB). When throttling is required, enter the value in kilobytes, 
for the maximum amount of data to transmit per second. Some FTP sites require a 
maximum throughput, for example.

Recreate Source Sub-directories. When checked, output files are written to the 
output directory in the same path as the source, including any intervening 
subdirectories, thus, retaining the source subdirectory structure in the output directory 
as well.

FTP-only options

SSL Mode. Enables or disables FTP Secure Socket Layer (SSL) for secure data transfer: 

• Off—Disables SSL. All transmissions occur using an unencrypted FTP connection.

• On—Enables SSL encryption and falls back to a clear connection if SSL fails.

• Force Control—Enables SSL encryption and fails to connect if SSL fails.

• Force All—Enables SSL encryption and ensures that all traffic is encrypted.
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Configuring Closed Captions
The Inspector is used to configure closed captioning. Closed captioning works with 
ordinary workflows as well as Split-and-Stitch. Captions may be passed through if they 
are already embedded, or they may be embedded during encoding from an scc or mcc 
file.

These output formats and video codecs support closed captioning:

• MXF (AS-11, Op1a, XDCAM) container

• MPEG-2 codec

• H.264 (MainConcept) and H.264 (x264) codecs

The following topics explain how to configure closed captioning.

Note: Closed caption configuration is done in four places: the Container, the Video 
Encoder, the VBI Importer Video Filter, and the Caption Importer Video Filter. Take care 
to set each one correctly in order to produce a successfully captioned output.

Adding Captions from a File (.scc or .mcc)
Episode can import .scc or .mcc caption files and embed their closed captioning data in 
the transcoded output. Caption files of the .scc type will add EIA-608 SD captions. 
MacCaption or CaptionMaker files of the .mcc type will add both EIA-608 SD and EIA-708 
HD captions. Ideally, the source media file and .scc or .mcc files should both include 
QuickTime timecode starting at 00:00:00:00, but even if timecode is not present, 
Episode assumes the 00:00:00:00 starting point and processes the job anyway. (To add 
timecode starting at 00 to the source, you can pre-process it in Episode and use the 
Timecode selection in the Format menu.)

The caption data from the .scc or .mcc file is inserted into the user data of the MPEG-2 or 
H.264 output files. 

To import a .scc or .mcc caption file: 
1. Create a workflow to encode a media file into one of the formats supporting 

captions: MXF Container, MPEG-2 Video Encoder, or H.264 Video Encoder. 

2. Select Video Filters in the Inspector. 

3. Select the Caption Importer Filter. 

4. Use the File menu in the Caption Importer to browse, select, and import a .scc or 
.mcc caption file. Captions from the file will be embedded during encoding.

Note: Because you must explicitly specify a file (and not a file variable), you must 
select the file in the filter each time you run the caption import workflow.
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5. Enable captions in the encoded output by making one or both of these selections:

– To add the captions to an MXF container file, select the container, and check Add 
Ancillary Closed Caption Track. 

– To add the captions to an MPEG-2 or H.264 video bitstream, select the Video 
Codec and ensure Closed Captioning is set to Same As Source. (Since this is the 
default setting, you won’t actually have to change anything.)

Passing Through Captions Embedded in the Source
Episode allows EIA-608, EIA-708, or SCTE-20 captions already embedded in the source 
media vertical blanking interval (VBI) or user data to be passed-through to the 
transcoded output. Settings depend on the source format:

Note: Episode cannot pass through embedded closed captions from MOV sources.

To pass captions embedded in an MXF or MPEG-2 source:
1. Create a workflow to encode the source file containing captions into a format 

supporting captions: MXF Container, MPEG-2 Video Encoder, or H.264 Video Encoder. 

2. No input Video Filter settings are required. The captions will automatically pass 
through to the output. 

3. Enable captions in the encoded output by making one or both of these selections:

– To add the captions to an MXF container file, select the container, and check Add 
Ancillary Closed Caption Track. 

– To add the captions to an MPEG-2 or H.264 video bitstream, select the Video 
Codec and ensure Closed Captioning is set to Same As Source. (Since this is the 
default setting, you won’t actually have to change anything.)

To pass captions embedded in a source other than MXF or MPEG-2: 
1. Create a workflow to encode the source file containing captions into a format 

supporting captions: MXF Container, MPEG-2 Video Encoder, or H.264 Video Encoder. 

2. Select the VBI Importer Video Filter, and check Decode Captions. When set to 
Automatic (the default), this will detect and extract the caption data on the input 
for embedding in the output. Instead of using Automatic, you have the option of 
setting decoding to Manual and selecting the vertical blanking line number that 
contains the caption data.

3. Enable captions in the encoded output by making one or both of these selections:

– To add the extracted captions to an MXF container file, select the container, and 
check Add Ancillary Closed Caption Track. 

– To add the captions to an MPEG-2 or H.264 video bitstream, select the Video 
Codec and ensure Closed Captioning is set to Same As Source. (Since this is the 
default setting, you won’t actually have to change anything.)

For details about caption outputs, see these format and codec descriptions: MXF AS-11 
(.mxf), MXF Op1a (.mxf), MXF XDCAM (.mxf), MPEG-2 Codec or H.264 (x264) Codec. 
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Using the Status Panel
The Status panel displays the status of jobs in queue and in execution on the current 
cluster. Depending on your preferences settings, the status of previously executed jobs 
may also be displayed, optionally subject to an age limit. See Setting Preferences.

Status Panel

The Status panel opens automatically whenever you submit a workflow for processing. 
To open the Status panel, (Win) click the Status menu icon in the lower left corner of the 
Workflow Editor, or (Mac) select Show Status (Command-3) from the Window menu. 

The Status panel includes a job/task list on the left, and the status of  the specific 
selected job on the right. Each side includes multiple information columns that can be 
rearranged by clicking and dragging.

Using controls at the bottom of the panel, you can start, stop, or pause workflows and 
resubmit the selected job. You can also delete workflows, copy workflows to the 
Workflow Editor, or expand and collapse job details.

Left Side Status Display
The left half of the Status panel lists workflows being processed and displays their 
status. The Status panel includes buttons and menus along the top of the panel that 
allow you to organize and filter the workflows and jobs you want to see. 

To change the status view:

Using the Jobs and Tasks buttons in the upper left corner, you can select between 
showing a hierarchical view with workflows on the left and their job details on the right, 
or a full-width listing of all individual tasks.
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To filter what is displayed:

Using the top drop-down menus, you can filter the display to only display jobs with a 
given submitter, workflow status, or job status. In a hierarchical view you can expand 
the detail view to display the component tasks of each job in the workflow and their 
status.

The order of jobs or tasks can be sorted by clicking any of the column headings. Click 
once to reverse the order and again to restore the original order. Note that if you have 
specified two-pass encoding, Episode cycles the progress bar twice—once for each 
pass.

To stop, pause, resume:

The Status panel lets you control encoding on the node. In the lower left corner there 
are Stop and Pause buttons. They only affect the currently selected workflow/job. You 
can also use the context menu (right click) to pause, resume, or stop the selected 
workflow/job (or delete the selected workflow). 

Note that when you pause a queued workflow to postpone its execution, it still 
occupies a slot on the cluster, and blocks execution of other jobs in that slot. (Slots in 
general correspond to a CPU core on a node, so you typically have multiple slots on 
each node.) 

You can change workflow execution priority by selecting the workflow in the list on the 
left and adjusting the Priority slider. (On Windows, you can also enter a new priority 
number in the field next to the slider.) If you want to leave a workflow running but stop 
it from picking up any more files for processing, click the Stop button next to the 
Priority slider. 

To open the selected workflow in the Workflow Editor on Windows, right-click and 
select Open/Recall (Command-O). On a Mac, select the gear-shaped icon in the lower 
right corner, and select Copy to Workflow Editor. 

CAUTION: If jobs are currently processing, do not change the system date and time, 
as this can cause the job to fail.

Left Panel Status Selections

The following selections are available in the left jobs panel. Each column label can be 
clicked to sort the jobs list.

Jobs/Tasks. Selects between a split display, showing a list of jobs on the left and tasks 
on the right, or a single display showing everything. 

Client/Machine. Selects whether to show jobs running only on this machine or on all 
visible client machines.

Workflow Status. Filters the job display based on workflow status—any (all) 
workflows, running workflows, successful workflows, failed workflows, or pending 
workflows.
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Job Status. Filters the job display based on job status—any (all) jobs, running (active) 
jobs, successful (completed) jobs, failed jobs, or pending/idle jobs.

Workflow Type. Filters the job display to show watch folder workflows, manually 
submitted workflows, or any workflows.

Workflow column. Lists workflow names. 

Submitted column. Lists date and time submitted for each job. 

Progress column. Shows a progress description for each job.

Priority column. Shows a priority setting for each workflow, ranging from -10 to +10. 
Adjust the slider or enter a number to change the priority.

Start/Stop button column. Click to start or stop the selected (highlighted) job.

Resume/Pause/Stop (bottom buttons). Use these player-like controls to restart, 
pause, or stop activity on the selected (highlighted) job.

Right Side Status Display
The right side displays the detailed job status of the workflow you select on the left. 
Column headings and bottom panel start, stop, and pause controls work the same as 
they do for the left side display with the addition of a Requeue Job button for 
resubmitting jobs to the queue. 

The right side status panel includes a search field for entering specific file names whose 
status you want to find and view. 

To view status details:

The right side columns display the Job and Task Name and show processing Progress 
and Priority, as well as helpful information about Current Time spent processing, when 
the job started (Start time), when it ended (End time) if it has ended, the length of the 
output media file (Media Duration), how many times the job has attempted to run 
(Attempt), the machine the job ran on, who submitted the job, and how long the 
encoding task took to run (Task Duration).

Right Panel Status Selections

The following selections are available in the right tasks panel. Each column label can be 
clicked to sort the tasks list.

Search. Allows entering and searching for a task by file name.

Job. Lists tasks based on task file name and task type.

Task Name. Lists the names of tasks

Progress. Shows the current progress for each task.

Priority. Shows the priority of each task.

Current Time. Shows how much time has been spent so far processing each task.
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Pass. Indicates whether each task has passed or failed.

Start time. Shows the time each task was started.

End (Stop) time. Shows the time that each completed task was finished.

Media Duration. Shows the length of the transcoded output file for each task.

Attempt. Shows how many times the task has attempted to complete.

Machine. Shows which machine the task is running on or has run on.

Submitter. Lists who submitted the associated workflow.

Task Duration. Shows how long the task took to complete. 

Resume/Pause/Stop/Requeue Job (bottom buttons). Use these player-like controls 
to restart, pause, or stop activity on the selected (highlighted) job. The Requeue Job 
button resubmits the job to the queue to repeat processing.
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Using the Cluster Window
The Cluster Browser is a window that displays all Episode nodes on the network, and 
their relationship (if any) with each other. The Cluster Browser window allows you to 
view, create, and join Episode clusters to take advantage of multiple computers for 
features such as Split-and-Stitch. 

Note: You can set cluster processing behavior in Preferences. See Setting Preferences.

The Cluster Browser displays all Episode clusters and nodes visible on the network. 

To display the cluster browser:

• Windows: Open the cluster browser with View > Cluster Window (Control-2).

• Mac: Select Windows > Show Cluster Browser (Command-4).

To display the Cluster Browser window:

• Windows: View > Cluster Browser

• Mac: Window > Cluster Browser

Cluster Browser

A cluster is a named collection of computers with Episode installed that work together 
to process Episode workflows. Each instance of Episode running on a computer is called 
a node. You can define a cluster temporarily to process a specific large job, or you can 
create clusters and leave them in operation for long periods.

Use the drop-down menu to create clusters, join existing clusters, specify the master of 
a cluster (the I/O server), or specify that your machine is working alone. The Cluster 
Browser displays the existing clusters, and clicking their popup menus displays the 
machines in the cluster.

Each cluster item can be expanded to display the nodes in that cluster.

A list of Machines Working Alone, indicates nodes that are not members of any cluster.
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To manage clusters using the drop-down menu:

Operate Alone. Handle all jobs locally.

Create Cluster. Create a new cluster with the current node as master.

Submit to selected cluster. Submit to a cluster, but do not receive submissions. 

Join Cluster. Join the selected cluster to submit to and receive from a cluster.

Join or Submit by IP or Host Name
To join or submit to clusters by IP address or DNS host name (for hosts not on your local 
subnet), click the gear menu in the lower right corner and select Join or Submit:

Join Cluster Via IP Address/Host Name. Select this option and enter an IP address or a 
DNS host name to join the specified cluster, allowing you to submit jobs to or receive 
jobs from the cluster.

Submit To Cluster Via IP Address/Host Name. Select this option and enter an IP 
address or DNS host name for the master of the cluster. This will allow you to submit 
jobs to the specified cluster, but you will not receive any jobs from the cluster.

After you join or submit, the Cluster Browser window indicates that you are joined to or 
submitting to a cluster. To return to working alone, use the top drop-down menu to 
select Operate Alone (Win)/Work Alone (Mac). The Cluster Browser window indicates 
working alone/privately.
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Cluster Browser Join by IP or Name (Submit is similar)



Using Episode
Using the Cluster Window

134
Using Named Storage
The Named Storage feature allows you to define a storage location, such as a SAN, with 
a user-configurable name so that the same physical location can be used across Mac 
and Windows platforms even though the local path to that storage is different on each 
machine. Named Storage can be used within a cluster to permit access to files by 
multiple machines of either platform belonging to the cluster. Named Storage is a more 
efficient way to access storage because it is a direct path and bypasses the IO Server in 
a cluster, helping to prevent the IO Server from becoming a bottleneck.

You can implement Named Storage using the Episode menus, or the command line 
interface (CLI) commands. This guide describes the menus in the Episode window. For 
detailed instructions on using the CLI, please refer to the Episode Advanced User’s Guide. 

Named Storage Simple Example
Windows Machine1 accesses a media location on a SAN using a windows path S:\

Mac Machine2 accesses the same location using a mac path /Volumes/MediaSAN/

In order for Episode to recognize both locations as the same physical storage, the 
Named Storage feature can be used. You specify a common storage name, that is, the 
same storage name to be used on each machine. The common name corresponds to 
the same physical storage location, but each machine reaches that location using a 
different path. 

When the common name is used to access storage from a particular machine, the 
system matches the common storage name with the actual path to the storage for that 
machine so that the files can be moved to or from storage using that path. 
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The following steps explain how to implement Named Storage for your Episode 
computers. The steps assume that there are two example machines, one Windows and 
one Mac. You can use the same steps for any number of machines. Just change the 
example storage name to the storage name of your choosing, and change the example 
paths to the paths your machines use to access the storage. Even if all machines use the 
same path, Named Storage ensures faster access to the common storage location.

To configure Named Storage:

1. Open the Preferences window (in the Win Tools menu or the Mac Episode menu).

2. Select Named Storage.

3. On Windows, just start typing in the fields.
On a Mac, click + to open a window for adding new named storage. 

4. Enter the common name in the Storage Name field, and enter or browse for the 
path to the storage for this machine in the Storage Location field.

5. Click Add to add the new Named Storage (or Cancel to abandon the add).

Named Storage Addition
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Note: Make sure Episode is launched and running on each affected computer. If you 
need to add new named storage to an existing cluster, you must take down the cluster 
first and ensure that all machines are working alone. Then you can add new named 
storage to each machine, create a new cluster, and join or submit to cluster all the 
machines that you want to include in the cluster.

That’s all you need to do. Episode on both machines will now be able to access the SAN 
using the different paths that each requires. 

You can apply this same process to as many Episode machines as you may have in your 
facility to enable all of them to directly access the Named Storage device.

To remove Named Storage:

1. Click the storage you want to remove to highlight it in the list.

2. Click Remove (-). The selected storage is immediately removed. 
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Setting Preferences
Select Tools > Preferences (Win) or Episode > Preferences (Mac) to display the 
Preferences window. The Preferences window has several tabs: General, Cluster, 
License, Update, and Advanced.

■ Using the General Tab

■ Using the Cluster Tab

■ Using the License Tab

■ Using the Update Tab

■ Using the Named Storage Tab

■ Using the YouTube Tab

■ Using the Advanced Tab

Using the General Tab
Use the general tab to set up preview options, specify the number of simultaneous 
encodes, specify job history retention, and reset user interface warnings.

Preferences—General Tab
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Preview—Default Preview Source. Click Browse to navigate and select the source to 
display in the Preview window.

Preview Output/Destination Folder. Enter or browse to the location where you want 
preview output files placed.

Simultaneous Encodes. Use the slider to set the number of jobs that can execute in 
parallel on this platform (node). Higher license levels can encode more simultaneous 
jobs. With the Engine license, Episode can encode up to 32 simultaneous jobs.

The number of jobs you can run efficiently in parallel is independent of the number of 
cores available in the host machine. In a transcode, each component (file parser, 
decoder, filter, encoder and exporter) runs separately and can use separate cores. 
Consequently, a typical HD ProRes transcode to H.264 can use 4 or 5 cores or more.

Calculating the optimal number of jobs to run in parallel depends on several factors:

• Cores: Always run fewer jobs than you have hardware cores. 

• Memory: For HD jobs you need at least 2GB of memory per job. 

• Resolution: If you are coding smaller (lower resolution) files, you can run more jobs 
in parallel than if you run HD or 4K jobs. 

To determine the optimum number of parallel jobs to specify for a typical batch, see 
how long the batch takes using the number recommended by Episode. Then first 
increase and then decrease the number of parallel jobs to pinpoint the best setting.

Recommend. Click to allow Episode to set the number of simultaneous encodes to the 
volume considered best for this platform. The maximum number of simultaneous 
encodes are also controlled by your license level.

Keep Job History. The Status window displays submitted jobs in queue, executing, and 
also for a given period after they have finished. See Using the Status Panel.

Select how long you want to keep job history information from the options in the 
dropdown menu: 

• Keep for 1 hour (Win)

• Never (Mac)

• Keep for 24 hours

• Keep for 1 week

• Forever (Mac)—retains history until manually deleted

• Clear Manually (Win)—retains history until manually deleted

Note: On the Mac, when Keep Job History is set to Never, sometimes users are allowed 
to recall invalid workflows because episode retains the workflow entry in the status 
window after the workflow finishes. Attempting to recall a workflow will cause the 
workspace to become blank, since the workflow information no longer exists. To avoid 
this problem, follow these steps:
1. Set Keep Job History to Never in Preferences.
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2. Change history-keep-time from 3600 to 0 in the ClientProxy xml, located at: 
          /Users/[user name]/Library/Application Support/Episode/.
3. Restart services. 

Job history is cached locally on each node. When you connect to a cluster the master 
node of that cluster transfers the job history to you.

Clear History/Now. Click to permanently remove the job history information. Deleting 
the job history on a cluster’s master node makes the earlier history unavailable to new 
nodes, but existing local history caches are retained until purged on those nodes.

The following are Windows-only controls:

UI Warnings—Reset. Click to reset the user interface warnings to the factory default 
settings, so that they start displaying again.

Application Logging Level. Select the level at which you want logging to be active. 
When a level is selected, all events at that level and above will be logged.

None—Nothing logged.
Fatal—Only errors that cause Episode to crash.
Error —Standard errors, such as workflows failing etc.
Warn—Any warnings that workflows generate.
Info—General events, minor errors, and state changes pertaining to normal operation 
of Episode and workflows.
Debug—All levels of errors, warnings, and events are logged.

Clear Log File. Click to permanently delete the entries in the log file. The log file is 
located at C:\Users<user name>\AppData\Local\Telestream\episode_log.txt.

For more information see Edit Menu, Technical Support Information.
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Using the Cluster Tab
Use the Cluster tab to set up cluster operational preferences.

Note: When operating as part of a cluster, deployment tasks always execute on the 
same server as the encode task in the job. In Split-and-Stitch jobs, deployment tasks 
execute on the same server as the stitch task. This is done to minimize network file 
transfer inefficiencies. The only way to disable this feature is to use the XML/RPC 
interface.

Preferences Window—Cluster Tab

Private Mode—Visible on network (Win)
When Working Alone—Allow others to see my node on the network (Mac). 
When your node is not part of a cluster, check to make this node visible in the cluster 
browsers of other nodes.

Cluster participation mode—Only Accept Jobs Submitted By Me (Win)
When Part of a Cluster—Only work on jobs that I submit (Mac). 
When your node is part of a cluster, check to enable this node to submit jobs to other 
nodes in the cluster, but only accept submissions from itself.
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Run Jobs (Win)
When Master of a Cluster—Run Jobs (Mac). 
When this node is the master node of a cluster, check to determine specify that this 
node can also run jobs, or uncheck to just assign them to the other nodes in the cluster. 
You can thus use a low-end machine as cluster master, sending jobs to more powerful 
nodes.

Job Scheduling [Select from dropdown] (Win)
Schedule Jobs Using [Select from dropdown] (Mac). 
Select to assign jobs to cluster members and select how to schedule jobs:

Round Robin simply sends jobs to each node in order.

Hardware Balanced is more likely to send jobs to more powerful nodes, as determined 
by processor number, speed, and memory size. 

Load Balanced uses the same capacity computation as Hardware Balanced but in 
addition considers the current CPU load on all nodes.
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Using the License Tab
Use the License tab to add, remove, or deactivate a license on this computer.

If you are purchasing additional licenses for use of Episode on other computers, 
Telestream recommends that you purchase them directly from the Telestream Web 
store at http://www.telestream.net/purchase/store.htm.

When a license is selected in the list, you can copy it or click the Copy button to place 
the license on the clipboard.

Note: If your Episode Engine is connected to a cluster, you must remove it from the 
cluster (see Using the Cluster Window) before making license changes. Make the 
changes, then add it back to the cluster.

Preferences—License Tab

Add. Click Add (+) to open a window where you can enter or purchase a license. Enter 
the license serial number in the Serial Number field. If you don't have one, click Purchase 
to enter our online store where you can purchase a license and enter it here.

http://www.telestream.net/purchase/store.htm
http://www.telestream.net/purchase/store.htm
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Adding a License

Remove. Select a serial number and click Remove (-) to remove it. You should do this if 
you intend to move your license to some other computer. It is suggested that you save 
the serial number in a text file, so as not to lose it.

Deactivate (Win). Select a serial number and click to deactivate it but leave it available 
in this window for later use.
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Using the Update Tab
Use the Update tab to check for and install Episode software updates.

Preferences—Update Tab

Update Settings—Check for Updates. Click the popup menu to set how often 
Episode checks for new software versions. You can choose Daily, Weekly, Monthly, or 
Never.

Check Now. Check immediately for new versions.

The Last Check for Update field indicates when the last check was made.
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Using the Named Storage Tab
Use the Named Storage tab to set a common name for networked storage and enable 
access to it from the unique path required by each Episode machine.

Preferences—Named Storage Tab

Storage Name. Enter the name you want to give the networked storage device

Path/Location URL. Enter or browse the path to the storage from this machine.

Add. Adds the storage name and path to the Named Storage list.

+/-. On a Mac, click + to open a window for adding storage. Click - to delete selected 
storage from the list.

Remove. On Windows, click Remove to delete selected storage from the list.

Cancel/OK. Click OK to save and close the named storage window or click Cancel to 
abandon a named storage entry.
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Using the YouTube Tab
Use the YouTube tab to store your login to the YouTube web site. This login can be 
selected in the Inspector when creating a deployment to YouTube.

Add. Click to open a window for adding a login. The new login is added to the User list. 

+/-. On a Mac, click + to open a window for adding a login. Click - to delete the selected 
user from the list.

Remove. On Windows, click Remove to delete the selected user from the list.

Login/Cancel. Click Login to open a browser window that allows you to log into 
Google, which can also log you into YouTube.
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Allow/Deny. When you log into Google, you are presented a list of features Episode will 
access, including your YouTube account. 

 

Click Allow to allow access and add the user to the User list in Episode. Click Deny if you 
do not want to grant Episode access to your Google/YouTube account.

If you click Allow, the browser confirms with “Authorization complete.” 

Now when you deploy to YouTube, you can select this account in the deployment 
inspector so that Episode can automatically log on and deploy to YouTube.

Deploying to YouTube
To deploy to YouTube, you can select one of the pre-made YouTube workflows or create 
your own workflow and use a YouTube deployment. In the deployment inspector, 
select the User account you created in Preferences and fill in all the other metadata, 
such as the title, description, category, and privacy. When you submit the workflow, it 
will automatically encode the video and post it to your YouTube account.
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Using the Advanced Tab
Use the Advanced tab to set background processing and other processing options.

Preferences—Advanced Tab

Background Processing. You can specify whether or not the Episode services run in 
the absence of the Episode desktop application. This can be useful if you need to run 
Episode interactively as part of an encoding cluster and you want it to keep working 
when you are not logged in. See Episode Components.

Start working on computer startup (Win)/when user logs in (Mac). Check to start 
and run all Episode processes, whether a user is logged in or the Episode application is 
running or not.

Keep working after application quits. Check this to allow Episode to keep processing 
workflow tasks even after the user closes the application.

Act as a low priority process. Choosing this option allows Episode to run as a lower 
priority process so that it does not draw excessive processing power away from 
foreground applications that need to be responsive to user input.
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Specify Windows User Account for File/Folder Access (Win). Since Episode services 
can run even if a user is not logged in or when running Episode as a non-administrator, 
you must specify what access rights should be assumed for the processes. The account 
that you specify must be an administrator with a password.

Note: Since all processes run in their own context, they only have access to the UNC 
volumes (in the form \\Server\Volume\File) the user has in their password cache.

Use default (Win). Use the access rights of the SYSTEM user (which must be an 
administrator with password).

To use Episode to give a non-administrative user administrative access to Episode 
Services, start Episode using an administrator account.

Deselect (uncheck) Use Default in the Specify Windows User Account for File/Folder 
Access and enter a username and password (administrator account) that will access 
Episode services for the user.

User Name (Win). Enter the name of the administrator account to use, in the form 
<domain>\<username>.

Password (Win). Enter the password of the selected account.

Close Episode, restart Windows as the Episode non-administrative user, and open 
Episode again. The user should now be able to run Episode without being an 
administrator, and Episode itself will log in with administrative rights.

Serve files to old clusters for. Use the popup menu to specify how long Episode will 
continue to have access to files on machines that have resigned from a cluster. During 
that access time period, the machine that has resigned will continue to supply any files 
that are part of a job being processed by the cluster, but the machine will not 
participate in processing the jobs. 

If you often create ad-hoc clusters for encoding several jobs and then break the cluster 
up into machines working alone, this setting will ensure that if a machine serving files 
leaves the cluster, those files will still be accessible to the rest of the encoding cluster 
even after it has resigned.

File Cache Path. Some encoders write temporary files during encoding, and Split-and-
Stitch jobs write temporary files during processing. If you have a faster disk somewhere 
else than the default location you can use a cache directory on that disk.

If you have an Episode cluster, and you are using shared storage (SAN, NAS, etc.) then 
you should set the file cache path to the same location on all nodes in the cluster.

Note: You should not change the cache directory, nor clear the cache while jobs are 
executing, because it is likely to cause the jobs to fail.

Browse. Set the cache directory.

Clear Cache. Delete all cache files. You should normally never need to do this, unless 
for some reason large cache files have not been automatically purged.

Set Default. Set the cache folder to (Win) C:\WINDOWS\TEMP\ (Mac) ~/Library/Caches.
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Using the Episode Premiere Plug-in
Telestream provides an application note with details about how to use Episode and 
Premiere together. Refer to this URL address in your web browser: http://
www.telestream.net/pdfs/app-notes/app_Episode_Premiere_Plugin.pdf. Information 
in the application note supersedes the information presented here.

The Episode Exporter 2.0 for Adobe® Premiere Pro CC allows you to select a clip, 
timeline, or portion of a timeline in Premiere Pro CC and submit the selected content to 
Episode or an Episode cluster for encoding and deployment.

The following topics provide a basic overview of using the Episode Exporter:

■ Preliminary Steps

■ Exporting and Encoding a Media File

■ Encoding Media Files in a Timeline Sequence

Preliminary Steps
Before using the Episode Exporter for Premiere Pro CC, complete these steps:

• Make sure Episode is running on your machine. 

• In Episode, create and export Episode encoder epitasks and deployment epitasks 
configured to perform the encoding and deploy the outputs you desire. These epi-
tasks will be used in the following Premiere Pro CC workflows.

• If you want to include any effects or transitions, add those to your clips in Premiere 
Pro CC prior to exporting. 

Exporting and Encoding a Media File
The following example demonstrates how to use Episode Exporter for Premiere Pro CC: 

1. Start Premiere Pro CC and create a new project or open an existing one. 

2. In the Media Browser, double-click a media clip. The file opens in Source Monitor.

3. From the main menu, select File > Export > Media. The Export Settings window 
opens.

4. In the Export Settings window, select the following:

– Format: Episode Exporter

– Video tab > Configure Settings button

The Configure Episode Exporter window opens so you can select encoding and 
deployment epitasks.

http://www.telestream.net/pdfs/app-notes/app_Episode_Premiere_Plugin.pdf
http://www.telestream.net/pdfs/app-notes/app_Episode_Premiere_Plugin.pdf
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5. In the Configure Episode Export window, make the following selections:

a. At Choose encoding, click Add and select an encoder epitask that you have 
exported from Episode.

b. Click the Target drop-down menu, and select either a Target folder to specify a 
destination for the encoded file, or select Deployment Task to use a deployment 
epitask.

c. Click Browse for a Target folder, or click Add for a Deployment Task, and browse 
to select the folder or epitask.

d. Make any other Premiere Pro CC export settings that you desire. See Premiere Pro 
CC Help for information about available settings.

e. Click OK to save and close the configuration.
f. Click the Export button at the bottom of the Export Settings window when you 

are ready to export the file for transcoding in Episode.

Premiere Pro CC shows an export progress bar, and you can also watch progress and 
view status information in the Status window on the Episode system. 

When encoding is complete, the encoded file appears in the target folder you specified.

Encoding Media Files in a Timeline Sequence
You can also use Episode and the Episode Exporter 2.0 for Premiere Pro CC to encode 
multiple files on a Premiere Pro CC Timeline:

1. Import or drag and drop a media clip onto the timeline to create a sequence.

2. Play the clip in the timeline and edit as desired, including marking in and out 
points.

3. Repeat the steps of the previous procedure—Exporting and Encoding a Media File—
to encode the media file used in the sequence. 

Export progress is displayed in Premiere Pro CC, and encoding progress can be viewed 
in the Episode Status window. Your encoded outputs will be placed in the specified 
target folder.
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Creating an MBR Streaming Media Project
MBR is an abbreviation of Multi-Bit-Rate which is a technology currently used by DASH 
Streaming, Apple's HTTP Live Streaming, and Microsoft's Smooth Streaming. MBR 
workflows consist of at least one Encode task (with a deployment) that gets submitted 
to at least one MBR task. To utilize the streaming technologies fully, at least three 
different Encode tasks with different bit rates should be used. Encode tasks are created 
in the Episode GUI application and configured to produce a TIFO (Telestream 
Intermediate Format) output. TIFO is a format that the MBR task can take as input.

Apple's HTTP Live Streaming can be produced on both Mac OS X and Microsoft 
Windows platforms, while Microsoft's Smooth Streaming can be produced only on the 
Windows platform. Produced, in this context, means that the MBR task configured to 
output Smooth Streaming must run on a Windows computer. The individual Encode 
tasks can run on either platform.

The following topics explain how to create MBR streaming outputs using the Mac and 
Windows user interfaces (UI).

■ Create MBR Tasks

■ Configure Encode Tasks

■ Submit Workflow

■ Output Results

Create MBR Tasks
To begin, create an MBR task for each streaming output you want to produce. In this 
example, three parallel encoder tasks are created to produce HTTP Live Streaming 
(HLS), SmoothStreaming, and DASH outputs.

Creating Tasks in the User Interface
Create a workflow as shown in the following figure.

1. Drag a workflow from the Workflows tab into the Workflow panel. There are 
multiple output workflows you can use as a starting point and modify, such as H264 
- Three Outputs or iPad Streaming 8 Streams. These workflows give you multiple 
parallel encoders. 

Alternatively, if you intend to produce only one live streaming output, such as 
DASH, you can select a DASH workflow from the System Workflows Library and 
drag that to the Workflows area. You will have only one encoder and deployment in 
the workflow instead of the multiples shown in the following steps.
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2. Drag a Watch Folder or File List from the Sources tab to the Source Task in the 
workflow. Click on the Source Task and browse for a folder location in the Inspector.

3. Drag encoders from the Encoders tab to the Encoders Tasks in the workflow to 
replace the default encoders. You will find encoders for HTTP Streaming, 
SmoothStreaming, and DASH Streaming at different bit rates. You can encode 
different stream formats, or you can encode one stream format at different bit rates.

4. Drag output locations from the Deployments tab to the Deployment Tasks in the 
workflow. Click on the Deployment Task and browse for a folder location for the 
output.
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Configure Encode Tasks
Next, configure Encode tasks to output TIFO files as input for the MBR tasks. 

Configuring Encoders in the UI
Click on each of the three encoder tasks and configure them in the Inspector. The 
container is TIFO, and the video and audio encoders can be set as you prefer.

You’re now finished creating the workflow, so you may want to save it as a User 
Workflow. To do so, right-click in the workflow area and select Save Workflow As.... Enter 
a name and save the workflow.
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Submit Workflow
Next, submit the workflow as multi-bit-rate jobs. 

Submit Workflow as MBR in the UI
1. Select the Window menu on a Mac or the Tools menu in Windows.

2. Select Submit Workflow as MBR. You can also right-click in the workflow panel and 
select Submit as MBR. The MBR configuration window shown below opens. 

3. Enter a name for the stream package, enter the number of seconds duration for 
each stream segment, check the streaming formats you want to output, and select 
the Deployment folder from the drop-down menu.

Output Results
The following screen shot shows the Status panel displaying the completed job with 
the three streaming outputs (HLS, DASH, and SmoothStreaming) available in the 
deployment location. If you chose to encode only one multi-bitrate format, such as 
DASH, you’ll have only one output.
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Completed Streaming Media Project
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Episode Menus
This chapter provides details about the Episode menus displayed across the top of the 
window and describes their menu items. 

■ Episode Menu (Mac)

■ File Menu

■ Edit Menu

■ View Menu (Win)

■ Media Browser Menu

■ Library Menu

■ Tools Menu (Win)

■ Inspector Menu (Mac)

■ Window Menu (Mac)

■ Help Menu

■ Shortcuts By Menu



Episode Menus
Episode Menu (Mac)

158
Episode Menu (Mac)
About Episode. Select to display the version of Episode.

Preferences. (Command-Comma) Select to display the Preferences panel. 

Quit Episode. (Command-Q) Select to stop the application—you are reminded to save 
unsaved files. 

File Menu
New Workflow. (Control-N (Win)/Command-N (Mac)) Select to display a new, unnamed 
workflow in the Workflow panel, with three empty tasks: source, encoder, and 
deployment. On a Mac, this menu item is disabled when the Workflow window is 
closed.

New (Win)/New Task (Mac) > New Source. (Mac: Option-Command-N) Select to create 
a new, untitled source task in your current workflow. Specific source selections: File 
List, Watch Folder, and Image Sequence. You can only have one source in a workflow.

New (Win)/New Task (Mac) > New Encoder. (Mac: Control-Command-N) Select to add 
a new, untitled encoder task to your current workflow. 

New (Win)/New Task (Mac) > New Deployment. (Mac: Shift-Command-N) Select to 
add a new, deployment task to your current workflow. Windows systems include 
specific deployment selections. 

Use Selected Deployment for All Encoders (Mac). (Option-Command-A) When a 
deployment is selected, select to apply the selected deployment to all of the encoders 
in the workflow.

Save <item> (Mac). (Command-S) Saves the selected workflow, source, encoder, or 
deployment. Saving changes overwrites the existing item. If items are unsaved at quit, 
Episode asks if you want to save and allows you to Save All. (This may be confusing if 
there are many unsaved changes; to prevent confusion, save often while you work.) 

Save Workflow As. (Win: Control-Shift-S/Mac: Command-Shift-S) Select to save the 
current workflow as a new item or use the same name to overwrite.

Save Task As (Win)/Save <item> As (Mac). (Win: Control-Alt-Shift-S/Mac: Shift-
Command-S) Select to save the highlighted item as a new item with a new name or use 
the same name to overwrite. Enter a name in the Inspector’s Name field. Workflows and 
tasks are saved in the Library.

If the item has already been saved as a user task, you can right-click on the name in the 
library and select Rename <item>, or on a Mac, you can double-click the name field in 
the library, enter a new name, and press Enter to save it. System tasks cannot be 
renamed.

Save All (Mac). (Option-Command-S) Allows you to save all unsaved items at once.

Revert <item>. Reverts the selected workflow, source, encoder, or deployment to the 
last saved version, discarding changes since the last save.
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Import. (Win: Control-O/Mac: Option-Command-I) Select to import tasks or workflows. 
Episode displays the Open dialog, where you can navigate and select the task or 
workflow to open.

Export Task. (Mac: Option-Command-E) When a task is selected, select to display a file 
system dialog, where you can navigate to your target directory and save the task. 
Episode task files are saved with an epitask suffix. You can archive these files, move 
them to other servers, and import them in other Episode instances.

Export Workflow. (Win: Control-Shift-S/Mac: Control-Command-E) Select to display 
the file system dialog, where you can navigate to your target directory and save the 
workflow. Episode workflows files are saved with an episubmission suffix. You can 
archive these files, move them to other servers, and import them in other Episode 
instances.

Submit Workflow (Mac). (Command-R) Select when the active workflow is ready to 
submit for processing. This may be a workflow with one or more files in its file list, 
which submits these files for processing, or it may be a workflow with a monitor, which 
activates the monitor to poll for new files to process. You can also use the Submit 
button at the bottom of the Workflow window to submit a workflow for processing.

Submit Workflow as MBR (Mac). (Command-5) Select to open the Multi-Bitrate 
window to submit an MBR workflow for processing.
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Edit Menu
Most Edit menu commands function the same as they do in other applications. A few 
are unique to Episode.

Undo. (Win: Control-Z/Mac: Command-Z) Roll back to the state before your last action.

Redo. (Win: Control-Y/Mac: Shift-Command-Z) Restore the state you just used Undo to 
roll back.

Copy. (Win: Control-C/Mac: Command-C) Copy the highlighted text or selected object 
to memory.

Cut. (Win: Control-X/Mac: Command-X) Remove the highlighted text or selected object 
and store it in memory.

Paste. (Win: Control-V/Mac: Command-V) Place the previously copied or cut text or 
selected object from memory into the target component.

Delete. Remove the highlighted object.

Select All. (Win: Control-A/Mac: Command-A) Select all objects in the selected panel.

Set as Deployment for All Encoders (Win). When a Deployment is highlighted, select 
to automatically use this Deployment for all encoders.

View Menu (Win)
Preview. (Control-1) Performs a preview encode of the selected file using the current 
workflow, and places the output file in the default folder specified in Tools/Preferences. 

A Preview window shows an encoding progress bar and presents these controls: 

• Cancel stops the preview encode and closes the Preview window.

• Close when finished automatically closes the window when encoding finishes.

• Close closes the Preview window. 

• Open opens the finished encoded file in your computer’s default video player. 

• Show file in explorer opens the desktop folder and highlights the file.

Cluster Browser. (Control-2) Select to open the Cluster Browser window.
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Media Browser Menu
Show | Hide Media Browser (Mac). (Option-Command-M) When the Media Browser is 
displayed, select to hide it. Select it again to display it.

Add Bookmark. (Mac: Command-B) Open the Inspector panel and select to create a 
new, unnamed bookmark. Configure the bookmark and click Save to create the 
bookmark and display it in the Media Browser. 

Remove Bookmark (Mac). When a bookmark is selected in the Media Browser, select 
to delete it. Confirm by clicking Remove.

Add As Watch Folder (Win). (Control- +) Add the selected folder as a watch folder.

Add As Deployment (Win). (Alt- +) Add the selected object as a deployment.

Add to Workflow (Win). (+) Add the selected object as a workflow.

View as Icons (Mac). (Option-Command-L) When the Media Browser is displayed, 
select to display the selected folder’s files as icons.

View as List (Mac). (Option-Command-L) When the Media Browser is displayed, select 
to display the files as a list.

Refresh (Mac). (Shift-Command-R) Refreshes the media list.

Reveal in Finder (Mac). (Option-Command-R) Opens the folder containing the 
selected media file.
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Library Menu
On the Mac, the menu items in the Library menu are enabled only when the Workflow 
window is open.

Show | Hide Library (Mac). (Command-L) When hidden, select to display the Library 
panel. When displayed, hides the library panel.

Browse Workflows. (Win: Control-Alt-W/Mac: Option-Command-1) Select to display 
the Workflows tab in the library.

Browse Sources. (Win: Control-Alt-S/Mac: Option-Command-2) Select to display the 
Sources tab in the library.

Browse Encoders. (Win: Control-Alt-E/Mac: Option-Command-3) Select to display the 
Encoders tab in the library.

Browse Deployments. (Win: Control-Alt-D/Mac: Option-Command-4) Select to display 
the Deployments tab in the library.

New Source. (Mac: Command-U) Select to create a new, unnamed source task in the 
library. This command can create a watch folder or a file list, depending on what you 
select in the menu.

New Encoder. (Mac: Command-K) Select to create a new, unnamed encoder task in the 
library.

New Deployment. Select to create a new, unnamed deployment task in the library. On 
Windows, selections are available directly in this menu.

Rename <item>. (Mac: Delete) Select to highlight the name text of the selected item 
(in any of the sections) in the library, so you can edit it.

Duplicate <item>. (Win: Control-D/Mac:Command-D) Select to duplicate the item in 
the library. Episode creates a new item identical to the selected item, adding a numeric 
suffix to its name. Edit the name of the duplicated item as appropriate.

Remove <item>. (Delete) Select to permanently remove the selected workflow in the 
library.

Add/Copy to Workflow/Workspace. (Win: +/Mac: Command-Down Arrow) Select to 
add the selected library task to the current workflow. In the case of a source task, the 
current task (if any) is replaced by the new task, because only one source per workflow 
is permitted.

Copy to Library (Mac). (Command-Up Arrow) Select to add the current workflow task 
to the Library.
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Tools Menu (Win)
Submit Workflow. (Control-R) Select to activate a workflow and begin monitoring, 
encoding, and deploying.

Submit Workflow As MBR. (Control-B) Select to activate a workflow and begin 
monitoring, encoding, and deploying a multi-bit-rate workflow. (MBR is available only 
with Pro and Engine licenses.)

Preferences. Select to open the Preferences panel and set preference options.

Inspector Menu (Mac)
Show | Hide Inspector. (Command-I) Display the Inspector panel. Hide the Inspector 
panel if it is currently displayed.

Expand All Panes. (Shift-Command-=) Display all panes for the selected item for 
viewing and editing.

Collapse All Panes. (Command-=) Close all panes for the selected item.

Format (Command-7) | Video Filters (Command-8) | Audio Filters(Command-9) | 
Split-and-Stitch (Command-0) | Metadata (Command-Minus) Pane. When an 
encoder task is selected, use these menu items to hide or show individual Inspector 
panels.
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Window Menu (Mac)
The top half of this menu displays the standard application minimize, close, and zoom 
functions. The bottom of the menu displays all open windows so you can click an item 
in the list to bring that window to the front. The frontmost window has a check beside 
its menu item. 

The middle menu items described below allow you to display the various Episode 
freestanding windows and panels. 

Show Workflow Editor. (Command-1) Select to display the Workflow window. 

Generate Preview File. (Command-2) Select to initiate a preview encode of the selected 
file using the current workflow, and places the output file in the default folder specified in 
Episode Preferences. 

A Preview window shows an encoding progress bar and presents these controls: 

• Cancel stops the preview encode and closes the Preview window.

• Close when finished automatically closes the window when encoding finishes.

• Close closes the Preview window. 

• Open opens the finished encoded file in your computer’s default video player. 

Show Status. (Command-3) Select to display the Status window. 

Show Cluster Browser. (Command-4) Select to display the Cluster Browser window. 

Show MBR Submission. (Command-5) Select to show Multi-Bitrate window.

Show Error History. (Command-6) Select to display the Error History window.

Help Menu
Episode Help. Displays the Episode User’s Guide (the document you’re currently 
reading) and support information.

Technical Support Information (Win)/Gather Support Documents (Mac). Displays a 
tabbed window with information beneficial to assisting user’s with problems using 
Episode. Click OK to save all of this information in a zip file, which you can send to 
Telestream Customer Service for analysis.

About (Win). Displays the About Episode window, where you can view the version of 
Episode you’re using.
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Shortcuts By Menu
Episode provides shortcuts for many menu items. These tables list Episode menu items 
with shortcuts, organized by menu. Common operating system shortcuts, such as in 
the Edit menu, are not listed.

Episode Menu Item Shortcuts (Mac)

Menu Item Shortcut

Preferences Command-Comma

File Menu Item Shortcuts

Menu Item Shortcut

New Workflow Win: Control-N
Mac: Command-N

New Source (Mac) Option-Command-N

New Encoder (Mac) Control-Command-N

New Deployment (Mac) Shift-Command-N

Use Selected Deployment for 
All Encoders (Mac)

Option-Command-A

Save Task As (Win) Control-Alt-Shift-S

Save Workflow (Mac) Command-S

Save Workflow As Win: Control-Shift-S
Mac: Shift-Command-S

Save All (Mac) Option-Command-S

Import Win: Control-O
Mac: Option-Command-I

Export Task (Mac) Option-Command-E

Export Workflow (Mac) Control-Command-E

Submit Workflow (Mac) Command-R

Submit Workflow as MBR (Mac) Command-5

Edit Menu Item Shortcuts

Menu Item Shortcut

Select All Command-Comma
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View Menu Item Shortcuts (Win)

Menu Item Shortcut

Preview Control-1

Cluster Browser Control-2

Media Browser/Media Menu Item Shortcuts

Menu Item Shortcut

Show | Hide Media Browser 
(Mac)

Option-Command-M

View as List/Icons (Mac) Option-Command-L

Add Bookmark (Mac) Command-B

Add As Watch Folder Control - +

Add As Deployment Alt - +

Add to Workflow +

Refresh (media view) Shift-Command-R

Reveal in Finder Option-Command-R

Library Menu Item Shortcuts

Menu Item Shortcut

Show | Hide Library (Mac) Command-L

Browse Workflows Win: Control-Alt-W
Mac: Option-Command-1

Browse Sources Win: Control-Alt-S
Mac: Option-Command-2

Browse Encoders Win: Control-Alt-E
Mac: Option-Command-3

Browse Deployments Control-Alt-D
Option-Command-4

New Source (Mac) Command-U

New Encoder (Mac) Command-K
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New Deployment

Rename Item

Duplicate Item Control-D
Command-D

Remove Item

Remove Item (Mac) Delete

Add to Workflow Win: +

Mac: Command-Down Arrow

Copy to Workspace Command-Down Arrow

Copy to Library (Mac) Command-Up Arrow

Tools Menu Item Shortcuts (Win)

Menu Item Shortcut

Submit Workflow Control-R

Submit Workflow as MBR Control-B

Preferences

Inspector Menu Item Shortcuts (Mac)

Menu Item Shortcut

Show | Hide Inspector Command-I

Expand All Panes Shift-Command-=

Collapse All Panes Command-=

Format Pane Command-7

Video Filters Pane Command-8

Audio Filters Pane Command-9

Split-and-Stitch Pane Command-0

Metadata Pane Command-Minus

Library Menu Item Shortcuts
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Window Menu Item Shortcuts (Mac)

Menu Item Shortcut

Minimize Command-M

Minimize All

Close Command-W

Zoom

Bring All to Front

Show Workflow Editor Command-1

Generate Preview File Command-2

Show Status Command-3

Show Cluster Browser Command-4

Show MBR Submission Command-5

Show Error History Command-6
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Video Encoding Concepts
This chapter discusses encoding concepts and how they apply to Episode transcoding.

■ File (Container) Formats And Codecs

■ Color Formats

■ Video Scan

■ Frame Types and I, P, and B Frames

■ Picture Resolution and Aspect Ratio

■ CBR, VBR, and Quality-Based VBR

■ VBV Video Buffer Verifier

■ Frame Skip Probability Smooth Motion Vs. Crisp Image

File (Container) Formats And Codecs
Many media file/container formats are actually wrappers—they contain video and/or 
audio data encoded with one of a number of codecs—each with their own format.

While many media files contain a single audio track, or a single video (with audio) track, 
some media file formats (QuickTime MOV format for example) contain multiple media 
tracks. 

Each track may have a different resolution, bandwidth, language, etc. Consequently, 
even though a file may be in a format supported by Episode, the media contained 
inside the file may be encoded with a codec that is not supported, leading to an error 
during transcoding. 

For details on the encoders and codecs supported by Episode, see Media Containers/
Formats.
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Color Formats
The most basic way to represent color in both still and moving digital images is to use 
the RGB color space. In RGB each pixel has three values: red, green and blue, which are 
mixed to generate the intended color. This is the way most computers store and display 
color.

However, the RGB color space is not represented in most video codecs, due to the way 
television emerged, at first with only black and white images and later with color 
images.

The color format for television was designed to contain all the black and white 
information in one channel, and the color information in two additional channels. The 
black and white channel is called luma (light), and the two color channels are called 
chroma (color). The separation of luma and chroma make it possible for older, black and 
white televisions to still work, only processing the black and white image, while color 
televisions can benefit from the color information.

This color space is called YUV, or YCbCr. Y is the luma and U (Cb) and V (Cr) are color 
differences—the luma subtracted from a transformed blue and red, respectively. (The 
green values are not passed in the signal—they are computed from these values.) This 
encoding has several advantages over RGB in terms of video compression, since most 
of the image information ends up in the luma channel and the chroma channels hold 
much less information for most video material. This, in combination with the fact that 
human visual perception is less sensitive to color than to brightness, makes it possible 
to sample the chroma more sparsely, thereby reducing the amount of data required to 
store (and transmit) an image.

The subsampling pattern is commonly given in the notation (a):(b):(c), which is 
interpreted in the following manner: In a block of size (ax2) there are (ax2) luma 
samples. (b) is the number of chroma samples along the top row and (c) is the number 
of chroma samples along the bottom row. In other words, 4:4:4 means there is a chroma 
sample for each luma sample—no subsampling. 4:4:0 means every second row has full 
chroma samples and every second is skipped. 4:2:2 means every second column has 
full chroma samples and every second is skipped. These two therefore have (2/3) the 
number of total samples, compared to 4:4:4. 4:2:0 means every second row has chroma 
samples for every second column, thus halving the number of total samples compared 
to 4:4:4.

Luma and chroma samples are not necessarily taken at the same positions relative to 
image pixels, but that is beyond the scope of this manual. For more information, refer to 
an article by Doug Kerr: Chrominance Subsampling in Digital Images (The Pumpkin, 
November 2005).



Video Encoding Concepts
Video Scan

171
Video Scan
Video material (de-interlaced or interlaced) can be rendered either a full frame at a 
time, a progressive scan, or with every other line of the frame at a time—interlaced 
scan.

The two half-frames in interlaced video are referred to as the top and the bottom fields. 
One of the fields is the dominant field and should always be played back first. 

When encoding material to be recorded on DVD and played back on a television, it is 
important that the dominant field is set as the first field. If you have not edited the 
material you are going to encode, it can be difficult to know whether the dominance 
lies in the top or bottom field. 

These are the normal field dominances of common formats:

Much of today’s digital video is generated from non-interlaced film material, where a 
single film frame may be sampled several times to generate video fields. This technique 
is known as telecine.

For NTSC material this is typically done by taking 3 fields from one frame and 2 from the 
next (known as 3-2 pulldown); for PAL, 2-2 pulldown is normal. Knowing this sequence 
of fields—the cadence—can greatly improve the quality of deinterlacing. Typically 
subsequent editing breaks up the cadence, but Episode detects and adapts to broken 
cadences.

For more information, read the article entitled DVD benchmark—Part 5—Progressive 
scan DVD, by Don Munsil and Brian Floria in Secrets of Home Theater and High Fidelity, 
7(4), October 2000.

Note: The preferred method of working with interlaced material in Episode is to 
deinterlace any interlaced source material to double-frame rate progressive material, 
apply video filters and then, if needed, re-interlace the material before creating the 
output file. See Field Order Filter, Frame Rate Filter, Deinterlace Filter, Advanced Frame 
Rate Filter, and Interlace Filter for further information.

Common Formats and Field Dominance

Format Field dominance

DV 25 Bottom Field

DVCPRO 25/50 Bottom Field

DVCPRO 100 HD Top Field

IMX Top Field

Apple Intermediate Codec Top field

Uncompressed 4:2:2 Top field
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Frame Types and I, P, and B Frames
Except for raw data formats and editing formats such as DV or Motion JPEG, most video 
formats do not simply consist of a sequence of frames, allowing them to be decoded 
independently. Since a video frame often looks a lot like its neighboring frames, a video 
codec typically searches for differences between frames to achieve a good 
compression ratio (temporal compression). Only the differences between these frames 
are stored in the encoded video file. However, for the encoded stream to be decodable, 
independent frames with full content—which can be decoded directly—must be 
scattered throughout the clip. These frames are called keyframes, or I-frames.

To decode a frame at a certain time in the movie the decoder must therefore begin the 
decoding process at the nearest previous key-frame and decode to the desired frame. 
Keyframes spaced far apart make the clip hard to search, but result in a good 
compression ratio. Accordingly they are good for streaming material in which searching 
is not usually done. A compromise is to limit the distance between keyframes to some 
maximum distance. This is used in most encoded video material.

A frame that predicts data from a previous frame is called a P-frame (Predictive Frame). A 
frame that predicts data from both a previous and a subsequent frame is called a B-
frame (Bi-Predictive Frame). The use of B-frames provides a somewhat better 
compression ratio, but is also more CPU intensive.

In MPEG-derived formats, the sequence of frames from an I-frame to the next I-frame is 
known as a Group Of Pictures (GOP).

Picture Resolution and Aspect Ratio
A digital video frame is a serial stream (ordinal sequence) of pixels which represents (or 
displays as) a two-dimensional lattice of pixels, where each pixel has a given color.

Aspect Ratio Example
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In the diagram above, a lattice of (m x n) pixels is represented. M x N represents the 
pixel resolution of the image. The aspect ratio of the display is (width:height). While 
computer displays normally have an aspect ratio which is identical to (m:n) (thus the 
pixels are square), this is often not true for televisions.

In cases the pixels on the monitor are not square, the pixel aspect ratio = pixel 
width:pixel height <> 1:1.

For example, PAL is defined as 720 x 576 pixels, with a display aspect ratio of (4:3. Since 
720:576 = 5:4 this means the pixel aspect ratio is 16:15.

SVCD is a video format that is stored on CDs and often played on computers. SVCD 
stores NTSC video in 480 x 480 pixels with a pixel aspect ratio of 4:3. The consequent 
display aspect ratio of 4:3 requires the player software to stretch the pixels, 
interpolating along the horizontal axis to show the image on 640 x 480 square pixels. 
Compressing dimensions in this way is known as anamorphic video.

Some codecs (D-10/IMX, DV, MPEG-2 and MPEG-4 in particular) allow the user to set a 
display aspect ratio for the output video in order to inform a player of the desired 
aspect ratio for viewing. However, this field is inconsistently used—in particular its 1:1 
setting does not mean that the display is square, but rather that the pixels themselves 
have a square aspect ratio. Often this field is also labelled as pixel aspect ratio. There is a 
risk that different equipment interprets this field in different ways.

QuickTime enables you to explicitly set the pixel aspect ratio if it is different from the 
display aspect ratio.

In Episode, you can also use the resize filter and the codec settings to manage pixel 
resolution and aspect ratio. See Resize Filter. 

For example, to create an SVCD video, use the resize filter and set both Width and 
Height to 480 in order to get the desired pixel resolution. Set the Aspect Ratio to 4:3 in 
the MPEG-2 codec settings to get the desired display aspect ratio.

If the input data has a non-square aspect ratio and this is not indicated in the source file 
(or if you wish to override this setting), you can configure the resize filter to use the 
Input display aspect ratio menu. Continuing with the example of SVCD video, first 
convert it to PAL output. The (m:n) ratio is not the same for SVCD and PAL, so you 
should select Cut in the Maintain Proportion With menu and set the Input display 
aspect ratio to Assume 4:3. In the codec, set Aspect ratio to 4:3 or Same as Input. 

Finally, to convert from one pixel resolution to another, you have two options: either to 
scale the smallest dimension to fit the output format and cut off parts of the largest 
dimension, or to scale the largest dimension to fit and pad the smallest dimension with 
black.

Example: You have an HD video of 1280 x 720 pixels and you want to encode it as a PAL 
video at 720 x 576 pixels while retaining as much of the picture as possible. You use the 
resize filter and set the Maintain Proportion With menu to Letterbox (Pad), scaling 
down the width of the picture until it fits. This shrinks the vertical dimension to 324 
pixels and the picture has 126-pixel black borders along the top and bottom as shown 
in the figure below.
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Converting HD to PAL with Letterbox Formatting

The other alternative is to select Cut, where the vertical dimension is scaled to 576 
pixels and the horizontal to 1024 pixels, of which 152 are cut off at both the left and 
right sides as shown below:

Converting HD to PAL with Cut Formatting

Letterbox formatting retains the full width and fills in missing height and width; Cut 
formatting retains the full height, but trims the edges. For more precise control you can 
use the Initial crop values to crop parts of the picture before scaling with either cutting 
or padding.
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CBR, VBR, and Quality-Based VBR
Constant Bit Rate (CBR), Variable Bit Rate (VBR) and Quality-Based VBR are encoding 
options available in several video encoders. A clip encoded in CBR mode has a relatively 
constant bit rate throughout its duration. CBR encoding is necessary when the content 
is distributed over networks or from devices that cannot handle peaks that are higher 
than the average bit rate.

However, the use of true CBR (also called Flat Rate), is difficult since it requires every 
encoded video frame to be exactly equal in size. This degrades visual quality. I-frames, 
for example, must be larger for overall quality to be high.

Different segments of a movie often require different bit rates in order to maintain 
constant quality. The quality delivered by most modern video encoders partly depends 
on the amount of motion and fine detail in the material. For this reason, VBR is superior, 
while keeping the average rate at the desired level. VBR is more suitable for playback on 
devices with higher available bandwidth. Since the average rate is known, it is still 
possible to predict the resulting file size with good accuracy.

When quality is most important, Quality-Based VBR is the best encoding mode. Using 
this mode you only specify the desired quality of the encoded material.

For each segment of the clip, the encoder uses the bit rate required to reach the 
specified quality. Thus, file size cannot be predicted, since it depends on how difficult 
the clip is to compress. For example, for the same visual quality, a 30-second clip of a 
news anchor (low movement) yields a small file while a 30-second clip of a football 
game (high movement) is significantly larger.

VBV Video Buffer Verifier
To control variations in bit rate when encoding, a Video Buffer Verifier (VBV) is used. The 
buffer size determines the elapsed time over which the bit rate must be kept constant. 
Episode measures the VBV in seconds. A buffer size of 0-5 seconds is considered CBR. 
Setting the VBV value greater than 5 seconds is considered VBR. During the specified 
VBV period the bit rate may vary without limits, as long as the average rate in the region 
is correct.

This enables the codec to use higher bit rates for difficult segments and lower bit rates 
for easier segments. A larger VBV enables the codec to encode difficult passages better, 
since the bit rate is allowed to peak for a longer period of time. Some specifications 
specify the buffer size in bits. In these situations, you can convert to seconds by 
dividing by the bit rate.

Since the buffer size determines how much the bit rate may vary, it sets a constraint on 
how long a player must buffer before starting playback, to ensure smooth playback 
without need for re-buffering.

In practice, the size of the VBV buffer is a trade-off. A large VBV enables the encoder to 
vary the bit rate more freely depending on the difficulty of the current part of the 
material, while maintaining the correct average bit rate. However, the player has to 
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buffer a larger portion of the clip before playback can be started. A small VBV forces the 
codec to encode at a more constant bit rate throughout the clip. This results in lower 
quality for difficult passages, but the buffer time for the player is lower.

When encoding a clip with Quality-Based VBR there is no constraint on the size of the 
VBV—it is ignored.

Frame Skip Probability Smooth Motion Vs. Crisp 
Image

In order to maintain the specified bit rate, most video encoders vary the quality of the 
encoded clip. Another alternative supported by some encoders is to skip frames when 
the bit rate gets too high. This enables the encoder to keep a higher quality for each 
encoded frame, but the motion of the video is not as smooth. Depending on the 
material being encoded, smooth motion may be more important than crisp image and 
vice versa. 

The frame skip probability controls the trade-off between skipping frames and 
lowering quality. A frame skip probability of 1 means that when the encoder has to 
choose between lowering the quality or skipping a frame, it skips a frame. A probability 
of 0 does not mean frames are never skipped, but that it only happens when image 
quality cannot be lowered more.

Frame skip probability is also important to use when creating content for networks 
with extreme bandwidth limitations such as GPRS, 3G or when streaming over 
modems. These networks sometimes cannot handle even the slightest peaks over the 
specified bit rate, and frames can be skipped to avoid this. When streaming to such a 
device, set the priority towards sustaining the bit rate and sacrificing the frame rate if 
necessary. 

When encoding for a less bandwidth limited target platform, such as local playback on 
a computer, the frame skip probability value can be set lower. This is possible since the 
data rate from the computer's hard drive is sufficient to handle quite large bit rate 
peaks.
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Media Containers/Formats
This chapter describes each of the container/file formats you can decode or encode in 
Episode, including each user-configurable setting. Each has a default file extension, 
which you can change as required. Many formats also have settings that you can 
configure. 

Note: For a complete list of supported formats, see the Specifications document at 
http://www.telestream.net/episode/tech-specs.htm.

Each format supports a specific set of video and/or audio codecs, with details including 
its ability to decode (in) and encode (out), plus notes about required subsystems and 
other limits, as appropriate.

Episode decodes only one (the first) audio track in source files it processes, except for 
MOV and MXF files. The track may contain multiple channels.

Episode decodes all audio tracks and channels in MOV and MXF source and creates one 
track with all channels in it. For example, 2 stereo tracks becomes one track with 4 
channels.

Note: Some formats require Episode Pro | Episode Engine, as noted.

■ 3GPP (.3gp)

■ 3GPP2 (.3g2)

■ 3GPP2 EZmovie (.3g2)

■ AC3/ATSC A/52 (.a52)

■ ADTS (.aac)

■ AIFF (.aif )

■ AMR (.amr)

■ AVCHD (.mts|.m2ts)

■ AVI (.avi)

■ DV-Stream (.dv)

http://www.telestream.net/episode/tech-specs.htm
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■ GXF (.gxf )

■ iTunes Audio (.m4a)

■ iTunes Video (.m4v)

■ MOV (.mov)

■ MP3 (.mp3)

■ MP4 (.mp4)

■ MPEG Audio (.m1a)

■ MPEG-ES (.m1v)

■ MPEG-ES (.m2v)

■ MPEG-PS (.mpg)

■ MPEG-TS (.ts)

■ Multi Bitrate DASH, HTTP (HLS), and Smooth Streaming

■ MXF AS-11 (.mxf )

■ MXF Op1a (.mxf )

■ MXF OpAtom Audio (.mxf )

■ MXF OpAtom Video (.mxf)

■ MXF Sony XAVC

■ MXF XDCAM (.mxf)

■ OGG (.ogg)

■ PSP (.mp4)

■ TIFO (.tifo)

■ WAV (.wav)

■ WebM (.webm)

■ WMA (.wma)

■ WMV (.wmv)
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3GPP (.3gp)
3GPP (3rd Generation Partnership Project) video format is based on MPEG-4 file format 
and GSM specifications. 3GPP specifies video standards for 3G technology known as 
UMTS. 3GPP is intended for use on mobile phones.1

Codecs

Settings

3GPP Settings

3GP Version. Select 3GPPv5 | 3GPPv6 depending on the target players.

For broadest compatibility, select 3GPP version 5, because many older mobile phones 
that cannot play 3GPP version 6. Most version 6 phones are backward-compatible with 
version 5.

Fast start. Check to add information to the file which enables a player to start playing 
the file before it has completely downloaded (progressive download). Fast start 
functionality is an alternative to streaming media.

1. 3rd Generation Partnership Project. Digital cellular telecommunications system (Phase 2+); Universal Mobile 
Telecommunications System (UMTS); LTE; Transparent end-to-end packet switched streaming service (PSS); 3GPP file 
format (3GP), v 9.1.0 edition, 2010 www.3gpp.org.

3GPP (.3gp) Codecs

Codec Episode Episode Pro Episode Engine Notes

AAC in/out in/out in/out

AMR out out out Out requires Pro Audio Option

H.263 in/out in/out in/out

H.264 in/out in/out in/out

HE-AAC out out

MPEG-4 in/out in/out in/out

http://www.3gpp.org/ ftp/Specs/archive/26_series/26.244/26244-910.zip
http://www.3gpp.org/About-3GPP
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Audio & Video Streaming
MP4 supports streaming of H263 | H264 | MPEG-4 video, and AAC | AAC QuickTime | 
AMR audio. Both video and audio codecs must support streaming to enable streaming.

H263 Packetizer

H263 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

Packetizing Type. Select 1998 (QT) | 2000.

Insert Extra Headers. Check to enable error correction.

H264 Packetizer

H264 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

MPEG-4 Packetizer

MPEG-4 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

AAC Packetizer

AAC Packetizer Settings

Encoding. Select from these options:

Generic (ISMA and QuickTime Default) is the best to use for Web media.
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LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.

Packet Size Limit. Specify the maximum packet size, in bytes.

AMR Packetizer

AMR Packetizer Settings

Frames Per Packet. Use the slider (or manually enter) to specify the number of frames 
per packet. A higher number improves bandwidth efficiency, but a player may not be 
able to store all frames. Range: 1 to 10.

Packetizing Mode. Select from these options:

Octet Align packetizing mode is supported by all players.

Bandwidth Efficient packetizing mode is not supported by all players, but can make 
better use of available bandwidth.

Cyclic Redundancy Check. Check to add CRC so the client can verify content validity 
errors that may have occurred in transmission. Not supported by all players.

Robust Sorting. Check to reorder data to decrease the impact of transmission errors. 
Not supported by all players.
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3GPP2 (.3g2)
3GPP2 (3rd Generation Partnership Project 2) video format is based on MPEG-4 file 
format and 3G CDMA technology. 3GPP2 is intended for use on mobile phones1. 3GPP2 
serves a similar purpose but is a different format from 3GPP.

Codecs

Settings
Except for File Extension (default .3g2), there are no user-configurable settings. 

Audio & Video Streaming
3GGP2 format supports streaming of H263 | H264 | MPEG-4 video, and AAC | AAC 
QuickTime | AMR audio. Both video and audio codecs must support streaming to 
enable streaming.

H263 Packetizer

H263 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

Packetizing Type. Select 1998 (QT) | 2000.

Insert Extra Headers. Check to enable error correction.

1. 3rd Generation Partnership Project 2. 3GPP2 File Formats for Multimedia Services. www.3gpp2.org.

3GPP2 (.3g2) Codecs

Codec Episode Episode Pro Episode Engine Notes

AAC in/out in/out in/out

AMR out out out Output (encoding) requires Pro 
Audio Option.

H.263 in/out in/out in/out 

H.264 in/out in/out in/out

HE-AAC in in 

MPEG-4 in/out in/out in/out

http://www.3gpp2.org/Public_html/specs/C.S0050-B_v1.0_070521.pdf
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H264 Packetizer

H264 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

MPEG-4 Packetizer

MPEG-4 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

AAC Packetizer

AAC Packetizer Settings.

Encoding. Select from these options:

Generic (ISMA and QuickTime Default) is the best to use for Web media.

LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.

Packet Size Limit. Specify the maximum packet size, in bytes.

AMR Packetizer

AMR Packetizer Settings

Frames Per Packet. Use the slider (or manually enter) to specify the number of frames 
per packet. A higher number improves bandwidth efficiency, but a player may not be 
able to store all frames. Range: 1 to 10.

Packetizing Mode. Select from these options:
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Octet Align packetizing mode is supported by all players.

Bandwidth Efficient packetizing mode is not supported by all players, but can make 
better use of available bandwidth.

Cyclic Redundancy Check. Check to add CRC so the client can verify content validity 
errors that may have occurred in transmission. Not supported by all players.

Robust Sorting. Check to reorder data to decrease the impact of transmission errors. 
Not supported by all players.
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3GPP2 EZmovie (.3g2)
3GPP2 EZmovie format is 3GPP2-compatible video extended with EZmovie features 
developed by KDDI Corporation1, which can be used on devices that use KDDI’s mobile 
video application or others that support these features.

Codecs

Settings

3GPP2 EZmovie Settings

Restrict Distribution. Check to implement distribution restriction mechanisms.

Restrict Playback. Check to limit the number of times the file can be played.

Playback Count. Integer value determines the number of times the file can be played.

Restrict Expiration. Check to limit the number of days the file can be played.

Expiration Time (Days). Specify an integer value for the number of days this video can 
be played, after which it expires and can not be played.

Note: A player may ignore these restrictions.

1.Ezmovie. www.au.kddi.com

3GPP2 (.3g2) EZMovie Codecs

Codec Episode Episode Pro Episode Engine Notes

AAC in in/out in/out

AMR out out out Output (encoding) requires Pro 
Audio Option.

H.263 in in/out in/out

H.264 in in/out in/out

HE-AAC in in in

MPEG-4 in in/out in/out

http://www.au.kddi.com/ezfactory/tec/spec/ezmovie01.html
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AC3/ATSC A/52 (.a52)
ATSC A/52, also known as AC-3, is an audio format developed by Advanced Television 
Systems Committee1 for use in HDTV digital television and DVD applications. 

This format requires the Episode Pro Audio option.

Codecs

Settings
Except for File Extension (default .a52), there are no user-configurable settings.

1. Advanced Television Systems Committee. Digital Audio Compression Standard (AC-3, E-AC-3), 2010. www.atsc.org.

ATSC A/52 (.a52) Codecs

Codec Episode Episode Pro Episode Engine Notes

A-52 in/out in/out in/out

http://www.atsc.org/cms/standards/a_52b.pdf
http://www.atsc.org/cms/standards/a_52-2010.pdf
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ADTS (.aac)
ADTS (Audio Data Transport Stream) is a wrapper format for AAC-encoded audio files.1 
ADTS is used by MPEG TS and others to stream audio.

Codecs

Settings
Except for File Extension (default .aac), there are no user-configurable settings.

1. International Organization for Standardization. Information technology—Generic coding of moving pictures and 
associated audio information—Part 7: Advanced Audio Coding (AAC), 2006.

ADTS (.aac) Codecs

Codec Episode Episode Pro Episode Engine Notes

AAC in/out in/out in/out 

HE-AAC in in in/out



Media Containers/Formats
AIFF (.aif )

188
AIFF (.aif)
AIFF (Audio Interchange File Format) is an audio file format standard for playback on 
personal computers and other audio devices, co-developed by Apple.1 

The audio data in AIFF is uncompressed, lossless PCM used by professional-level audio 
and video applications, unlike the better-known lossy MP3 format.

Codecs

Settings
Except for File Extension (default .aif ), there are no user-configurable settings.

1. Apple. Audio Interchange File Format: AIFF, version 1.3 edition, 1989

AIFF (.aif ) Codecs

Codec Episode Episode Pro Episode Engine Notes

PCM in/out in/out in/out
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AMR (.amr)

Note: The AMR container and codec are available only with Pro Audio Option.

AMR (Adaptive Multi-Rate) is a standard, mandatory audio codec in 3GPP.1 AMR is a 
speech format, designed for storing the spoken word but unlikely to give acceptable 
results for music audio.

Codecs

Settings
Except for File Extension (default .amr), there are no user-configurable settings.

1. Internet Engineering Task Force. RTP Payload Format and File Storage Format for Adaptive Multi-Rate (AMR) & 
Adaptive Multi-Rate Wideband Audio Codecs, 2007. www.rfc-editor.org

AMR (.amr) Codecs

Codec Episode Episode Pro Episode Engine Notes

AMR out out out Requires Pro Audio Option

http://www.rfc-editor.org/rfc/rfc4867.txt
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AVCHD (.mts|.m2ts)
Episode can decode AVCHD media from QuickTime (mov) files and MPEG Transport 
Stream (.mpg) files.

AVCHD is a term that camera manufacturers have coined to describe their recording 
format. It is also a term used to describe particular aspects of MPEG4, specifically H.264. 
In the context of Episode decoding, it is used to describe files produced by cameras. 

The container is usually MPEG transport stream (.mts | .m2ts).

Codecs
AVCHD (.m2ts) Codecs

Codec Episode Episode Pro Episode Engine Notes

H264 in in in

MPEG-4 in in in
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AVI (.avi)
AVI (Audio Video Interleave) is a multimedia (audio and video) container format 
developed by Microsoft in 1992.1 AVI allows synchronous audio-with-video playback.

Many AVI files also use the file format extensions developed by the Matrox OpenDML 
group. These extensions are supported by Microsoft, and are unofficially called AVI 2.0.

Codecs

Settings

AVI Settings

Version. Select Version 1 (Regular AVI) | Version 2 (Large Files). Version 2 is not supported 
by all players. but enables encoding of source files larger than 4GB.

1. AVI File Format, 2010. msdn.microsoft.com.

AVI (.avi) Codecs

Codec Episode Episode Pro Episode Engine Notes

BlackMagic in in in

DV 25 in/out in/out in/out 

DVCPro in in/out in/out

DVCPro 50 in in/out in/out

MJPEG in in/out in/out

MP4 out out out 

MP3 in/out in/out in/out 

PCM in/out in/out in/out 

Windows RGB in in/out in/out

YCbCr in in/out in/out

http://msdn.microsoft.com/en-us/library/dd318187(v=VS.85).aspx
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DV-Stream (.dv) 
DV (Digital Video) format (originally known as Blue Book) was developed by a group of 
leading video camera manufacturers.1

Audio in DV is stored uncompressed as either 16-bit linear PCM at 48kHz or 4 nonlinear 
12-bit PCM channels at 32 kHz. DV also supports 16-bit audio at 44.1 kHz.

Codecs

Settings
Except for File Extension (default .dv), there are no user-configurable settings.

1. International Electrotechnical Commission. Helical-scan digital video cassette recording system using 6.35 mm 
magnetic tape for consumer use (525-60, 625-50, 1125-60 & 1250-50 systems), 2001.

DV-Stream (.dv) Codecs

Codec Episode Episode Pro Episode Engine Notes

DV 25 in/out in/out in/out 

DVCPro 25 in/out in/out in/out 

DVCPro 50 in/out in/out in/out 

DV Audio in/out in/out in/out
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GXF (.gxf)
GXF (General eXchange Format) is an interchange format for storage and data transfer 
originally developed by Grass Valley Group.1

Codecs

Settings
Except for File Extension (default .gxf ), there are no user-configurable settings.

1. Society of Motion Picture and Television Engineers. General Exchange Format (GXF), 2009.

GXF (.gxf ) Codecs

Codec Episode Episode Pro Episode Engine Notes

MPEG-2 in in/out in/out

MPEG-2 HD in in/out in/out

PCM in in/out in/out
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iTunes Audio (.m4a)
iTunes Audio is AAC audio in an MPEG-4 wrapper, containing the audio layer (non-
video) of an MPEG-4 movie file. Also known as Apple Lossless.

Codecs

Settings
Except for File Extension (default .m4a), there are no user-configurable settings.

iTunes Audio (.m4a) Codecs

Codec Episode Episode Pro Episode Engine Notes

AAC in/out in/out in/out 

HE-AAC in in in
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iTunes Video (.m4v)
iTunes Video is an MPEG-4 multi-media (audio and video) wrapper intended for playing 
files in iTunes. This format supports copyright protection.

Codecs

Settings
Except for File Extension (default .m4v), there are no user-configurable settings.

iTunes Video (.m4v) Codecs

Codec Episode Episode Pro Episode Engine Notes

AAC in/out in/out in/out 

H.264 in/out in/out in/out 

MPEG-4 in/out in/out in/out
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MOV (.mov)
MOV format is an Apple QuickTime multimedia framework described in the QuickTime 
File Format Specification available by searching Apple.com.

Episode decodes all audio tracks and channels in MOV and MXF sources and creates 
one track with all channels in it. For example, 2 stereo tracks become one track with 4 
channels. 

Codecs
MOV (.mov) Codecs

Codec Episode Episode Pro Episode Engine Notes

AVC-Intra 50 in in/out in/out

AVC-Intra 100 in in/out in/out

AAC in/out in/out in/out

AMR out out out

Apple 
Uncompressed

in/out in/out in/out

Avid DNxHD/
DNxHR

in/out in/out in/out

Black Magic in in/out in/out

D-10/IMX in in /out in/out

DV 25 in/out in/out

DVCPro 25 in/out in/out in/out

DVCPro 50 in/out in/out in/out

DVCPro 100/HD in/out in/out in/out

H.263 in/out in/out in/out

H.264 in/out in/out in/out

HDV in in /out in/out

HE-AAC in in in

HEVC (x265) in/out in/out in/out

D-10/IMX in in /out in/out

JPEG 2000 in in/out in/out
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Settings

MOV Settings

Disable Saving. Check to prevent others from transcoding the output file to other 
formats.

Add QuickTime Timecode Track. Check to add a QuickTime timecode track in 
conjunction with the Timecode option. The timecode track can be toggled on or off in 
QuickTime Player.

MJPEG in in/out in/out

MP3 in/out in/out in/out

MPEG-4 in/out in/out in/out

PCM in/out in/out in/out

ProRes 4:2:2 and 
4:4:4:4

in/out in/out in/out

Windows output 
available only on 
Windows Server 
2012. 

RAW in/out in/out in/out

RGB Levels

Targa Cine YUV in in/out in/out

XDCAM in in in/out

XDCAM EX in in/out in/out

XDCAM HD in in/out in/out

XDCAM HD 422 in in/out in/out

YCbCr in in /out in/out

MOV (.mov) Codecs

Codec Episode Episode Pro Episode Engine Notes
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Note: QuickTime Player Version 7.6.6 and earlier fails to increment the timecode for 
the first B-frame in a video, causing the timecode to seem out of sync, but no frames 
are skipped.

Fast Start. Check to add information to the file which enables a player to start playing 
the file before it has completely downloaded (progressive download). Fast start 
functionality is an alternative to streaming media.

Add Clean Aperture Atom (CLAP). Check to add information (metadata) to the file to 
crop the video to the clean aperture region, which is the part of the video image that is 
free from transition artifacts caused by signal encoding.

Add File Type Atom. Check to include file type information (metadata).

Audio & Video Streaming
MOV format supports streaming of H263 | H264 | MPEG-4 video, and AAC | AMR audio. 
Both video and audio codecs must support streaming to enable streaming.

H263 Packetizer

H263 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

Packetizing Type. Select 1998 (QT) | 2000.

Insert Extra Headers. Check to insert extra headers.

H264 Packetizer

H264 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

MPEG-4 Packetizer

MPEG-4 Packetizer Settings
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Packet Size Limit. Specify the maximum packet size, in bytes.

AAC Packetizer

AAC Packetizer Settings

Encoding. Select from these options:

Generic (ISMA and QuickTime Default) is the best to use for Web media.

LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.

Packet Size Limit. Specify the maximum packet size, in bytes.

AMR Packetizer

AMR Packetizer Settings

Frames Per Packet. Use the slider (or manually enter) to specify the number of frames 
per packet. A higher number improves bandwidth efficiency, but a player may not be 
able to store all frames. Range: 1 to 10.

Packetizing Mode. Select from these options:

Octet Align packetizing mode is supported by all players.

Bandwidth Efficient packetizing mode is not supported by all players, but can make 
better use of available bandwidth.

Cyclic Redundancy Check. Check to add CRC so the client can verify content validity 
errors that may have occurred in transmission. Not supported by all players.

Robust Sorting. Check to reorder data to decrease the impact of transmission errors. 
Not supported by all players.
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MP3 (.mp3)
MP3 (MPEG-1 Audio Layer III) is the audio format of MPEG-1.1

Codecs

Settings

MP3 Settings

Use ID3 tag v 1.1. Check to add ID3 v1.1 metadata tags to the output file.

Use ID3 tag v 2.3. Check to add ID3 v2.3 metadata tags to the output file.

See Adding Metadata for more information on metadata. See www.id3.org for more 
information ID3 tags.

1. International Organization for Standardization. Information technology—Coding of moving pictures and associated 
audio for digital storage media at up to about 1.5 Mbs—Part 3: Audio, 1993.

MP3 (.mp3) Codecs

Codec Episode Episode Pro Episode Engine Notes

MP3 in/out in/out in/out 

http://www.id3.org
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MP4 (.mp4)
MP4 or MPEG-4 Part 14 format is a multimedia container format.1 It is commonly used 
to store digital video and digital audio streams (especially MPEG). Like most modern 
container formats, MP4 can be streamed over the Internet.

Episode can add ODSM (Object Descriptor Stream) and SDSM (Scene Description 
Stream) tracks to MPEG-4 files which are required by some players. A check box in the 
Format panel enables this feature.

Codecs

Settings
These are the user-configurable settings:

Audio & Video Streaming
MP4 supports streaming of H264 | MPEG-4 video, and AAC audio. Both video and audio 
codecs must support streaming to enable streaming in this container.

H264 Packetizer

H264 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

1. International Organization for Standardization. Information technology—Coding of audio-visual objects, 2004.

MP4/MPEG4 (.mp4) Codecs

Codec Episode Episode Pro Episode Engine Notes

AAC in/out in/out in/out audio

H264 
(MainConcept)

in/out in/out in/out 

H264 (x264) in/out in/out in/out

HEVC (x265) in/out in/out in/out

MPEG-4 in/out in/out in/out

XAVC in/out in/out in/out
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MPEG-4 Packetizer

MPEG-4 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

AAC Packetizer

AAC Packetizer Settings

ODSM and SDSM Tracks. A check box at the bottom of the Format panel enables 
these tracks to be included (or excluded by unchecking).

Include Picture Aspect Ratio Box. Adds information about the Pixel Aspect Ratio to 
the video description. This tells the player what aspect ratio to use during video 
playback. As an example, this is useful if the movie is anamorphic.

MP4 Container Selections

Encoding. Select from these options:

Generic (ISMA and QuickTime Default) is the best to use for Web media.

LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.

Packet Size Limit. Specify the maximum packet size, in bytes.
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MPEG Audio (.m1a)
MPEG Audio is an MPEG-1 elementary stream with a single audio track.1 see MPEG 
Audio Codec.

Codecs

Settings
Except for File Extension (default .m1a), there are no user-configurable settings.

1. International Organization for Standardization. Information technology—Coding of moving pictures and associated 
audio for digital storage media at up to about 1.5 Mbs—Part 1: Systems, 1993.

MPEG Audio (.m1a) Codecs

Codec Episode Episode Pro Episode Engine Notes

MPEG-1 in/out in/out in/out
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MPEG-ES (.m1v)
MPEG-ES is an MPEG-1 elementary stream with a single video track.1

Codecs

Settings
Except for File Extension (default .m1v), there are no user-configurable settings.

1. International Organization for Standardization. Information technology –Coding of moving pictures and associated 
audio for digital storage media at up to about 1.5 Mbs—Part 1: Systems, 1993.

MPEG-ES (.m1v) Codecs

Codec Episode Episode Pro Episode Engine Notes

MPEG-1 in/out in/out in/out
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MPEG-ES (.m2v)
MPEG-ES format is an MPEG-2 elementary stream with a single video track.1

Codecs

Settings
Except for File Extension (default .m2v), there are no user-configurable settings.

1. International Organization for Standardization. Information technology—Generic coding of moving pictures and 
associated audio information: Systems, 2007.

MPEG-2 ES (.m2v) Codecs

Codec Episode Episode Pro Episode Engine Notes

MPEG-2 in/out in/out in/out
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MPEG-PS (.mpg)
MPEG-PS (MPEG Program Stream) is a format for multiplexing digital audio, video and 
more. It contains interleaved (multiplexed) packetized elementary streams. Program 
streams are intended for reasonably reliable media such as DVD or SVCD.

Codecs

Settings

MPEG-PS Settings

Max Packet Size. Set the size of interleaved packets (300-5000 bytes).

MPEG-PS (.mpg) Codecs

Codec Episode Episode Pro Episode Engine Notes

AAC out out out

ATSC A-52 in/out in/out in/out Requires Pro Audio option.

H.264 in/out in/out in/out 

MPEG audio in/out in/out in/out

MPEG-2 in/out in/out in/out

MPEG-4 in/out in/out in/out
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MPEG-TS (.ts)

Note: This format is available only in Episode Pro and Episode Engine.

MPEG-TS (MPEG Transport Stream) is a container format for transmission and storage of 
audio, video, and data and is used in broadcast systems—which are inherently less 
reliable than disk-based storage and transmission systems.2

In this application, packets may be lost and viewers must be able to enter a 
transmission in mid-stream. Packetized elementary streams are interleaved (muxed) in 
the transport stream.

Codecs
MPEG-TS (.mpg) Codecs

Codec Episode Episode Pro Episode Engine Notes

AAC in out out

AES in in/out in/out Only 48 kHz audio allowed.

AC3/ATSC A-52 in in/out in/out Requires Pro Audio option.

H.264 in in/out in/out

HDV in/out in/out in/out

MPEG audio in in/out in/out

MPEG-2 in in/out in/out

MPEG-4 in in/out in/out

PCM in in in



Media Containers/Formats
MPEG-TS (.ts)

208
Settings

MPEG-TS Settings

General
PID Assignment

Each packet contains a PID (Packet IDentifier), so that the receiving system/application 
can utilize the incoming packet in the correct video or audio stream. PID values can be 
set in the range 16 to 8190, but video and audio streams should not use values below 
32.

Audio PID. Set the audio PID.

Video PID. Set the video PID.

PCR PID. Set the PID for the Program Clock Reference (PCR) packets, which control 
media timing. The PID may be identical to a media track (typically the Video PID) or 
have a unique value. The PCR PID cannot be the same as the PMT PID.

PMT PID. Set the PID for the Program Map Tables (PMT), which describe the structure of 
tracks within a program in the transport stream. Since Episode only creates single-
program transport streams, only one PMT can be specified.
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Transport Rate

The transport rate determines the bit rate of the resulting stream.

Transport Rate Mode. Select Automatic to set the transport rate to the sum of the rates 
of the media tracks plus approximately 10% overhead for system packets. This is the 
lowest possible rate for the stream.

Select Manual to explicitly specify the transport rate. If the sum of the rates of the 
media tracks and system packets is lower than the specified bit rate, the stream is 
padded to the specified bit rate. If the total rate is higher than the specified rate, the 
rate is automatically adjusted up to the lowest possible rate, as it is for Automatic.

Transport Rate. Specify the manual transport rate numeric value.

Transport Rate Unit. Select the unit type: bps | Kbps | Mbps.

PES Options

Packetized Elementary Stream (PES) describes how the media tracks (elementary 
streams) are stored within the transport stream.

PES Mode. Select Automatic Max Size to automatically set the maximum size of PES 
packets.

Select One PES per Frame to store each frame of video in one PES packet. This may be 
required for compatibility with some video-on-demand services.

Select Manual Max Size to manually set the maximum size of PES packets.

PES Max Size. When Manual Max Size is checked, enter the appropriate PES size.

Language

ISO 639 Language Code. Select a language code, or None. If a language code is 
selected, an ISO-6391 language descriptor is added to the audio track of the stream.

System Packets

These settings enable you to configure various settings in the set commonly known as 
system packets.

1. International Organization for Standardization. Codes for the representation of names of languages—Part 2: Alpha-
3 code, 1998.
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MPEG-TS System Packets Settings

Transport Stream ID. Set the ID number for the transport stream.

Program Number. Set the number for the single program stream within this transport 
stream (range: 1-65535).

PAT Interval. Set the maximum time interval between Program Association Table (PAT) 
packets. These indicate the programs available in the transport stream.

PMT Interval. Set the maximum time interval between PMT packets.

PCR Interval. Set the maximum time interval between PCR packets.

Force NULL Packets. Check to add null packets to the stream in order to create a 
constant bit rate stream.

NULL Interval. When Force NULL Packets is checked, set the maximum time interval in 
seconds between NULL packets.
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Multi Bitrate DASH, HTTP (HLS), and Smooth Streaming
The DASH, HTTP (HLS), and Smooth Streaming protocals offer live multi-bitrate 
streaming of media. These protocols cause the encoder to create multiple identical 
media streams encoded at different data rates and resolutions. During playback, the 
client player selects among the different available streams to choose the best one for 
the available network bandwidth, producing a smooth live viewing experience with 
minimal pauses. 

Episode implements streaming outputs (HTTP, Smooth, and DASH Streaming) using 
the Multi Bitrate Submission dialog (). To output live streaming media, you must first set 
up a workflow using one of the DASH, HTTP (HLS), or Smooth Streaming System 
Workflows in the Library. Then right-click the workflow to select Submit As MBR, which 
opens the MBR Submission dialog. Use the dialog to specify the details of the output 
and submit the job for processing. For a more complete step procedure, see Creating an 
MBR Streaming Media Project in the Using Episode chapter of this guide.

Settings
For settings, please see the settings for the chosen container and encoder. TIFO (.tifo) is 
the default container, and H.264 (MainConcept) Codec is the default video encoder.

Multi-bitrate Streaming Example
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MXF AS-11 (.mxf)
MXF AS-11 is defined by the Advanced Media Workflow Association (AMWA) as a 
format containing HD AVC-Intra or SD D-10 video with AES3 audio used by program 
producers and distributors for distributing programming to broadcasters. Episode 
supports AS-11 transcoding using the codecs listed below.

Episode decodes all audio tracks and channels in MOV and MXF sources and creates one 
track with all channels. For example, two stereo tracks become one track with 4 channels. 

Codecs

Settings
MXF AS-11 Settings

File Extension. Specifies the .mxf file extension by default but allows you to enter a 
different extension.

Split audio channels to separate tracks. Check to send the input audio channels to 
separate tracks in the output file.

Add Ancillary Closed Caption track. Check this option to include a CEA-608 or CEA-
708 closed caption track in the VANC data of the output MXF file container if captions 
are present in the incoming media. Uncheck this option to exclude MXF file captions. 
(Note: To enable captions imported from .scc or .mcc files, also see the Caption Importer 
Filter. To enable embedded input captions, also see the VBI Importer Filter.)

MXF AS-11 (.mxf) Codecs

Codec Episode Episode Pro Episode Engine Notes

AES in in/out in/out 

AVC-Intra 50/
100

in in/out in/out

D-10/IMX in in/out in/out 
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MXF Op1a (.mxf)
MXF Op1a wrapper file format is defined in SMPTE 377M.1 Op1a corresponds to the 
SMPTE 378M standard.2

Episode decodes all audio tracks and channels in MOV and MXF sources and creates 
one track with all channels. For example, two stereo tracks become one track with 4 
channels. 

Codecs

1. Society of Motion Picture and Television Engineers. Television—Material Exchange Format (MXF)—File Format 
Specification, 2004.

2. Society of Motion Picture and Television Engineers. Television—Material Exchange Format (MXF)—Operational 
pattern 1A (Single Item, Single Package), 2004.

MXF Op1a (.mxf ) Codecs

Codec Episode Episode Pro Episode Engine Notes

AES in in/out in/out 

AVC-Intra 50 in in/out in/out

AVC-Intra 100 in in/out in/out

Avid DNxHD/HR in in/out in/out 

BWF in in/out in/out 

D-10/IMX in in/out in/out 

DV25 in in/out in/out 

DVCPro25 in in/out in/out 

DVCPro50 in in/out in/out 

DVCProHD in in/out in/out 

H.264 
MainConcept

in in/out in/out

H.264 (x264) in in/out in/out

JPEG 2000 in in/out in/out

MPEG-2 ES in in/out in/out 

MPEG-2 VOD in in/out in/out 

XAVC in in/out in/out 

XDCAM HD in in/out in/out
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Settings
MXF OP1a Settings

File Extension. Specifies the .mxf file extension by default but allows you to enter a 
different extension.

Split audio channels to separate tracks. Check to send the input audio channels to 
separate tracks in the output file.

Add Ancillary Closed Caption track. Check this option to include a CEA-608 or CEA-
708 closed caption track in the VANC data of the output MXF file container if captions 
are present in the incoming media. Uncheck this option to exclude MXF file captions. 
(Note: To enable captions imported from .scc or .mcc files, also see the Caption Importer 
Filter. To enable embedded input captions, also see the VBI Importer Filter.)
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MXF OpAtom Audio (.mxf)
MXF OpAtom format is similar to MPEG Elementary Stream format, in that either a 
video track or an audio track can be wrapped, but not both at the same time.1

Episode decodes all audio tracks and channels in MOV and MXF sources and creates 
one track with all channels. For example, two stereo tracks become one track with 4 
channels. 

Codecs

Settings

MXF OpAtom Settings

Wrap as Avid compliant OpAtom (BWF only). Check to generate a file using the 
proprietary modifications to the standard for Avid video editing systems.

Framerate. Select the frame rate, in frames per second.

1. Society of Motion Picture and Television Engineers. Television—Material Exchange Format (MXF)—Specialized 
Operational Pattern Atom (Simplified Representation of a Single Item), 2004.

MXF OPAtom (.mxf) Codecs

Codec Episode Episode Pro Episode Engine Notes

AES in in/out in/out 

BWF in in/out in/out 

PCM in in/out in/out 



Media Containers/Formats
MXF OpAtom Video (.mxf )

216
MXF OpAtom Video (.mxf)
MXF OpAtom Video format is similar to MPEG Elementary Stream format, in that either 
a video track or an audio track can be wrapped, but not both at the same time.1

Codecs

Settings

MXF OpAtom Settings

Wrap as Avid compliant OpAtom. Check to generate a file using the proprietary 
modifications to the standard for Avid video editing systems.

1. Society of Motion Picture and Television Engineers. Television—Material Exchange Format (MXF)—Specialized 
Operational Pattern Atom (Simplified Representation of a Single Item), 2004.

MXF OPAtom Video (.mxf ) Codecs

Codec Episode Episode Pro Episode Engine Notes

AVC-Intra 50 in in/out in/out

AVC-Intra 100 in in/out in/out

Avid DNxHD/HR in in/out in/out 

D10/IMX in in/out in/out 

DV25 in in/out in/out 

DVCPro25 in in/out in/out 

DVCPro50 in in/out in/out 

DVCPro HD in in/out in/out 

MPEG-2 ES in in/out in/out 

MPEG-2 VOD in in/out in/out 

XDCAM HD in in/out in/out 
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MXF Sony XAVC
MXF XAVC serves digital cinema with standards of 4096x2160 resolution in the MXF file 
wrapper. The XAVC codec supports a variety of Sony digital cameras and camcorders. 

Codecs

Settings
MXF XAVC Settings

File Extension. Specifies the .mxf file extension by default but allows you to enter a 
different extension.

MXF XAVC (.mxf ) Codecs

Codec Episode Episode Pro Episode Engine Notes

XAVC in in/out in/out
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MXF XDCAM (.mxf)

Note: This format is available only in Episode Pro and Episode Engine.

MXF XDCAM format is a unique MXF version used by the Sony XDCAM video camera.

Episode decodes all audio tracks and channels in MOV and MXF sources and creates 
one track with all channels. For example, two stereo tracks become one track with 4 
channels. 

Codecs

Settings
MXF XDCam Settings

File Extension. Specifies the .mxf file extension by default but allows you to enter a 
different extension.

Add Ancillary Closed Caption track. Check this option to include a CEA-608 or CEA-
708 closed caption track in the VANC data of the output MXF file container if captions 
are present in the incoming media. Uncheck this option to exclude MXF file captions. 
(Note: To enable captions imported from .scc or .mcc files, also see the Caption Importer 
Filter. To enable embedded input captions, also see the VBI Importer Filter.)

MXF XDCAM (.mxf) Codecs

Codec Episode Episode Pro Episode Engine Notes

AES in in/out in/out

PCM in in/out in/out 

D10/IMX in in/out in/out

XDCAM HD in in/out in/out

XDCAM HD 422 in in/out in/out

XDCAM EX in in/out in/out
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OGG (.ogg)
OGG format is an open media wrapper format designed for efficient streaming and 
manipulation.1

Codecs

Settings
Except for File Extension (default .ogg), there are no user-configurable settings.

1. Internet Engineering Task Force. Ogg Encapsulation Format Version 0, 2003. www.rfc-editor.org.

OGG (.ogg) Codecs

Codec Episode Episode Pro Episode Engine Notes

Vorbis out out out

http://www.rfc-editor.org/rfc/rfc3533.txt
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PSP (.mp4)
PSP format is an MPEG-4 file format for PlayStation Portable.

PSP can play MPEG-4 files, but requires that they be named M4V99999.mp4, where 
99999 is five decimal digits, and stored in the directory E:\MP_ROOT\100MNV01 on the 
PSP. You can set up the file naming convention in the deployment. 

Codecs

Settings
Except for File Extension (default .mp4), there are no user-configurable settings.

PSP (.mp4) Codecs

Codec Episode Episode Pro Episode Engine Notes

AAC in/out in/out in/out

H264 in/out in/out in/out

MPEG-4 in/out in/out in/out
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TIFO (.tifo)
Telestream Intermediary Format is an intermediate media wrapper format designed by 
Telestream. Its primary use is in efficiently moving file-based media between 
Telestream digital media products.

TIFO supports all codecs available in Episode (base, Pro, and Engine) for both input and 
output.

Settings

TIFO Settings

TIFO Version. Select the version number required to maintain compatibility with older 
versions of Telestream products.
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WAV (.wav)
The Waveform audio format was co-developed by Microsoft and IBM.1

Codecs

Settings

WAV Settings

Add Broadcast wave header. Check to add a BWF header, which allows you to add 
metadata to the output file. See Adding Metadata.

1. Multiple channel audio data and wave files, 2007. www.microsoft.com.

WAV (.wav) Codecs

Codec Episode Episode Pro Episode Engine Notes

PCM in/out in/out in/out

http://www.microsoft.com
http://www.microsoft.com
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WebM (.webm)
WebM is a multimedia container format designed to provide a royalty-free, high-quality 
open video compression format for use with HTML5 video. The project's development 
is sponsored by Google.

A WebM file consists of VP8 or VP9 video and Vorbis audio streams, in a container based 
on a profile of Matroska. The project releases WebM related software under a BSD 
license and all users are granted a worldwide, non-exclusive, no-charge, royalty-free 
patent license.

Codecs

Settings
Except for File Extension (default .webm), there are no user-configurable settings.

Webm (.webm) Codecs

Codec Episode Episode Pro Episode Engine Notes

VP8 out out out

VP9 out out out

 Vorbis out out out
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WMA (.wma)
Windows Media is a proprietary multimedia framework developed by Microsoft. WMA 
format is the audio portion of Windows Media.

Codecs

Settings
Except for File Extension (default .wma), there are no user-configurable settings.

WMA (.wma) Codecs

Codec Episode Episode Pro Episode Engine Notes

Windows 
Media Audio 9

in/out in/out in/out
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WMV (.wmv)
Windows Media is a proprietary multimedia framework developed by Microsoft. WMV 
is the video portion of Windows Media.

Codecs

Settings
Except for File Extension (default .wmv), there are no user-configurable settings.

WMV (.wmv) Codecs

Codec Episode Episode Pro Episode Engine Notes

VC-1 out out out

WMV9 in/out in/out in/out 

WMA 9 in/out in/out in/out 
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Video Codecs
This chapter describes each of the video codecs provided in Episode, including a 
description of each user-configurable parameter.

Note: For a complete list of supported formats, see the Specifications document at 
http://www.telestream.net/episode/tech-specs.htm.

Some codecs require an Episode Pro or Episode Engine license, as indicated.

■ AVC-Intra Codec

■ Blackmagic Codec

■ D-10/IMX Codec

■ DNxHD/DNxHR Codec

■ DPX Sequence Codec

■ DV Codec

■ DVCPro HD Codec

■ GoPro Cineform Decoder

■ H.263 Codec

■ H.264 (MainConcept) Codec

■ H.264 (x264) Codec

■ HDV Codec

■ HEVC (H.265/x265) Codec

■ JPEG Sequence Codec

■ JPEG 2000 Codec

■ MJPEG Codec

■ MPEG-1 Codec

■ MPEG-2 Codec

■ MPEG-2 VOD Codec

■ MPEG-4 Codec

http://www.telestream.net/episode/tech-specs.htm
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■ Pass Through Option

■ ProRes Codec

■ RGB Levels Codec

■ Targa Cine YUV Codec

■ TGA Sequence Codec

■ TIFF Sequence Codec

■ VP8 Codec

■ VP9 Codec

■ Windows Media Video 9 Codec

■ Windows Media Video VC-1 Codec

■ Windows RGB Codec

■ XAVC Codec

■ XDCAM HD Codec

■ YCbCr Codec
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AVC-Intra Codec
Episode is able to encode AVC-Intra media in both MXF and MOV formats. AVC-Intra 
was developed by Panasonic. It is fully compliant with the H.264/MPEG AVC standard 
and follows the SMPTE RP 2027-2007 recommended practice specifications. AVC-Intra 
utilizes 10-bit intra-frame AVC compression and can be used for both 1080 and 720 HD 
frame sizes.

Note: Input is supported in all editions. Output is supported in Episode Pro and 
Episode Engine only.

AVC-Intra Codec Settings

AVC-Intra Class. Select from the following options:

Class 50. Produces 50 Mbit/s CABAC encoding. 1920X1080 (1440X1080 encoded pixels) 
formats are High 10 Intra Profile, Level 4, 4:2:0 chrominance. 1280X720 (960X720 actual 
pixels) formats are High 10 Intra Profile, level 3.2, 4:2:0 chrominance.

Class 100. Produces 100Mbit/s CAVLC encoding. All formats are High 4:2:2 Intra Profile, 
level 4.1, 4:2:2 Chrominance. All formats are full frame (1920X1080 and 1280X720).
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Blackmagic Codec
The Blackmagic codec provides uncompressed video used by Decklink and AJA 
products.

Blackmagic Codec Settings

Bit depth. Select 8 |10 bits per color channel.

Note: 10-bit encoding does not increase the quality of 8-bit source data.

Display Aspect Ratio. Select from the following options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in 
the source material or the value set in the resize filter if activated.

Square Pixels | 4:3 | 16:9 | 2.21:1 | 2.35:1 causes the codec to use the specified pixel aspect 
ratio. See Picture Resolution and Aspect Ratio.
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D-10/IMX Codec

Note: This codec is available only in Episode Pro and Episode Engine.

The D-10/IMX codec is a form of MPEG-2 4:2:2 I-frames-only video (SMPTE 356M).1 The 
codec is restricted to encoding NTSC and PAL frame sizes and frame rates.

D-10/IMX Codec Settings

Bit Rate. Select 30 Mbs | 40 Mbs | 50 Mbs.

Display Aspect Ratio. Select from the following options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in 
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3 | 16:9 | 2.21:1 causes the codec to use the specified pixel aspect ratio. 
See Picture Resolution and Aspect Ratio.

1. Society of Motion Picture and Television Engineers. Television—Type D-10 Stream Specifications—MPEG-2 4:2:2P @ 
ML for 525/60 and 625/50, 2001.
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Discard Option (Windows)
When the Discard option is selected from the Video Codec dropdown menu, Episode 
does not decode the video or pass it to the encoder. Thus, there is no video stream in 
the output.
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DNxHD/DNxHR Codec 
Avid systems store Avid DNxHD (high definition) material natively in MXF and MOV file 
containers, and DNxHR (2K/4K high resolution) material natively in MOV file containers. 

The Episode codec supports DNxHD natively in the MOV and MXF-Op1a containers, 
and DNxHR (2K/4K high resolution) material natively in MOV containers. 

For format details, see this Avid publication: http://www.avid.se/static/resources/US/
documents/dnxhd.pdf.

DNxHD/DNxHR Codec Settings

http://www.avid.se/static/resources/US/documents/dnxhd.pdf
http://www.avid.se/static/resources/US/documents/dnxhd.pdf
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DNxHD/DNxHR Codec Resolution Selections

DNxHD Low Bandwidth 1080p 8-bit 36-45 Mbps
DNxHD Thin Raster 720p 8-bit 40-100 Mbps
DNxHD Thin Raster 1080i/1080p 8-bit 80-100 Mbps
DNxHD High Quality Thin Raster 1080i 8-bit 120-145 Mbps
DNxHD Standard Quality 720p 8-bit 60-75 Mbps
DNxHD Standard Quality 1080i/1080p 8-bit 115-145 Mbps
DNxHD High Quality 720p 8-bit 90-220 Mbps
DNxHD High Quality 720p 10-bit 90-220 Mbps
DNxHD High Quality 1080i/1080p 8-bit 175-220 Mbps
DNxHD High Quality 1080i/1080p 10-bit 175-220 Mbps
DNxHD 4:4:4 1080p 10-bit RGB
DNxHR Low Bandwidth
DNxHR Standard Quality
DNxHR High Quality (8-bit)
DNxHR High Quality (10-bit)
DNxHR 4:4:4 RGB
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DPX Sequence Codec

Note: This feature is available in both the Episode CLI and in the GUI client with the 
Episode Engine license. For CLI details, see the Episode Advanced User’s Guide.

Select a sequence of DPX images as an input format for conversion to video. Support 
includes 8-bit, 10-bit, and 12-bit resolution.

Image Sequence Settings

Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default 
value is 1, meaning that one missing number in a sequence is treated as the end of the 
sequence. If set to another number, that number of sequence numbers must be 
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the 
sequence before processing of the file begins. This does not apply to the first file in a 
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sequence. This only has practical implications if Encode While Ingest is enabled. Setting 
this to 0 (zero) may significantly decrease the time the encoder has to wait when the 
end of the sequence is reached, but depending on file system and file format, may 
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device 
that produces an image sequence over time. Wait times between received files can be 
specified in the following wait fields. 

Encode while ingest waits (sec). Specifies the number of seconds to wait before 
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to 
wait for files during encode while ingest. The default is 5 times. If no files are received 
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum 
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.

Revert. Restores the Image Sequence settings to what they were before they were 
changed.

Save As. Saves the Image Sequence configuration to a file.
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DV Codec
DV does not use intra-frame prediction—all frames are keyframes. Thus, each frame is 
decodable separately. This makes DV video suitable for editing and provides a 
remarkably even quality, even in segments that are typically difficult for other video 
encoders to encode well.

The DV codec is restricted to NTSC and PAL frame sizes and rates.

DV Codec Settings

DV Type. Select from the following options. The DV type automatically sets the audio in 
the sample rate filter to the appropriate value.

DV, also known as DV25, has a fixed 25 Mbs bit rate. DV25 can encode PAL video (720 x 
576) pixels at 25 FPS with a 4:2:0 color space and NTSC video (720 x 480) pixels at 29.97 
FPS with a 4:1:1 color space. Audio at 32 | 44.1 | 48 kHz is supported in both cases.

Note: The DVCPRO and DBVCPRO50 codecs are available only in Episode Pro and 
Episode Engine.

DVCPRO has a fixed 25 Mbs bit rate. DVCPRO can encode PAL video (720 x 576) at 25 
FPS with a 4:1:1 color space and NTSC video (720 x 480) at 29.97 FPS with a 4:1:1 color 
space. Audio at 32 | 48 kHz is supported in both cases.

DVCPRO50 has a fixed 50 Mbs bit rate. DVCPRO50 can either PAL video (720 x 576) 
pixels at 25 FPS with a 4:2:2 color space and NTSC video (720 x 480) pixels at 29.97 FPS 
with a 4:2:2 color space. Audio at 32 | 48kHz is supported in both cases.

Display Aspect Ratio. Select from these options:

4:3 | 16:9 causes the codec to use the specified pixel aspect ratio. See Picture Resolution 
and Aspect Ratio.

From Source/Resize Filter causes the codec to use the display aspect ratio information in 
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3 | 16:9 | 2.21:1 causes the codec to use the specified pixel aspect ratio. 
See Picture Resolution and Aspect Ratio.

Frame Mode. Select from these options:

Same as Source sets the output frame mode the same as the input file.

Interlaced sets the output frame mode to interlaced.

Progressive sets the output frame mode to progressive.
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DVCPro HD Codec
The SMPTE 370M-2006 specification defines the DVCPRO HD format, which is a 100 
Mbps extension of the DVCPRO 25 and DVCPRO 50 formats. The HD format is used for 
capturing and editing high-quality HD video. 

The Episode DVCPro HD codec supports these standard resolutions:

•1080i60: 1280 pixels per line, 1080 lines; interlaced (displayed at 16:9, or 1920 x 1080)

•1080i50: 1440 pixels per line, 1080 lines; interlaced (displayed at 16:9, or 1920 x 1080)

•720p60: 960 pixels per line, 720 lines; progressive (displayed at 16:9, or 1280 x 720)

•720p50: 960 pixels per line, 720 lines; progressive (displayed at 16:9, or 1280 x 720)

For all resolutions, DVCPRO HD captures and displays images with a 16:9 aspect ratio 
(or 1.78). 

No explicit settings are provided in Episode. The resolution is chosen from the 
incoming media parameters (a combination of the source and filter selections).

These Episode containers can use the DVCPro HD codec:

• MOV

• MXF-Op1a

• MXF-OpAtom

• TIFO

DVCPro HD Codec Selection
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GoPro Cineform Decoder
Episode decodes (but does not encode) GoPro Cineform files. The CineForm format was 
created to support compressed Digital Intermediate HD or higher resolution media for 
film and television. CineForm media is typically wrapped within AVI or MOV files types.

Files may consist of image formatting for 10-bit 4:2:2 YUV, 12-bit 4:4:4 RGB and RGBA, 
and 12-bit CFA Bayer filter RAW compression (for Silicon Imaging SI-2K camera.) 
Compression data-rates typically range from 10:1 to 3.5:1, and files may also be 
uncompressed.
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H.263 Codec
H.263 is designed for low-bit rate video1. It is suitable for streaming to handheld 
devices.

■ Bandwidth Settings

■ Keyframe Settings

■ Profile Settings

■ Encoding Settings

Bandwidth Settings

H.263 Codec—Bandwidth Settings

Average Bit Rate. Set the desired bit rate of the video track. Range: 0 to 30,000 Kbps.

Frame Skip Probability. Use the slider (or enter the value manually) to set the 
probability of skipping frames so that if the set bit rate is exceeded, 0.0 is least likely and 
1.0 is most likely to cause frame skipping. See Frame Skip Probability Smooth Motion Vs. 
Crisp Image.

Video Buffering Verifier (VBV) Buffer Size. Use the slider (or enter the value 
manually) to set the VBV buffer size. Range: 0 to 60 seconds. See VBV Video Buffer 
Verifier.

Keyframe Settings

H263 Codec—Keyframe Settings

Keyframe Control. Select from the following options:

1. International Telecommunication Union. Video coding for low bit rate communication, 2005. www.itu.int.

http://www.itu.int/rec/dologin_pub.asp?lang=e&id=T-REC-H.263-200501-I!!PDF-E&type=items
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Keyframes Only creates all frames as keyframes. Requires very high video bit rate.

Forced Keyframes Only creates keyframes with exactly the specified keyframe distance.

Natural and Forced Keyframes creates keyframes when the encoder detects a scene 
change, but also inserts a keyframe at Keyframe distance from the latest keyframe. If 
keyframe distance is 0, only natural keyframes are created.

Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Intra Block Refresh updates only moving areas in the image instead of the entire frame. 
This is useful when streaming at very low bit rates, since it keeps the bit rate more 
constant.

Keyframe Interval. Use the slider (or enter the value manually) to set the maximum 
distance between keyframe. Range: 0 to 1,000 frames.

Intra Refresh Period. Use the slider (or enter the value manually) to set the maximum 
distance between Intra Block Refreshes. Range 0 to 140 frames.

Profile Settings
H.263 has a number of profiles, supporting different features.

H263 Codec—Profile Settings

Profile. Select from the following options:

Baseline (Profile 0) only allows the picture sizes QCIF (176 x144) and Sub-QCIF (128 x 
96). No other profile settings are enabled.

Profile 3 supports all picture sizes and enables the following options:

Advanced Intra Coding. Check to use an advanced algorithm for coding intra blocks.

Deblocking Filter. Check to reduce artifacts at the edges of encoding blocks.

Slice Structure. Check to use slices when encoding frames. This allows faster re-
synchronization of the picture for lossy connections.

Modified Quantization. Check to use an alternate quantization method to increase 
color fidelity.
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Encoding Settings

H263 Codec—Encoding Settings

Two-pass encoding. Check to perform encoding in two passes. In pass one, the codec 
analyzes the frames and collects data. In the second pass it uses the collected data as 
the basis for how to best distribute the bits. Two-pass encoding provides better output 
image quality but increases encoding time.
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H.264 (MainConcept) Codec
H.264 is also known as AVC and MPEG-4 Part 101. H.264 uses many different techniques 
to achieve excellent video compression ratio for bit rates ranging from very low levels 
for hand-held devices to high levels for HD television.

Note: This topic describes how to use the MainConcept H.264 codec. You can also 
generate H.264 video using the H.264 (x264) Codec.

■ Bandwidth Settings

■ Frame Type Settings

■ Profile Settings

■ Display Settings

■ Quality Settings

■ Detailed Frame Settings

■ Bitstream Flags

■ Level Signaling

■ General Tab

■ Profile & Quality Tab

■ Advanced Tab

General Tab
The General tab displays the following settings:

■ Bandwidth Settings

■ Frame Type Settings

Bandwidth Settings

H264 Codec—Bandwidth Settings

Bandwidth Control. Select from the following options:

Constant Bit Rate (CBR) uses the constant bit rate with the Average Bit Rate setting.

1. International Organization for Standardization. Information technology—Coding of audio-visual objects, 2004.
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Variable Bit Rate (VBR) uses the Average Bit Rate setting.

Variable Bit Rate (VBR)—Quality Based uses the VBR Quality setting.

Average Bit Rate. When Variable Bit Rate (VBR) is selected, specify the desired bit rate of 
the video track. Range: 15 to 100,000 Kbps.

Note: The actual maximum size of the VBV is determined by the encoding level and 
target bit rate and may be considerably less than 60 s. In this case it is limited to the 
maximum possible value. See VBV Video Buffer Verifier.

Variable Bit Rate (VBR) Quality. Use the slider (or enter the value manually) to set the 
image quality for a video frame expressed as a percent: 0% (most compression, lowest 
quality) to 100% (least compressed, highest quality).

Frame Type Settings

H264 Codec—Frame Type Settings

Keyframe Control. Select from the following options: 

Keyframes Only creates all frames as keyframes. Requires very high video bit rate.

Forced Keyframes Only creates keyframes with exactly the specified keyframe distance.

Natural and Forced Keyframes creates keyframes when the encoder detects a scene 
change, but also inserts a keyframe at Keyframe distance from the latest keyframe. If 
Keyframe distance is 0, only natural keyframes are created.

Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Keyframe Interval. When enabled (Forced Keyframes Only | Natural and Forced 
Keyframes) Specify the maximum distance between keyframes. Range: 0 to 300.

Use Adaptive B-frames. Check to use fewer than the number of B-frames (specified in 
Number of B-frames) in a sequence if this improves quality.

Number of B-frames. Use the slider (or enter the value manually) to set the number of 
B-frames between P-frames in a GOP. Range: 0 to 3.

Number of Reference Frames. Use the slider (or enter the value manually) to set the 
number of reference frames stored. A higher number may improve coding quality but 
increases encoding time. Range: 0 to 16.
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Profile & Quality Tab
The Profile & Quality tab displays the following settings:

■ Profile Settings

■ Display Settings

■ Quality Settings

Profile Settings

H264 Codec—Bandwidth Settings

Profile Settings. Select Baseline | Main | High profile.

Baseline is primarily used for low-cost applications that require additional data loss 
robustness. This profile is used in some videoconferencing and mobile applications.

Main is used for standard-definition digital TV broadcasts that use the MPEG-4 format.

High is primarily used for broadcast and disc-based applications, particularly for high-
definition applications.

Entropy Coding. When enabled (Main | High profile), select from these options:

CAVLC is simpler and faster. When Baseline profile is selected, CAVLC is used.

CABAC is slower and higher quality.

Display Settings
The color space option is only enabled when High profile is selected. For Baseline and 
Main, only 4:2:0 color space is used.

H264 Codec—Display Settings

Color Space. When High profile is selected, choose Same as Source | 4:2:0 | 4:2:2. See 
Color Formats.

Display Aspect Ratio. Select from these options:
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From Source/Resize Filter causes the codec to use the display aspect ratio information in 
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3 | 16:9 explicitly set the display aspect ratio.

Quality Settings

H264 Codec—Quality Settings

Two-pass Encoding. Check to perform encoding in two passes. In pass one, the codec 
analyzes the frames and collects data. In the second pass it uses the collected data as 
the basis for how to best distribute the bits. Two-pass encoding provides better output 
image quality but increases encoding time.

Deblocking Filter. Check to smooth out block artifacts which may occur in the image 
when using lower bit rates.

Adaptive Interlacing Mode. Check to generate more efficient interlaced output. This 
option increases encoding time.

Advanced Tab
The Advanced tab displays the following settings:

■ Detailed Frame Settings

■ Bitstream Flags

■ Level Signaling

■ Closed Captioning Settings

Detailed Frame Settings

H264 Codec—Detailed Frame Settings

Number of Slices. Select from these options:
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Automatic (One per CPU) speeds up processing by transcoding parts (slices) of the same 
frame in parallel. 

1 Slice | 2 Slices | 3 Slices | 4 Slices Select to speed encoding. Using more slices may 
decrease image quality somewhat as redundancies between parts of the frame cannot 
be fully utilized. 

Initial Buffer Fullness. Use the slider (or enter the value manually) to set the maximum 
percent of the buffer to be utilized. 

When encoding starts, the encoder assumes a certain level of bits in the buffer, to 
obtain an even bit rate right from the beginning. How full the buffer is affects how large 
the first frames are. Lower means fewer available bits and the first frames are smaller. 
This is good when you want to limit the size of the first frame which typically can be 
very large, especially if there is little motion in the material (because then it makes 
sense to spend a lot of bits on the quality of the first frame). A low value decreases 
quality slightly for the first frames of the movie. The default value is 50%.

IDR Frames. Select from the following options to set the frequency of IDR frames: Every 
| Every 2nd | Every 3rd | Every 5th | Every 10th.

An IDR frame is an I-frame whose preceding frames cannot be used by predictive 
frames. Predictive frames (P-frames and B-frames) coming after an I-frame may look at 
frames before the I-frame for best compression. More distant IDR frames may allow 
more efficient compression but limits the ability of a player to move to arbitrary points 
in the video. In particular, QuickTime Player may display image artifacts when you scrub 
the timeline unless every I-frame is an IDR frame.

Limit Frame Size. Check to enable the Frame Size option so you can set it as 
appropriate.

Even if the average bit rate stays below the set limit, individual frames may become 
larger than a decoder can handle in real time, thus you may need to set limits on how 
large frames can get. This limitation may reduce image quality considerably, so you 
should not use this setting unless you have definite problems.

Frame Size. When enabled, use the slider (or enter the value manually) to limit the 
maximum frame size. Range: 2 to 10 times the average frame size.

Bitstream Flags

H264 Codec—Bitstream Flag Settings

Force Headers for Every GOP. Check to insert a header before every GOP, which is a 
requirement for producing Blu-ray media.
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Add Picture Timing SEI. Check to add Supplemental Enhancement Information fields 
indicating the global time for each frame and suitable decoder settings. They add a 
small overhead to the file size, but can help a decoder play out the video more 
efficiently.

Signal Fixed Framerate. Check to indicate that the clip is to be played out with a fixed 
framerate.

Pulldown. Select how to set the flag which tells a player how to pull down fields in 
order to display at a higher frame rate. See Video Scan. 

Select from these options:

None does not perform pulldown.

2:3 (23.976/24 -> 29.97/30 FPS) | 3:2 (23.976/24 -> 29.97/30 FPS) | 2:3 (23.976/24 -> 59.94/60 
FPS) | 3:2 (23.976/24 -> 59.94/60 FPS). If the frame rate does not match 23.976 or 24 these 
settings are ignored.

Level Signaling

H264 Codec—Level Signalling Settings

Level. Select an option to mark the level of the output as a higher value than the 
default. Select from these options: Auto | Level 1.1... Level 5.1. 

The level you select provides the decoder the required maximum values for macro 
block rates, frame sizes and bit rates. Episode automatically marks the level as 
corresponding to the lowest level matching the current values for those parameters. If 
you indicate a level lower than allowed by the current parameter values, the lowest 
legal level is silently selected.

Closed Captioning Settings

H.264 (MainConcept) Codec—Closed Captioning Settings

Closed Captioning. Select None | Same as Source | EIA-608 | EIA-608 + EIA-708. 
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This setting controls and enables only the output side of the closed captioning 
capability. When set to None, no captions are embedded in the encoded output. When 
set to Same as Source, EIA-608, or EIA-608 + EIA708, closed captions (of the type 
selected) embedded in the source are likewise embedded into the encoded output.

None. Embedded closed captions in the source are not included in the output. 

Same as Source. Embedded captions in input media are embedded in output media.

EIA-608. 608 captions embedded in input media are embedded in output media.

EIA-608 + EIA-708. Embedded 608/708 input captions are embedded in the output.

Note: Depending on the source, you may also need to enable an input Video Filter: 

To make captions embedded in source blanking available to the encoder, select 
Decode Captions in the VBI Importer Filter. (Strips input VBI captions if not selected). 

To import 608/708 captions from .scc or .mcc caption files, select the Caption Importer 
Filter and browse for the .scc or .mcc caption file.

MPEG-2 source files containing embedded captions in the user data do not require the 
VBI Importer Filter. As long as Closed Captioning is enabled for the encoder, captions on 
the input should pass to the transcoded output.

You can also choose to include closed captions in the MXF AS-11 (.mxf), MXF Op1a 
(.mxf), or MXF XDCAM (.mxf) file containers. To do so, select Container in the Inspector, 
and select Add Ancillary Closed Caption Track. 
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H.264 (x264) Codec
H.264 is also known as AVC and MPEG-4 Part 101. H264 uses many different techniques 
to achieve excellent video compression ratio for bit rates ranging from very low levels 
for hand-held devices to high levels for HD television.

Note: This topic describes the x264 H.264 codec, often referred to simply as x264. You 
can also generate H.264 media using the H.264 (MainConcept) Codec. 
Tables below each user interface figure identify corresponding standard x264 CLI 
commands so that you can correlate the two interfaces more easily. The CLI commands 
in these tables are not those of the x264 implementation in the Episode CLI.

■ Bandwidth Settings

■ Preset and Tuning

■ Frame Type Settings

■ Buffering Settings

■ Display Settings

■ Profile & Level Settings

■ Slices Settings

■ Deblocking Filter Settings

■ Analysis Settings

■ Compatibility Settings

■ Closed Captioning Settings

■ General Tab

■ Profile & Quality Tab

■ Advanced Tab

General Tab
The General tab displays the following settings:

■ Bandwidth Settings

■ Preset and Tuning

■ Frame Type Settings

1. International Organization for Standardization. Information technology—Coding of audio-visual objects, 2004.
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Bandwidth Settings

x264 Codec—Bandwidth Settings

H264 (x264) Codec CLI—Bandwidth Settings

Rate Control Method

Average Bit Rate -B, --bitrate

Constant Quality -q, --qp

HRD Compliance --nal-hrd

Disabled none
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Rate Control Method. Select from the following options:

Average Bit Rate uses the Average Bit Rate setting.

Constant Quality Based uses the Quality setting.

Average Bit Rate. When Average Bit Rate is selected, specify the desired bit rate of the 
video track. Range: 15 to 400,000 Kbit/s.

HRD Compliance. HRD (Hypothetical Reference Decoder) is a reference model of a 
decoder that is specified in the H.264 standard. It defines two buffers by their size and 
read/write speed. Creation of HRD-compliant video streams is important when the 
stream is to be streamed at a constant bit rate or played back on a hardware device 
with limited resources (DVD/Blu-ray players, etc.).

Select from these options:

Disabled eliminates the requirement to adhere to the HRD model. This is the preferred 
choice when encoding a file for local playback or download to a computer.

CBR encodes to a constant bit rate targeted at the average bit rate value. This is the 
preferred choice when encoding files to be streamed to a device. For CBR mode, you 
must also specify the VBV size. The VBV maximum bit rate is set to the same value as the 
average bit rate.

VBR encodes to an average bit rate constrained to the average bit rate value. For VBR 
mode one must also specify the VBV size and the VBV max bit rate. VBR mode is the 
preferred choice when the VBV buffer has a bit rate different from the average bit rate. 
For example, a Blu-ray player can fill the VBV buffer at a higher bit rate than the video 
average bit rate.

VBV Size. Specifies the size of the VBV buffer in kilobits. A larger buffer provides the 
encoder a longer time for varying the bit rate. The buffer is filled at the bit rate set by 
the VBV Max bit rate. A larger buffer also increases the time the decoder/player has to 
buffer the stream before it should start playback (buffering time (in seconds) = VBV Size 
/ VBV Max bit rate).

VBV Max Bitrate. The bit rate at which the VBV buffer fills. In a scenario where you 
stream a file at a constant bit rate (for example, a VOD transport stream), this is set to 
the same rate as the video bit rate. If you are encoding for a device that can refill the 
buffer faster than the average bit rate, set it here.

CBR cbr

VBR vbr

VBV Size --vbv-bufsize

VBV Max Bit Rate --vbv-maxrate

H264 (x264) Codec CLI—Bandwidth Settings
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Quality. When Constant Quality is selected, use the slider (or enter the value manually) 
to set the image quality for a video frame expressed as a whole number: 1 (Best) to 51 
(Worst).

Preset and Tuning

x264 Codec—Preset and Tuning

H264 (x264) Codec CLI—Preset and Tuning Settings

Preset --preset

Ultra Fast ultrafast

Super Fast superfast

Very Fast veryfast

Faster faster

Fast fast

Medium medium

Slow slow

Slower slower

Very Slow veryslow

Placebo placebo

Tuning --tune

Disabled (--tune not set)
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Preset. Select from these options, which trade encoding speed for visual quality:

Ultra Fast | Super Fast | Very Fast | Faster | Fast | Medium | Slow | Slower | Very Slow |Placebo

Tuning. Select from these options, which optimize encoding quality for a particular 
type of source content:

Disabled performs no special optimization of the video frame during encoding.

Film optimizes the output assuming film-based input.

Animation optimizes the output assuming animated media input.

Grain optimizes the output assuming grainy video input.

Still Image optimizes the output assuming still images as input.

PSNR optimizes the encoder for PSNR (peak signal to noise ratio) at the expense of 
visual quality.

SSIM optimizes the encoder for SSIM (structural similarity) at the expense of visual 
quality.

Fast Decode optimizes the output for fastest decoding on the display device.

Zero latency optimizes the output to target zero latency on the display device.

Film film

Animation animation

Grain grain

Still Image stillimage

PSNR psnr

SSIM ssim

Fast Decode fastdecode

Zero Latency zerolatency

H264 (x264) Codec CLI—Preset and Tuning Settings
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Frame Type Settings

x264 Codec—Frame Type Settings

H264 (x264) Codec CLI—Frame Type Settings

Keyframe Control

Natural Keyframes 
Only

Natural and Max 
Keyframe Interval
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Keyframe Control. Controls the method of inserting keyframes into the stream.

Select from the following options: 

Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Natural and Max Keyframe Interval creates keyframes when the encoder detects a scene 
change, but also inserts a keyframe if the Keyframe Interval distance is reached before a 
natural keyframe has been created.

Forced Keyframe Only only creates keyframes at the set keyframe interval.

Natural and Forced Keyframe Interval creates keyframes when the encoder detects a 
scene change, but also inserts a keyframe at the set keyframe interval.

Forced Keyframe Only creates all frames (requires higher bit rates).

Keyframes Only creates all frames as keyframes. Requires very high video bit rate.

Natural and Forced 
Keyframe Interval

Forced Keyframe 
Interval Only

--no-scenecut

Keyframes Only -i, --min-keyint 1

Keyframe Interval -I, --keyint

Max Number of Reference 
Frames

--ref

Adaptive B-Frames --b-adapt

Auto (From Preset)

Disabled 0

Fast 1

Trellis 2

Number of B-Frames -b, --bframes

B-Frames As Reference 
Frames (B-Pyramid)

--b-pyramid

Disabled none

Strict strict

Normal normal

H264 (x264) Codec CLI—Frame Type Settings



Video Codecs
H.264 (x264) Codec

257
Keyframe Interval. When Natural and Max Keyframe Interval | Forced Keyframe Only | 
Natural and Forced Keyframe Interval are selected, use the slider (or enter the value 
manually) to specify the maximum distance between keyframes. Range: 0 to 300.

Max Number of Reference Frames. Use the slider (or enter the value manually) to set 
the maximum number of frames a frame can reference. More reference frames provides 
better quality, because the encoder has more frames in which to find similarities, but 
increases memory use by the decoder. Range: 1 to 16.

Adaptive B-Frame. Check to enable adaptive B-frame placement. Sometimes it is 
better to create a P-frame rather than a B-frame, so the number of B-frames between P-
frames may become less than the Number of B-frames value. 

Number of B-Frames. Use the slider (or enter the value manually) to set the number of 
B-frames that can be used between P-frames. Range: 1 to 16.

B-Frames as Reference Frames (B-Pyramid). Allows the use of B-frames as references 
for other frames. 

Select from these options:

Disabled does not allow B-frames to the used as references.

Strict allows one B-frame per mini-GOP to be used as a reference.

Normal allows numerous B-frames per mini GOP to be used as a reference.

Profile & Quality Tab
The Profile & Quality tab displays the following settings:

■ Buffering Settings

■ Display Settings

■ Profile & Level Settings
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Buffering Settings

x264 Codec—Buffering Settings

Override Number of Frames to Look Ahead. Check to override the default Frame 
Look-ahead value.

Number of Frames to Look Ahead. Use the slider (or enter the value manually) to 
specify the number of frames the encoder can look ahead to detect more difficult areas 
to encode, and save bits for those sections. Range: 0 to 250.

Two-Pass Encoding. Check to perform encoding in two passes. In the first pass, the 
encoder analyzes the frames and collects data. In the second pass, it uses the collected 
data as the basis for how to best distribute the bits. Two-pass encoding provides better 
output image quality but increases encoding time.

H264 (x264) Codec CLI—Buffering Settings

Number of Frames To Look 
Ahead

--rc-lookahead

Two-Pass Encoding -p, --pass 2
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Display Settings

H264 Codec—Display Settings

Display Aspect Ratio. Select from these options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in 
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3 | 16:9 explicitly set the display aspect ratio.

H264 (x264) Codec CLI—Display Settings

Display Aspect Ratio

Square Pixels (will use --sar to set correct 
display aspect ratio)

4:03:00

16:09:00
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Profile & Level Settings

H264 Codec—Profile & Level Settings

Profile. Select from the following options:

H264 (x264) Codec CLI—Profile and Level Settings

Profile --profile

Baseline baseline

Main main

High high

Level --level

Entropy Coding

Auto (From Preset)

Context-Adaptive 
Variable-Length 
Coding (CAVLC)

--no-cabac

Context-Adaptive 
Binary-Arithmetic 
Coding (CABAC)

(--no-cabac not set)
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Baseline uses the fastest encode and decode profile.

Main uses a more complex encoder, which usually provides better quality/bit rate ratio.

High use an even more complex encoder. Requires Episode Pro or Episode Engine.

Level. The level you select provides the decoder the maximum values for macro block 
rates, frame sizes, reference frames, VBV information, and bit rates. 

Select from these options:

Auto. Episode automatically marks the level as corresponding to the lowest level 
matching the current configuration.

Levels (1.0 to 5.1). Select an option to mark the level of the output as a higher value than 
the default. If you manually select a level lower than allowed by the current parameter 
values, the configuration may silently change to match the selected level.

Entropy Coding. When enabled (Main | High profile), select from these options:

CAVLC is simpler and faster. When Baseline profile is selected, CAVLC is used.

CABAC is slower and higher quality. CABAC is enabled when Main or High files are 
selected.

Advanced Tab
The Advanced tab displays the following settings:

■ Slices Settings

■ Deblocking Filter Settings

■ Analysis Settings

■ Compatibility Settings

■ Closed Captioning Settings

Slices Settings

x264 Codec—Slices Settings
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Number of Slices. Select from these options:

Auto speeds up processing by transcoding parts (slices) of the same frame in parallel. 

1 Slice | 2 Slices | 3 Slices | 4 Slices. Select to speed encoding. Using more slices may 
decrease image quality somewhat as redundancies between parts of the frame cannot 
be fully utilized. 

Deblocking Filter Settings

x264 Codec—Deblocking Filter Settings

Deblocking Filter. Select to enable the in-loop deblocking filter. The deblocking filter 
provides quality gains without affecting the encoding speed significantly. Telestream 
recommends that you enable this option.

H264 (x264) Codec CLI—Slices Settings

Number of Slices --slices

H264 (x264) Codec CLI—Deblocking Filter Settings

Deblocking Filter -f, --deblock

Strength alpha

Threshold beta
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Strength. When deblocking is enabled, use the slider (or enter the value manually) to 
specify filter strength, which affects the overall amount of deblocking to be applied. 
Higher values deblock the picture more effectively, but destroys details in the picture to 
provide a more softened picture.

Threshold. When deblocking is enabled, use the slider (or enter the value manually) to 
specify filter threshold, which determines whether something in a block is a detail or 
not. Higher values apply more deblocking to less flat blocks (with more detail present).

Analysis Settings

x264 Codec—Analysis Settings
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Motion Estimation Method. Select the full-pixel motion estimation method to use:

Diamond | Hexagon | Uneven Multi-Hex | Exhaustive | Transformed Exhaustive

Motion Estimation Range. Use the slider (or enter the value manually) to specify the 
maximum range of motion search in pixels. Range 0 to 32.

Override Motion Vector Range. Check to override the motion vector value.

Override Motion Vector Range. When Override Motion Vector Range is checked, use 
the slider (or enter the value manually) to specify the maximum vertical range of any 
one motion vector in pixels. Range -1 (Auto) to 1024.

Fast Noise Reduction. Use the slider (or enter the value manually) to estimate noise 
based on this value and attempts to remove it by dropping small details before 
quantization. Range 0 to 1000. 

Weighted P-Frames Prediction. Select Auto (from Preset) | Disabled | Simple | Smart.

H264 (x264) Codec CLI—Analysis Settings

Motion Estimation Method --me

Auto (From Preset)

Diamond dia

Hexagon hex

Uneven Multi-Hex umh

Exhaustive esa

Transformed 
Exhaustive

tesa

Motion Estimation Range --merange

Motion Vector Range --mvrange

Fast Noise Reduction --nr

Weighted P-Frames 
Prediction

--weightp

Auto (From Preset)

Disabled 0

Simple 1

Smart 2
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Compatibility Settings

x264 Codec—Compatibility Settings

H264 (x264) Codec CLI—Compatibility Settings

Fake Interlace --fake-interlaced

Force headers for every 
GOP

Open GOP --open-gop

Blu-Ray Compatibility --preset veryslow 
--tune film 
--bluray-compat 
--vbv-maxrate X 
--vbv-bufsize X
 --level 4.1 
--keyint X 
--open-gop
--slices 4 
--tff 
--colorprim "bt709" 
--transfer "bt709" 
--colormatrix "bt709" 
--sar X 
--pass 1



Video Codecs
H.264 (x264) Codec

266
Fake Interlace. Check to mark the video stream as interlaced even when the stream is 
progressive. Allows the encoding of 25p and 30p Blu-ray-compliant video streams.

Force Headers for every GOP. Check to insert a header for every GOP, which is a 
requirement for producing Blu-ray media.

Open GOP. Check Open GOP encoding to increase encoding efficiency. However, not 
all players/decoders support this encoding method.

Blu-Ray Compatibility. Check to adhere to encode for Blu-Ray compatibility.

Closed Captioning Settings

x264 Codec—Closed Captioning Settings

Closed Captioning. Select None | Same as Source | EIA-608 | EIA-608 + EIA-708. 

This setting controls and enables only the output side of the closed captioning 
capability. When set to None, no captions are embedded in the encoded output. When 
set to Same as Source, EIA-608, or EIA-608 + EIA708, closed captions (of the type 
selected) embedded in the source are likewise embedded into the encoded output.

None. Embedded closed captions in the source are not included in the output. 

Same as Source. Embedded captions in input media are embedded in output media.

EIA-608. 608 captions embedded in input media are embedded in output media.

EIA-608 + EIA-708. Embedded 608/708 input captions are embedded in the output.

Note: Depending on the source, you may also need to enable an input Video Filter: 

To make captions embedded in source blanking available to the encoder, select 
Decode Captions in the VBI Importer Filter. (Strips input VBI captions if not selected). 
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To import 608/708 captions from .scc or .mcc caption files, select the Caption Importer 
Filter and browse for the .scc or .mcc caption file.

MPEG-2 source files containing embedded captions in the user data do not require the 
VBI Importer Filter. As long as Closed Captioning is enabled for the encoder, captions on 
the input should pass to the transcoded output.

You can also choose to include closed captions in the MXF AS-11 (.mxf), MXF Op1a 
(.mxf), or MXF XDCAM (.mxf) file containers. To do so, select Container in the Inspector, 
and select Add Ancillary Closed Caption Track. 

Closed Captioning Fields. Default: Field 1. This option is not user-configurable and is 
always set to Field 1 for H.264 (x264), which means that only Field 1 caption information 
is forwarded to the output if Closed Captioning is set to EIA-608. Any Field 2 caption 
information is disregarded.
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HDV Codec
HDV is a High Definition Video codec which utilizes MPEG-2 compression.

HDV Codec Settings

HDV Type. Select from the following options:

HDV 720p (1280 x720 24, 25, 29.97, 30, 50, 59.94 or 60 FPS) | HDV 1080i (1440 x1080 25, 
29.97 or 30 FPS) | HDV 1080p (1440 x1080 24 or 25 FPS).

Note: This setting determines the allowable values for the Resize Filter, Frame Rate 
Filter, and Advanced Frame Rate Filter and the corresponding values of the source file.
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HEVC (H.265/x265) Codec
The High Efficiency Video Coding format (HEVC), also known as H.265, succeeds the 
H.264 format, providing approximately double the compression with the same video 
quality. HEVC format supports resolutions up to 8K (8192 x 4320) or lower resolutions at 
higher quality for the same bit rate compared to H.264.

■ Bandwidth Settings

■ Preset and Tuning

■ Frame Type Settings

■ Compatibility

■ Buffering Settings

■ Display Settings

■ Profile & Level Settings

General Tab
The General tab displays the following settings:

■ Bandwidth Settings

■ Preset and Tuning

■ Frame Type Settings
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Bandwidth Settings

H.265 (x265)Codec—Bandwidth Settings

H.265 (x265) Codec CLI—Bandwidth Settings

Rate Control Method

Average Bit Rate -B, --bitrate

Constant Quality -q, --qp

HRD Compliance --nal-hrd

Disabled none
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Rate Control Method. Select from the following options:

Average Bit Rate uses the Average Bit Rate setting.

Constant Quality Based uses the Quality setting.

Average Bit Rate. When Average Bit Rate is selected, specify the desired bit rate of the 
video track. Range: 15 to 400,000 Kbit/s.

HRD Compliance. HRD (Hypothetical Reference Decoder) is a reference model of a 
decoder that is specified in the H.265 standard. It defines two buffers by their size and 
read/write speed. Creation of HRD-compliant video streams is important when the 
stream is to be streamed at a constant bit rate or played back on a hardware device 
with limited resources (DVD/Blu-ray players, etc.).

Select from these options:

Disabled eliminates the requirement to adhere to the HRD model. This is the preferred 
choice when encoding a file for local playback or download to a computer.

CBR encodes to a constant bit rate targeted at the average bit rate value. This is the 
preferred choice when encoding files to be streamed to a device. For CBR mode, you 
must also specify the VBV size. The VBV maximum bit rate is set to the same value as the 
average bit rate.

VBR encodes to an average bit rate constrained to the average bit rate value. For VBR 
mode one must also specify the VBV size and the VBV max bit rate. VBR mode is the 
preferred choice when the VBV buffer has a bit rate different from the average bit rate. 
For example, a Blu-ray player can fill the VBV buffer at a higher bit rate than the video 
average bit rate.

VBV Size. Specifies the size of the VBV buffer in kilobits. A larger buffer provides the 
encoder a longer time for varying the bit rate. The buffer is filled at the bit rate set by 
the VBV Max bit rate. A larger buffer also increases the time the decoder/player has to 
buffer the stream before it should start playback (buffering time (in seconds) = VBV Size 
/ VBV Max bit rate).

VBV Max Bitrate. The bit rate at which the VBV buffer fills. In a scenario where you 
stream a file at a constant bit rate (for example, a VOD transport stream), this is set to 
the same rate as the video bit rate. If you are encoding for a device that can refill the 
buffer faster than the average bit rate, set it here.

CBR cbr

VBR vbr

VBV Size --vbv-bufsize

VBV Max Bit Rate --vbv-maxrate

H.265 (x265) Codec CLI—Bandwidth Settings
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Quality. When Constant Quality is selected, use the slider (or enter the value manually) 
to set the image quality for a video frame expressed as a whole number: 1 (Best) to 51 
(Worst).

Preset and Tuning

H.265 (x265) Codec—Preset and Tuning

H.265 (x265) Codec CLI—Preset and Tuning Settings

Preset --preset

Ultra Fast ultrafast

Super Fast superfast

Very Fast veryfast

Faster faster

Fast fast

Medium medium

Slow slow

Slower slower

Very Slow veryslow

Placebo placebo

Tuning --tune

Disabled (--tune not set)
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Preset. Select from these options, which trade encoding speed for visual quality:

Ultra Fast | Super Fast | Very Fast | Faster | Fast | Medium | Slow | Slower | Very Slow |Placebo

Tuning. Select from these options, which optimize encoding quality for a particular 
type of source content:

Disabled performs no special optimization of the video frame during encoding.

PSNR optimizes the encoder for PSNR (peak signal to noise ratio) at the expense of 
visual quality.

SSIM optimizes the encoder for SSIM (structural similarity) at the expense of visual 
quality.

Grain optimizes the output assuming grainy video input.

Zero latency optimizes the output to target zero latency on the display device.

Fast Decode optimizes the output for fastest decoding on the display device.

Frame Type Settings

H.265 (x265) Codec—Frame Type Settings

Film film

Animation animation

Grain grain

Still Image stillimage

PSNR psnr

SSIM ssim

Fast Decode fastdecode

Zero Latency zerolatency

H.265 (x265) Codec CLI—Preset and Tuning Settings
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H.265 (x265) Codec CLI—Frame Type Settings

Keyframe Control

Natural Keyframes 
Only

Natural and Max 
Keyframe Interval

Natural and Forced 
Keyframe Interval

Forced Keyframe 
Interval Only

--no-scenecut

Keyframes Only -i, --min-keyint 1

Keyframe Interval -I, --keyint

Max Number of Reference 
Frames

--ref

Adaptive B-Frames --b-adapt

Auto (From Preset)

Disabled 0
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Keyframe Control. Controls the method of inserting keyframes into the stream.

Select from the following options: 

Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Natural and Max Keyframe Interval creates keyframes when the encoder detects a scene 
change, but also inserts a keyframe if the Keyframe Interval distance is reached before a 
natural keyframe has been created.

Forced Keyframe Interval Only only creates keyframes at the set keyframe interval.

Keyframes Only creates all frames as keyframes. Requires very high video bit rate.

Keyframe Interval. When Natural and Max Keyframe Interval | Forced Keyframe Only | 
Natural and Forced Keyframe Interval are selected, use the slider (or enter the value 
manually) to specify the maximum distance between keyframes. Range: 0 to 300.

Max Number of Reference Frames. Use the slider (or enter the value manually) to set 
the maximum number of frames a frame can reference. More reference frames provides 
better quality, because the encoder has more frames in which to find similarities, but 
increases memory use by the decoder. Range: 1 to 16.

Adaptive B-Frames. Check to enable adaptive B-frame placement. Sometimes it is 
better to create a P-frame rather than a B-frame, so the number of B-frames between P-
frames may become less than the Number of B-frames value. 

Number of B-Frames. Use the slider (or enter the value manually) to set the number of 
B-frames that can be used between P-frames. Range: 1 to 16.

B-Frames as Reference Frames (B-Pyramid). Allows the use of B-frames as references 
for other frames. 

Select from these options:

Disabled does not allow B-frames to the used as references.

Strict allows one B-frame per mini-GOP to be used as a reference.

Normal allows numerous B-frames per mini GOP to be used as a reference.

Fast 1

Trellis 2

Number of B-Frames -b, --bframes

B-Frames As Reference 
Frames (B-Pyramid)

--b-pyramid

Disabled none

Strict strict

Normal normal

H.265 (x265) Codec CLI—Frame Type Settings



Video Codecs
HEVC (H.265/x265) Codec

276
Compatibility

H.265 (x265) Codec Compatibility Settings

Open GOP. Check Open GOP encoding to increase encoding efficiency. However, not 
all players/decoders support this encoding method.

Profile & Quality Tab
The Profile & Quality tab displays the following settings:

■ Buffering Settings

■ Display Settings

■ Profile & Level Settings

Buffering Settings

H.265 (x265) Codec—Buffering Settings

H.265 (x265) Codec CLI—Buffering Settings

Number of Frames To Look 
Ahead

--rc-lookahead
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Override Number of Frames to Look Ahead. Check to override the default Frame 
Look-ahead value.

Number of Frames to Look Ahead. Use the slider (or enter the value manually) to 
specify the number of frames the encoder can look ahead to detect more difficult areas 
to encode, and save bits for those sections. Range: 0 to 250.

Display Settings

H.265 (x265) Codec—Display Settings

Display Aspect Ratio. Select from these options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in 
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3 | 16:9 explicitly set the display aspect ratio.

H.265 (x265) Codec CLI—Display Settings

Display Aspect Ratio

Square Pixels (will use --sar to set correct 
display aspect ratio)

4:03:00

16:09:00
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Profile & Level Settings

H.265 (x265) Codec—Profile & Level Settings

Profile. Select from the following options:

Main performs 8-bit encoding.

Main 10 performs 8- to 10-bit encoding. Requires Episode Pro or Episode Engine.

Level. The level you select provides the decoder the maximum values for macro block 
rates, frame sizes, reference frames, VBV information, and bit rates. 

Select from these options:

Auto. Episode automatically marks the level as corresponding to the lowest level 
matching the current configuration.

Levels (1.0 to 5.1). Select an option to mark the level of the output as a higher value than 
the default. If you manually select a level lower than allowed by the current parameter 
values, the configuration may silently change to match the selected level.

H.265 (x265) Codec CLI—Profile and Level Settings

Profile --profile

Main main

Main10 high

Level --level
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JPEG Sequence Codec

Note: This feature is available in both the Episode CLI and in the GUI client with the 
Episode Engine license. For CLI details, see the Episode Advanced User’s Guide.

Select a sequence of JPEG images as an input format for conversion to video. RGB 32-bit 
is supported.

Image Sequence Settings
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Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default 
value is 1, meaning that one missing number in a sequence is treated as the end of the 
sequence. If set to another number, that number of sequence numbers must be 
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the 
sequence before processing of the file begins. This does not apply to the first file in a 
sequence. This only has practical implications if Encode While Ingest is enabled. Setting 
this to 0 (zero) may significantly decrease the time the encoder has to wait when the 
end of the sequence is reached, but depending on file system and file format, may 
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device 
that produces an image sequence over time. Wait times between received files can be 
specified in the following wait fields. 

Encode while ingest waits (sec). Specifies the number of seconds to wait before 
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to 
wait for files during encode while ingest. The default is 5 times. If no files are received 
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum 
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.

Revert. Restores the Image Sequence settings to what they were before they were 
changed.

Save As. Saves the Image Sequence configuration to a file.
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JPEG 2000 Codec
The JPEG 2000 (JP2) image compression standard and coding system was created by 
the Joint Photographic Experts Group committee in 2000 to supersede the JPEG 
standard. The format is used for such widely different applications as digital cameras, 
color scanning, faxing, and printing, medical and military imaging, live video feeds, and 
digital cinema.

Episode JPEG 2000 Codec

Bit Rate: Enter the maximum bit rate in kbits per second. The default is 25,000 kbits (25 
Mb/s). 
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MJPEG Codec
The Motion JPEG (MJPEG) codec generates a sequence of JPEG still images, and is 
suitable to use as an editing format.

■ Profile Settings

■ Encoding Setting

Profile Settings

MJPEG Codec—Profile Settings

Profile. Select MJPEG A | MJPEG B | Photo JPEG. The actual encoding is identical for all 
versions, but the headers are different.

Color Space. Select Same as Source | 4:2:0 | 4:2:2 (see Color Formats (78)).

Encoding Setting

MJPEG Codec—Encoding Setting

Encoding Quality. Use the slider (or enter the value manually) to specify the image 
quality as a percent, from 0 (most compression, lowest quality) to 100 (least 
compressed, highest quality).
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MPEG-1 Codec
MPEG-1 video is accepted by most video players. This format is suitable when it is 
important to reach a large audience on different platforms. MPEG-1 is recommended 
for image sizes up to CIF (352 x 288) and bit rates up to 1500 Kbps. Above 1500 Kbps, 
MPEG-2 is typically a better encoding option.

■ Bandwidth Settings

■ Keyframe Settings

Bandwidth Settings

MPEG-1 Codec—Bandwidth Settings

Coding Type. Select from the following options:

Bit Rate-based controls bandwidth by specifying a maximum bit rate.

Quality-based controls bandwidth by specifying a maximum quality.

Average Bit Rate. When bit rate-based is selected as the coding type, specify the 
desired bit rate of the video track, from 16 Kbps upwards.

Encoding Quality. When quality-based is selected as the coding type, use the slider (or 
enter the value manually) to specify the image quality. Range: 0 (most compression, 
lowest quality) to 100 (least compressed, highest quality).
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Keyframe Settings

MPEG-1 Codec—Keyframe Settings

GOP Format. Select one of the predefined GOP structures, or select Custom to specify 
some other GOP structure using the P-frames between I-frames and B-frames between 
P-frames fields.

GOP Type. Select Open GOP | Closed GOP. In a file using an Open GOP structure, frames 
are allowed to predict data from frames outside the GOP. This provides better 
compression but is not accepted by all applications and does not work well when using 
MPEG-1 as an editing format. When using Closed GOP, each frame in the GOP is 
independent of the frames outside of the GOP. Hence all the predictive coding is 
performed inside each GOP.

P-frames Between I-frames. Use the slider (or enter the value manually) to set the 
maximum number of P-frames permitted between I-frames. Range: 0 to 25.

B-frames Between P-frames. Use the slider (or enter the value manually) to set the 
maximum number of B-frames permitted between P-frames. Range: 0 to 10.

Force Sequence Header for Every GOP. Check to insert a sequence header before 
every GOP, a requirement when creating MPEG files for editing.
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MPEG-2 Codec
The MPEG-2 codec is similar to the MPEG-1 codec, but is more suitable for larger frame 
sizes and higher bit rates. MPEG-2 is the standard format for DVDs and for digital 
television.

■ Bandwidth Settings

■ Display Settings

■ Keyframe Settings

■ Advanced Options

■ Closed Captioning & VBI Settings

Bandwidth Settings

MPEG-2 Codec—Bandwidth Settings

Coding Type. Select from the following options:

Bit Rate-based controls bandwidth by specifying a maximum bit rate. When selected, 
Encoding Quality is disabled, and other bit rate-based settings are enabled, as 
appropriate.

Quality-based controls bandwidth by specifying a maximum quality. When selected, 
only Encoding Quality is enabled.
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Bit Rate Control. When Bit Rate-Based is selected, select from the following options:

Constant Bit Rate (CBR) encodes the video with a constant bit rate. The VBV buffer size is 
adjusted so that the output conforms to Main Profile at Main Level. If you encode the 
video as I-frames only, frames are padded to reach the set bit rate. This is best suited for 
high bit rates: 30 Mbs and upwards.

Video Buffering Verifier (VBV) Size uses the buffer time value in the VBV buffer size field. 
The VBV buffer size controls the variation in bit rate. A larger buffer size allows bigger 
variations in bit rate. For more information, see VBV Video Buffer Verifier.

Peak Rate sets the highest allowed bit rate in the clip to the value in the Peak Rate field.

Average Bit Rate. When Bit Rate-Based is selected, set the desired bit rate of the video 
track. Range 16 Kbps to 300,000 Kbps.

Peak Bit Rate. When Peak Rate is selected, specify the maximum allowed bit rate over 
any one-second interval. Range: 16 Kbps to 300,000 Kbps.

Video Buffering Verifier (VBV) Buffer Size. When Video Buffering Verifier (VBV) Size is 
selected, use the slider (or enter the value manually) to set the VBV buffer size. Range: 0 
to 60 seconds. See VBV Video Buffer Verifier.

Two-pass Encoding. When Bit Rate-Based is selected, check to perform encoding in 
two passes. In pass one, the codec analyzes the frames and collects data. In the second 
pass it uses the collected data as the basis for how to best distribute the bits. Two-pass 
encoding provides better output image quality but increases encoding time.

Encoding Quality. When Quality-Based is selected, use the slider (or enter the value 
manually) to set the image quality for a video frame. Range: 0 (most compression, 
lowest quality) to 100 (least compressed, highest quality).

Display Settings

MPEG-2 Codec—Display Settings

Display Aspect Ratio. Select from the following options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in 
the source material or the value set in the Resize Filter if activated.
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Square Pixels | 4:3 | 16:9 | 2.21:1 causes the codec to use the specified pixel aspect ratio. 
See Picture Resolution and Aspect Ratio.

Field Order. Select Top First | Bottom First | Same as Input.

Keyframe Settings

MPEG-2 Codec—Keyframe Settings

GOP Format. Select one of the predefined GOP structures, or select Custom to specify 
some other GOP structure using the P-frames between I-frames and B-frames between 
P-frames fields.

P-Frames Between I-Frames. When enabled, enter the maximum number of P-frames 
permitted between I-frames. Range: 0 to 25. 

B-Frames Between P-Frames. When enabled, enter the maximum number of B-frames 
permitted between P-frames. Range: 0 to 10.

Force Sequence Header for Every GOP. Check to insert a sequence header before 
every GOP, a requirement when creating MPEG files for editing.

GOP Type. Select Open GOP | Closed GOP. In a file using an Open GOP structure, frames 
are allowed to predict data from frames outside the GOP. This provides better 
compression but is not accepted by all applications, and does not work well when 
using MPEG-1 as an editing format. When using Closed GOP, each frame in the GOP is 
independent of the frames outside of the GOP. Hence, all the predictive coding is 
performed inside each GOP.
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Advanced Options

MPEG-2 Codec—Advanced Options

Profile. When Coding Type is set to Bitrate-Based, Select Main | 422 | High. When Coding 
Type is set to Quality-Based, Main is specified.

Level. Select Main | High422 | High.

Intra DC Precision. Select 8 Bits | 9 Bits | 10 Bits. The DC component of the encoded 
signal determines the base level of each encoded block.

Detect Scene Changes. Check to insert keyframes (I-frames) in the stream when two 
consecutive frames differ more than a given threshold.

Pulldown. Select how to set the flag which tells a player how to pull down fields in 
order to display at a higher frame rate. See Video Scan. Select from the following 
options:

None do not perform pulldown.

2:3 (23.976/24 -> 29.97/30 FPS) | 3:2 (23.976/24 -> 29.97/30 FPS). If the frame rate is not 
23.976 or 24 FPS, these setting is ignored.

Closed Captioning & VBI Settings
Episode supports writing closed captions in MPEG-2 video in MPEG Elementary, 
Program, and Transport Streams. Closed captions are imported from MPEG user data in 
D-10/IMX, HDV, MPEG-2, and XDCAM HD files in the following formats: EIA-608 in ATSC 
A/53 wrapping, EIA-708 in ATSC A/53 wrapping, and SCTE-20.
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MPEG-2 codec—Closed Captioning & VBI Settings

Closed Captioning. Select the format of the output closed captioning data:

None does not place any closed captions in the output file.

Same as Source copies any closed captions from the source to the output file.

EIA-608 places captions from the source into the output file Closed Captioning Fields.

EIA-608 + EIA-708 places both ATSC A/53-wrapped EIA-608 and EIA-708 captions from 
the source into the output file.

SCTE-20 places captions from the source into the selected Closed Captioning Fields of 
the output file.

This setting controls and enables only the output side of the closed captioning 
capability. To pass captions from input to output, you also have to set up caption 
importing from the input source files. Detecting and importing captions on the input 
source requires enabling either the VBI Importer Filter or the Caption Importer Filter 
described in the Video Filters chapter. The Caption Importer Filter imports embedded 
608/708captions from the source media file, and the VBI Importer Filter ensures that VBI 
data containing captions is passed to the output and not removed from the input. 

When both EIA-608 and either VBI Importer Filter or Caption Importer Filter are 
enabled, captions will be embedded in the transcoded output file if valid captions were 
present in the input source file or caption file.

MPEG-2 source files containing embedded captions in the user data are an exception to 
the VBI or Caption Filter requirement; these captions can be forwarded to the 
transcoded output without enabling any filters as long as Closed Captioning is set to 
EIA-608 in the video codec.

Closed Captioning Fields. When SCTE-20 is selected, select to indicate the fields in 
which to place EIA-608 and SCTE-20 captions:
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Field 1 places captions in field 1 if the source contains captions in field 1; captions in 
field 2 are ignored. If there are captions in field 2 and none in field 1, the field 2 captions 
are placed in field 1.

Field 1 + Field 2 places captions in the same field as they were imported from in the 
source file.

Add Empty VBI. Check to pad the height of the image so that there is space for VBI 
(Vertical Blanking Information) lines that can be used to store information such as time 
codes, teletext, etc. Images from 480 to 511 lines high are assumed to be NTSC and are 
padded up to 512 lines; images from 576 to 607 lines high are assumed to be PAL and 
are padded up to 608 lines.

VBI Pad Color. When Add Empty VBI is checked, select the color of the VBI space (0 | 16) 
from the dropdown menu.
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MPEG-2 VOD Codec

Note: This codec is available only in Episode Pro and Episode Engine.

The MPEG-2 VOD codec uses automatic and limited encoding parameters. It cannot be 
customized.

Supported input includes:

• 528 or 352 x 576 @ 25 FPS

• 528 or 352 x 480 @29.97 FPS

• 1920 x 1080 @ 25 or 29.97 FPS
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MPEG-4 Codec
MPEG-4 includes many of the features of MPEG-1 and MPEG-2 and is accepted by most 
video players. The role of MPEG-4 has been for the most part superseded by a codec 
developed to support its subset MPEG-4 Part 10, known as H.264. MPEG-4 can be useful 
if support in older players and/or platforms is required. MPEG-4 is efficient across a 
wide range of bit rates, frame sizes. and frame rates.

■ Bandwidth Settings

■ Keyframe Settings

■ Profile Settings

■ Encoding Settings

Bandwidth Settings

MPEG-4 codec—Bandwidth Settings

Average Bit Rate. Specify the desired bit rate. Range: 0 to 100,000 Kbps.

Frame Skip Probability. Use the slider (or enter the value manually) to set the 
probability of skipping frames so that if the set bit rate is exceeded, 0.0 is least likely and 
1.0 is most likely to cause frame skipping. See Frame Skip Probability Smooth Motion Vs. 
Crisp Image.

Video Buffering Verifier (VBV) Buffer Size. Use the slider (or enter the value 
manually) to set the VBV buffer size. Range: 0 to 60 seconds. See VBV Video Buffer 
Verifier.
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Keyframe Settings

MPEG-4 codec—Keyframe Settings

Keyframe Control. Select from the following options:

Keyframes Only creates all frames as keyframes. Requires very high video bit rate.

Forced Keyframes Only creates keyframes with the specified keyframe distance.

Natural and Forced Keyframes creates keyframes when the encoder detects a scene 
change, but also inserts a keyframe at keyframe distance from the latest keyframe. If 
Keyframe distance is 0, only natural keyframes are created.

Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Keyframe Interval. When creating Forced Keyframes Only or Natural and Forced 
Keyframes, specify the maximum distance between keyframes. Range 0 to 200 frames.

Number of B-Frames. When Advanced Simple Profile is selected, use the slider (or enter 
the value manually) to set the maximum number of B-frames permitted between P-
frames. Range: 0 to 10.
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Profile Settings

MPEG-4 codec—Profile Settings

Profile. Select from the following options:

Simple Profile Simple Profile (Level 0) is used in 3GPP files. Simple Profile provides the 
fastest encoding and is supported by any player that supports MPEG-4. If the video bit 
stream is below 64 Kbps it is tagged as level 0. If the bit stream is between 64 Kbps and 
128 Kbps it is tagged as level 0B.

Advanced Simple Profile Advanced Simple Profile includes additional encoding features 
but is not supported by all players.

Simple Profile Level 0. Check to encode media below 64Kbps.

Motion Estimation Accuracy. When using Advanced Simple Profile, select the active 
area for looking at motion estimation. Half Pel (1/2 pixel) | Quarter Pel (1/4 pixel).

Display Aspect Ratio. Select 1:1 | 4:3 | 16:9 | 2.21:1.

Error Correction
Packet Length. Specify data packet length in bits. Large packets have less overhead, 
but provide less error correction. Range: 0 to 163,840 bits.
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Use Data Partition. Check to insert synchronization markers for better error correction. 
This is useful for very low bandwidth and error-prone networks.

Use RVLC. Check to utilize Reversible Variable Length Codes. RVLC make it possible for 
the player to look back in previously-played video and check previous parts of the 
image. If the current frame contains corrupt data, the codec can check with previous 
frames for correction.

Note: Using RVLC increases bandwidth requirements and may result in lowered 
image quality. RVLC is dependent on player support.

Encoding Settings

MPEG-4 codec—Encoding Settings

Two-pass Encoding. Check to perform two-pass encoding. In pass 1, the codec 
analyzes the frames and collects data. In the 2nd pass it uses the collected data as the 
basis for how to best compress the data. Two-pass encoding provides better output 
quality but increases encoding time.
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Pass Through Option
When the Pass Through option is selected from the Video Codec dropdown menu, 
Episode extracts the video stream from the input file, and passes it through untouched, 
and inserts it into the output file. That is, no decoding or encoding of the video stream 
occurs.
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ProRes Codec
ProRes is capable of recording full HD frame sizes at a variety of bit rates, which is useful 
for a wide range of purposes from proxies to finish editing and archiving.

ProRes 422 is a full-frame 10-bit 4:2:2 video codec developed by Apple in 2007. ProRes 
4444 (MacOS X only) is a 12-bit 4:4:4 video codec. It is a lossy video compression format 
which supports Variable Bit Rate (VBR). Telestream does not recommend using the 
ProRes 4444 encoding in a mixed-platform cluster because the job may be assigned to 
a Windows node, which will cause the job to fail because Windows is not supported. 

Note: MacOS X: ProRes is distributed and installed for encoding and decoding. 
Windows: ProRes is provided for encode and decode operations. You must be running 
Windows Server 2012 or 2012 R2 and have an Episode Engine license. 

Episode supports decoding of 4444 XQ (both Mac and Windows), which is the highest 
quality version of the Apple ProRes format. It consists of up to 12 bits per image 
channel and up to 16 bits for the alpha channel.

ProRes Codec Settings

Version. Select the version of ProRes to use:

ProRes 422 (HQ) video bit rate of approx. 220 mb/s at 1920 x 1080.

ProRes 422 a 10-bit 4:2:2 codec developed by Apple. Video bit rate of approx 145 mb/s 
at 1920 x 1080.

ProRes 422 (LT) video bit rate of approx 100 mb/s at 1920 x 1090.

ProRes 422 (Proxy) video bit rate of approx 45 mb/s at 1920 x 1080.

ProRes 4444 video bit rate of approx 330 mb/s at 1920 x 1080. (See comments above 
regarding 4444 encoding and 4444 XQ decoding.)
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RGB Levels Codec
The RGB Levels codec produces video in an uncompressed video format, which is 
utilized by QuickTime.

RGB Levels Codec Settings

Bits Per Pixel. Select 24 | 32 from the dropdown menu. 24 bits per pixel provides 8 bits 
each for red, blue, and green. 32 bits per pixel provides additional support for an 8-bit 
alpha channel.
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Targa Cine YUV Codec

Note: This codec is available only in Episode Pro and Episode Engine.

Targa Cine YUV is an uncompressed video format used with Cinewave cards. The pixel 
values are stored with 4:2:2 subsampling.

There are no user-settable options.
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TGA Sequence Codec

Note: This feature is now available in both the Episode CLI and in the GUI client with 
the Episode Engine license. For CLI details, see the Episode Advanced User’s Guide.

Select a sequence of TGA images as an input format for conversion to video. An alpha 
channel and 24-bit graphics are supported.

Image Sequence Settings
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Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default 
value is 1, meaning that one missing number in a sequence is treated as the end of the 
sequence. If set to another number, that number of sequence numbers must be 
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the 
sequence before processing of the file begins. This does not apply to the first file in a 
sequence. This only has practical implications if Encode While Ingest is enabled. Setting 
this to 0 (zero) may significantly decrease the time the encoder has to wait when the 
end of the sequence is reached, but depending on file system and file format, may 
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device 
that produces an image sequence over time. Wait times between received files can be 
specified in the following wait fields. 

Encode while ingest waits (sec). Specifies the number of seconds to wait before 
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to 
wait for files during encode while ingest. The default is 5 times. If no files are received 
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum 
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.

Revert. Restores the Image Sequence settings to what they were before they were 
changed.

Save As. Saves the Image Sequence configuration to a file.
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TIFF Sequence Codec

Note: This feature is now available in both the Episode CLI and in the GUI client with 
Episode Engine license. For CLI details, see the Episode Advanced User’s Guide.

Select a sequence of TIFF images as an input format for conversion to video. 8-bit and 
16-bit are supported.

Image Sequence Settings
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Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default 
value is 1, meaning that one missing number in a sequence is treated as the end of the 
sequence. If set to another number, that number of sequence numbers must be 
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the 
sequence before processing of the file begins. This does not apply to the first file in a 
sequence. This only has practical implications if Encode While Ingest is enabled. Setting 
this to 0 (zero) may significantly decrease the time the encoder has to wait when the 
end of the sequence is reached, but depending on file system and file format, may 
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device 
that produces an image sequence over time. Wait times between received files can be 
specified in the following wait fields. 

Encode while ingest waits (sec). Specifies the number of seconds to wait before 
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to 
wait for files during encode while ingest. The default is 5 times. If no files are received 
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum 
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.

Revert. Restores the Image Sequence settings to what they were before they were 
changed.

Save As. Saves the Image Sequence configuration to a file.
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VP8 Codec
The VP8 codec is an open source codec released by Google. The codec is based on VP6, 
which was initially developed by On2 Technologies, and is used in WebM format.

VP8 Codec Settings

Bit Rate. Enter the maximum bit rate in kbits per second.

Two-pass Encoding. Check to perform encoding in two passes. In pass one, the codec 
analyzes the frames and collects data. In the second pass it uses the collected data as 
the basis for how to best distribute the bits. Two-pass encoding provides better output 
image quality but increases encoding time.

Keyframe Settings. Select from the following options:

Natural creates keyframes when the encoder detects a scene change.

Forced Keyframes creates keyframes with exactly the specified keyframe distance.

Minimum Keyframe Interval. When Forced Keyframes is selected, specify the minimum 
distance between keyframes. Range: 0 to 50 frames.

Maximum Keyframe Interval. When Forced Keyframes is selected, specify the 
maximum distance between keyframes. Range: 0 to 200 frames.

Video Intended for. Select Streaming (CBR) | Download (VBR).
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Decoders Buffer Time. Use the slider (or enter the value manually to set the amount of 
media the buffer holds. Range: 0 to 10 seconds.

Maximum Number of Threads. Use the slider (or enter the value manually to set the 
maximum number of threads. Range: 1 to 16.
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VP9 Codec
The VP9 codec is open source software released by Google as the successor to VP8 with 
improved compression to achieve a reduced bit rate while retaining the same video 
quality. The codec is based on VP6, which was initially developed by On2 Technologies, 
and is used in WebM format. A number of common browsers allow the VP9 codec to 
play in the HTML5 video tag.

VP9 Codec Settings

Bit Rate. Enter the maximum bit rate in kbits per second.

Two-pass Encoding. Check to perform encoding in two passes. In pass one, the codec 
analyzes the frames and collects data. In the second pass it uses the collected data as 
the basis for how to best distribute the bits. Two-pass encoding provides better output 
image quality but increases encoding time.

Keyframe Settings. Select from the following options:

Natural creates keyframes when the encoder detects a scene change.

Forced Keyframes creates keyframes with exactly the specified keyframe distance.

Minimum Keyframe Interval. When Forced Keyframes is selected, specify the minimum 
distance between keyframes. Range: 0 to 50 frames.

Maximum Keyframe Interval. When Forced Keyframes is selected, specify the 
maximum distance between keyframes. Range: 0 to 200 frames.

Video Intended for. Select Streaming (CBR) | Download (VBR).

Decoders Buffer Time. Use the slider (or enter the value manually to set the amount of 
media the buffer holds. Range: 0 to 10 seconds.

Maximum Number of Threads. (Mac only) Use the slider (or enter the value manually 
to set the maximum number of threads. Range: 1 to 16.
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Windows Media Video 9 Codec
The Windows Media Video 9 codec is used in the Windows Media (WM) format, a 
proprietary format playable in Windows Media Player. (Note that there is another WMV 
codec. See Windows Media Video VC-1 Codec.)

These are the main topics for the WMV9 codec:

■ Bandwidth Settings

■ Keyframe Settings

■ Profile Settings

■ Encoding Settings

Bandwidth Settings

Windows Media Video 9 Codec—Bandwidth Settings

Coding Mode. Select from the following options: 

One-Pass Constant Bit Rate (CBR) encodes video at the bit rate specified in the Average 
Rate field. Quality is specified using the Picture Quality slider.

One-Pass variable Bit Rate (VBR) encodes the clip with a variable bit rate, at the quality 
specified in the Smoothness/crispness slider. The encoder uses whatever bit rate 
necessary to maintain the specified quality. Unlike One-pass CBR, a higher quality never 
causes the encoder to skip frames, only to use a higher bit rate.

Peak Rate. Range: 5 Kbps to 20,000 Kbps.

Average Rate. When encoding One-Pass Constant Bit Rate (CBR), set the desired bit rate 
of the video track. Range 5 to 20,000 Kbps.

Video Buffering Verifier (VBV) Buffer Size. When encoding One-Pass Constant Bit 
Rate (CBR), use the slider (or enter the value manually) to set the VBV buffer size. Range: 
0 to 60 seconds. See VBV Video Buffer Verifier.

Picture Quality. Use the slider (or enter the value manually) to set the probability of 
skipping frames so that if the set bit rate is exceeded, 0.0 is least likely and 1.0 is most 
likely to cause frame skipping (see Frame Skip Probability Smooth Motion Vs. Crisp Image.
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Keyframe Settings

Windows Media Video 9 codec—Keyframe Settings

Keyframe Control. Select from the following options:

Natural and Forced Keyframes causes the codec choose when to insert keyframes, but 
also ensures that there is at least one keyframe within the specified distance. If 
Keyframe distance is set to 0, keyframes are created only when a scene change is 
detected, making this the same as Natural Keyframes Only.

Natural Keyframes Only causes the codec insert keyframes when it detects scene 
changes.

Keyframe Interval. Enter the maximum distance between keyframes regardless of 
scene changes. With long clips that have lots of redundant data such as news clips 
(talking heads), limiting the maximum distance allows the stream to recover more 
rapidly if losing packets. Range: 0-60 seconds.

Number of B-frames. When using Main Profile, use the slider (or manually enter the 
value) to specify the number of B-frames in a GOP (range: 0 to 7). A higher number 
causes more efficient, slower encoding.

Profile Settings

Windows Media Video 9 Codec—Profile Settings

Profile. Select from the following options:

Simple Profile is the fastest-encodable profile.

Main Profile allows additional encoding options.

Advanced Profile
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Encoding Settings

Windows Media Video 9 Codec—Encoding Settings

Encoding Complexity. Select from the following options: 

Live Fast | Live Normal are best for streaming video. 

Offline Fast | Offline Normal | Offline Slow provide increasingly slower, but higher quality 
encoding; they are better for downloadable video.
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Windows Media Video VC-1 Codec
The VC-1 Codec creates Windows Media 9 Advanced Profile CBR (Constant Bit Rate) or 
VBR (Variable Bit Rate) files, either in one- or two-pass encoding. (Note that there is 
another WMV codec: See Windows Media Video 9 Codec.)

These are the main topics for the WMV VC-1 codec:

■ Bandwidth Settings

■ Keyframe Settings

■ Encoding Settings

Bandwidth Settings

VC-1 Codec—Bandwidth Settings

Coding Mode. Select from the following options:

One-Pass Constant Bit Rate (CBR) encodes video at the bit rate specified in the Average 
Rate field. Quality is specified using the Picture Quality slider.

One-Pass Variable Bit Rate (VBR) encodes the clip with a variable bit rate, at the quality 
specified in the Smoothness/crispness slider. The encoder uses whatever bit rate 
necessary to maintain the specified quality. Unlike One-pass CBR, a higher quality never 
causes the encoder to skip frames, only to use a higher bit rate.

Peak Rate. 5 Kbps to 20,000 Kbps.

Average Rate. When encoding One-Pass Constant Bit Rate (CBR), set the desired bit rate 
of the video track. Range 5 to 20,000 Kbps.

Video Buffering Verifier (VBV) Buffer Size. When encoding One-Pass Constant Bit 
Rate (CBR), use the slider (or enter the value manually) to set the VBV buffer size. Range: 
0 to 60 seconds. See VBV Video Buffer Verifier.

Smoothness/Crispness. Use the slider (or enter the value manually) to set the 
probability of skipping frames so that if the set bit rate is exceeded, 0.0 is least likely and 
1.0 is most likely to cause frame skipping. See Frame Skip Probability Smooth Motion Vs. 
Crisp Image.
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Keyframe Settings

Windows Media Video VC-1 Codec—Keyframe Settings

Keyframe Control. Select from the following options:

Natural and Forced Keyframes causes the codec to choose when to insert keyframes, but 
also ensures that there is at least one keyframe within the specified distance. If 
Keyframe distance is set to 0, keyframes are created only when a scene change is 
detected, making this the same as Natural Keyframes Only.

Natural Keyframes Only causes the codec insert keyframes when it detects scene 
changes.

Keyframe Distance/Interval. Enter the maximum distance between keyframes 
regardless of scene changes. With long clips that have lots of redundant data such as 
news clips (talking heads), limiting the maximum distance allows the stream to recover 
more rapidly if losing packets. Range: 0-60 seconds.

Number of B-frames. When using Main Profile, use the slider (or manually enter the 
value) to specify the number of B-frames in a GOP (range: 0 to 7). A higher number 
causes more efficient, slower encoding.

Encoding Settings

Windows Media Video VC-1 Codec—Encoding Settings

Encoding Complexity. Select from the following options:

Live Fast | Live Normal are best for streaming video.

Offline Fast | Offline Normal | Offline Slow provide increasingly slower, but higher quality 
encoding; they are better for downloadable video.
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Windows RGB Codec

Note:  This codec is available only in Episode Pro and Episode Engine.

Windows RGB is an uncompressed I-frames-only format.

Windows RGB Codec Settings

Bits Per Pixel. Select 24 | 32 from the dropdown menu. 24 bits per pixel provides 8 bits 
each for red, blue, and green. 32 bits per pixel provides additional support for an 8-bit 
alpha channel.
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XAVC Codec
The XAVC video format was invented by Sony for use in its video cameras and 
camcorders. XAVC uses level 5.2 of the H.264/MPEG-4 AVC format, supporting up to 4k 
resolution (4096 x 2160) and up to 60 frames per second. Color depth can be 8-, 10-, or 
12-bits, and chroma subsampling can be 4:2:0, 4:2:2, or 4:4:4. The container format is 
MXF. 

XAVC Codec Settings

Settings
XAVC Type. Select either the XAVC Intra type for intra-frame processing, or the XAVC 
Long GOP for Group of Pictures processing. According to Sony specifications, long GOP 
format at 35 to 50 Mbps is a good choice for HD when the best compromise between 
small file size with high picture quality and low computational demand is required. 
Intra produces high picture quality but requires a higher bitrate and more 
computational power.

AVC Intra Class. If you choose Intra type above, also select the Intra Class: 50 to 480 
CBG (constant bit rate) or 100 to 480 VBR (variable bitrate). VBR is supported by most 
equipment and can produce higher video and audio quality. However, it can also take 
more time to encode and may sometimes exceed the data rate of the connection. 

AVC Long GOP Bit Rate. If you choose Long GOP above, select the bit rate, from 25 to 
300 Mbps, or select Automatic to allow the rate to be set automatically.
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XDCAM HD Codec

Note:  This codec is available only in Episode Pro and Episode Engine.

XDCAM HD is an MPEG-2-based codec used by Sony for High-Definition video. 

XDCAM HD Codec Settings

Version. Select the video profile, which is comprised of a codec, rate control, frame size, 
color space, and/or bit rate.
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YCbCr Codec

Note:  This codec is available only in Episode Pro and Episode Engine.

YCbCr is an uncompressed I-frames-only format. It is a transformation of RGB images 
where Y is the luma (brightness) component of the image and Cb and Cr are the blue 
and red chroma (color) components, respectively. For details, see Color Formats.

YCbCr Codec settings

Color Space. Select from these options:

Same as Source causes the codec to use the color space in the source material.

4:2:0 | 4:2:2 | 4:2:2 Interleaved causes the codec to use the specified color space. 4:2:2 
Interleaved format has Y, Cb, and Cr samples for each pixel stored next to each other, 
and the planar formats have all Y, Cb, and Cr samples stored in separate sequences 
(planes).
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Video Filters
This chapter describes each of the video filters in Episode:

■ Advanced Frame Rate Filter

■ Black and White Restoration Filter

■ Burn Timecode Filter

■ Caption Importer Filter

■ Color Space Converter Filter

■ Contrast Filter

■ Deinterlace Filter

■ Fade Filter

■ Field Order Filter

■ Frame Rate Filter

■ Gamma Filter

■ HSV Levels Filter

■ Interlace Filter

■ Matte Extractor Filter

■ Noise Reduction Filter

■ Resize Filter

■ RGB Filter

■ Rotate Filter

■ Sharpen Filter

■ Smoothing Filter

■ Timecode Converter

■ VBI Exporter Filter

■ VBI Importer Filter

■ Watermark Filter

■ Watermark Resize Filter
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Video filters apply transformations to the video track in the source file, before it is 
encoded. Activated filters are applied to your video in the order they are listed in the 
Inspector panel, from top to bottom.

You select a filter to display its properties in the inspector. You activate a filter by 
checking its checkbox, and de-activate it by unchecking the box. You can only alter the 
properties (or method/option/section within a filter) of an active filter.

Note: Codecs encode the output after all active video filters have been applied to 
your input media (as it is being decoded). In some cases, functionality in filters and 
codecs is duplicated, and if enabled in both it may be unnecessary and harmless, or it 
may lead to unintended results. For example, you can enable a filter to change the 
display aspect ratio. However, in some codecs, you can also change the aspect ratio. 
The best practice is to avoid duplication in your codec and filter settings.

Some filters are used to adjust the output format, such as the Frame Rate and Resize 
filters. Others are used to improve the appearance of the image, such as the Noise 
Reduction filter, and the Black And White Restoration filter. Still others add information 
to the output file, such as the Burn Timecode filter and Watermark filter.

You can view the effects of video filters by using the Preview function to encode and 
view a sample of your video input to determine if you are achieving the intended effect 
(see Previewing Workflow Outputs).

Click the question mark icon to display online help for the filter.

Only active filters are applied to your video (as depicted in the figure following), and 
they are applied frame by frame, to decoded digital baseband video in the order they 
are listed in the Inspector panel, from top to bottom.
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This process and result are depicted in the figure below:

Video Filter Application to a Frame

In this example, the Contrast, Burn Timecode, and Watermark filters are activated (and 
configured). On this frame which has just been decoded to digital baseband, first the 
Contrast filter is applied, increasing the contrast (which you can see in the output 
frame). Next, the Burn Timecode filter renders the current timecode onto the frame (see 
output frame), and finally the Watermark filter applies the specified graphic to the 
frame—notice that the watermark partially overlays the timecode.

With all the video filters applied, the digital baseband output frame is passed to the 
encoder for encoding into the output stream.



Video Filters
Advanced Frame Rate Filter

320
Advanced Frame Rate Filter
The advanced frame rate filter performs complex frame rate conversions. (Basic frame 
rate conversions are available in the Frame Rate Filter.)

Note: A frame rate change that changes the video track duration requires you to use 
the Audio Speed Filter to adjust the audio track to match.

Advanced Frame Rate Filter—General Settings

Filter Mode. Select the type of frame rate conversion you want to perform:

Fixed Frame Rate enables the Create New Frames field. New frames are created to match 
the given frame rate.

Twice the Framerate sets the filter output frame rate to twice the input frame rate. This 
setting is often used when you are interlacing non-interlaced content, using the double 
frames to create fields in the interlace filter. This setting can optionally be used to create 
slow motion material by setting the Stated output frame rate to Same as input.

Copy Input Frames copies the source frames to the output, but a different frame rate can 
be specified with the Stated output frame rate menu.

Create New Frames at Rate. When using Fixed Frame Rate, use the slider (or manually 
enter) the new output frame rate. Range: 001 to 200.

Create New Frames. Select how to create new frames:

As Copy Of Nearest Neighbor copies the source frame closest in time to the desired 
output frame. This is the fastest frame generation method, but may cause uneven 
motion, especially in pans.

By Blending Neighboring Frames creates the output frame as a weighted average of the 
two source frames closest to it in time. This provides smoother motion, but may also 
cause slight blurriness.

Using Smart Motion Compensation analyzes the motion of the objects in the video to 
provide both a sharp image and smooth motion. Scenes where the motion of objects is 
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hard to analyze may cause artifacts in the image. The algorithm searches in the most 
probable direction of motion.

Using Heavy Motion Compensation searches the entire frame to find the best match for 
motion. This method is very slow, but often produces in the best result.

Stated Output Frame Rate. Select the indicated output frame rate:

Same As Input sets the output frame rate from the filter to be the same as the frame rate 
of the input material.

Note: If you are using the Field Order Filter in this workflow, it may have already 
changed the frame rate relative to the source frame rate.

To Keep Speed adjusts the stated output frame rate so that one second of input material 
generates one second of output material.

Set To explicitly sets the desired output frame rate from the filter.

Frames Per Second. When using the Set To option, enter the frames per second.

Advanced Frame Rate Filter—Advanced Settings

Enable Advanced Options. Check to enable these advanced features:

Search Block Size (Pixels). Select a block size from the dropdown menu to determine 
how large a search block to use in the interpolation algorithm. A larger search block 
provides better data to work with but also limits the amount of motion in between 
frames. Smaller-sized frames should use smaller search blocks.

Motion Search Length. Select a short, medium, or long motion search distance from 
the dropdown menu. A longer search distance improves compression, but slows 
transcoding.

Dampen Deviating Motion. Use the slider to determine what assumptions to make 
about motion in the frames. If motion is mostly uniform in one direction, set the slider 
toward more, in which case deviation motion is treated as noise and filtered away. If 
motion is non-uniform and should be kept so, set the slider toward less.

Blur Motion Estimation Errors. Use the slider to perform a certain amount of image-
blurring to hide errors in motion estimation, from less to more.

Sub-pel Precision. Check to perform motion estimation for movements smaller than a 
full pixel. This improves image quality, but slows transcoding.
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Black and White Restoration Filter
Content for television (encoded from PAL or NTSC) sometimes appears washed out: 
black appears dark grey and white appears as light grey. Use the black and white 
restoration filter to correct this condition by setting a new black and/or white level.

Black and White Restoration Filter Settings

Black. Use the slider to set (or manually enter) the threshold for black. All luma values 
below this are remapped to black. (Range: 0 to 255.)

White. Use the slider to set (or manually enter) the threshold for white. All luma values 
above this are remapped to white. (Range: 0 to 255.)
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Burn Timecode Filter
Use the burn timecode filter to add a visible timecode to the output video. The 
timecode alters the video frame, and cannot be removed later.

Burn Timecode Filter Settings

Position X. Select the horizontal position of the timecode burn-in location: Left | Center 
| Right.

Position Y. Select the vertical position of the timecode burn-in location: Top | Center | 
Bottom.

Opacity (%). Use the slider to set (or manually enter) the opacity value, making the 
timecode text partially transparent. Lower values are more transparent; higher values 
are more opaque. Range: 0 to 100.

Width (%). Use the slider to set (or manually enter) the timecode width as a percentage 
of the image width. Range: 0 to 100.

Font. Select a font for the timecode.

Header. Enter the text prefix to display with the timecode.
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Caption Importer Filter
Use the Caption Importer Filter to select and import the data from an SCC (.scc) closed 
caption file or an MCC (.mcc) MacCaption or CaptionMaker file. These files will produce 
EIA-608 SD or EIA-708 HD captions on the transcoded MXF, MPEG2, or H.264 (x264) 
output if you enable the additional output settings explained below.

To pass the imported captions from the .scc or .mcc file through to the transcoded 
output, select a Closed Captioning type in Video Encoder. See these container and 
encoder descriptions for details about enabling closed captions on the transcoded 
output: MXF AS-11 (.mxf), MXF Op1a (.mxf), MXF XDCAM (.mxf), MPEG-2 Codec, H.264 
(MainConcept) Codec, or H.264 (x264) Codec. 

These elements must be present to produce a captioned output from a caption file:

• Select an imported .scc or .mcc caption file in the Caption Importer Filter.

• Set Video Encoder Closed Captioning to Same as Source or the type of captioning 
you are submitting via the .scc (608) or .mcc (708+608) file.  

Note: Because you must explicitly specify a file (and not a file pattern), you must 
change the file in the filter each time you run this workflow.

Caption Importer Filter Settings

Click the Browse/navigation button and choose the .scc or .mcc file to import.
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Color Space Converter Filter
Use the color space converter filter to convert video between 601 and 709 color spaces. 
Additionally, color can be converted between scaled and unscaled color.

Color Space Converter Settings

Color Space
Input Color Space. Select Derive From Source | ITU-R Rec. 601 | ITU-R Rec. 709 to identify 
the color space of your source video.

Output Color Space. Select Derive From Source | ITU-R Rec. 601 | ITU-R Rec. 709 to specify 
which color space to use to encode your video.

Video Levels
Output Video Levels. Select the options for dealing with monitor vs. television output 
from the dropdown menu:

Pass Through Use the same video level on your output as your input.

Clamp to Studio Range (Video Levels) Narrow full-range values (RGB 0-255) to studio 
values (RGB 16-235) by clamping out-of-range values.

Stretch to Full Range (RGB Levels) Expand studio range video (RGB values 16-235) to full-
range values (RGB 0-255), in a relative manner.

Squeeze to Studio Range (Video Levels) Narrow full-range values (RGB 0-255) down to 
studio values (RGB 16-235), in a relative manner.
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Contrast Filter
Use the contrast filter to make dark pixels darker and light pixels lighter. Higher positive 
values increase contrast; higher negative values flatten or reduce contrast.

Video encoded from NTSC/PAL can sometimes look a bit grey or milky. Increasing the 
contrast may improve the appearance.

Be careful not to increase the contrast too much—lighter pixels have a tendency to 
become a white blur. In high contrast video, you can lower the contrast, causing the 
image to become develop a flat or greyish appearance.

Contrast Filter Settings

Contrast (%). Use the slider to set (or manually enter) the contrast adjustment value.
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Deinterlace Filter
Use the deinterlace filter to convert video from interlaced to deinterlaced (progressive). 
As explained in Video Scan, a television video frame is constructed of two interlaced 
fields as a pair, displayed one after the other. Because computers, mobile phones, and 
other mobile devices use progressive scan, showing a whole frame at once, interlaced 
video should be deinterlaced for playback on these devices.

Deinterlace Filter Settings

Field Order. Select the option to determine which field is dominant.

Top Indicates that the input should be processed as top-field dominant.

Bottom Indicates that the input should be processed as bottom-field dominant.

Automatic Detection Analyzes the correct field order (recommended).

Note: If the field order filter is activated, the values set in the field order filter are used 
and this setting is ignored.

Creating New Fields by. Create each de-interlaced frame from two fields.

Duplication. Duplicates the dominant field—quicker with less lower visual quality.

Interpolation. Creates new pixels by linear interpolation of the nearest pixels in the 
dominant field only; the non-dominant field is discarded. This method provides better 
results than duplication, but requires more processing time.

Blending. Averages both fields to smoother motion; less sharpness than interpolation.

Smooth Blending. Averages both fields, then applies the lowpass filter to the frame. 
This method provides a smoother image, but is slightly slower than blending.

Edge Detecting Interpolation. Interpolates pixels (only vertically). Edge Detecting 
Interpolation attempts to find similar elements in the frame and detect edges before 
interpolating. This method provides more distinct diagonal edges in the output.

Edge Detecting Interpolation Heavy. Interpolates in the same manner as edge 
detecting interpolation, but with a more detailed algorithm. This method slows 
encoding, but provides better results.
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Motion Compensation. Analyzes the motion of objects in the video to obtain more 
information on how to best create new frames. This method provides sharper output 
than blending, while preserving smooth motion. Motion compensation usually 
provides the best results, but may result in artifacts in scenes where motion is difficult 
to estimate. This method is computationally intense, and therefore the slowest.

Note: Motion compensation requires deinterlacing of all frames, therefore the 
Deinterlace Type setting is ignored when using the Motion Compensation method.

This table displays an original image, and images processed by various methods in the 
deinterlace filter, to illustrate how these methods change the visual result.

Deinterlace Type. Select the type of deinterlacing from the dropdown menu:

Complete Deinterlace. Deinterlaces the entire frame.

Effects of Different Deinterlacing Types on Frames

Image Description

Unprocessed interlaced frame

Duplication

Interpolation

Blending

Smooth blending

Edge detecting interpolation

Motion compensation
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Deinterlace Interlaced Frames (Automatic). Deinterlaces frames that are determined 
to be interlaced. This option is suitable for media with both interlaced and progressive 
frames, such as telecine media.
Deinterlace Interlaced Frames (Manual). Deinterlaces frames that are determined to 
be interlaced based on the Threshold field value. This option is suitable for media with 
both interlaced and progressive frames, such as telecine media.
Deinterlace Moving Areas (Automatic) deinterlaces the moving parts of each frame. This 
option is not suitable for media with progressive frames, such as telecine media.
Deinterlace Moving Areas (Manual) deinterlaces the moving parts of each frame. 
Deinterlacing is performed on those macroblocks where the average luminance 
difference between the two frames exceeds the value in the Threshold field. This option 
is not suitable for media with progressive frames, such as telecine media.
Double Frame Rate. Separates interlaced frames into two consecutive frames. This 
doubles the frame rate, so it is necessary to apply the Frame Rate Filter to keep the 
original speed. One application of this function is converting from HD interlaced to SD 
progressive media.
Threshold. Set the threshold for when deinterlacing should occur. The value 
determines how large the difference can be between the pixels of two fields before 
deinterlacing. If the value is set to zero the whole frame is de-interlaced.
Deinterlace Chroma. Check to indicate that the chroma channel is interlaced in the 
source material and has to be de-interlaced as well. It is not always easy to know if the 
chroma channels are interlaced or not. To verify results of your workflow with 
deinterlacing selected, use the Preview function (see Previewing Workflow Outputs).
 

Note: Only apply Deinterlace to interlaced media. Otherwise, undesirable artifacts 
are created. When using the Field Order filter, make sure your source media has not 
been de-interlaced prior to use.

Effects of Deinterlacing Luma and Chroma

Image Description

Only luma de-interlaced

Both luma and chroma de-interlaced
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Fade Filter
Use the fade filter to fade the encoded clip in and out from/to black or white. The 
number of frames are counted from the beginning of the clip for a fade in and from the 
end for a fade out.

Fade Filter Settings

Fade In (Frames). Use the slider to set (or manually enter) the number of frames over 
which the clip is faded in.

Fade From Color. Select Black or White.

Fade Out Frames. Use the slider to set (or manually enter) the number of frames 
(counting from the end of the clip).

Fade To Color. Select Black or White.
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Field Order Filter
Use the field order filter to change the field dominance of interlaced video. Subsequent 
filters may require this field order information to operate properly.

The field order filter can both identify and modify interlacing. You can select from a list 
of input video choices and then select from choices on how to modify the media.

The field order filter can both identify it and modify field order, depending on the 
parameters you set.

Field Order Filter Settings

Input Field Order. Select the field dominance of the incoming material.

Derive from file format operates on the field order, based on the assumption that the 
field order information in the source file is correct (regardless of whether it is or not).

Source has Top Field First operates on the field order, assuming the source is top field 
dominant.

Source has Bottom Field First operates on the field order, assuming the source is bottom 
field dominant.

Source is Progressive operates on the field order assuming the source is progressive; 
disables the filter action option.

Source has unknown field order does not modify the source; subsequent filters are free 
to determine the field order themselves; disables the filter action option.

Filter Action. When source is interlaced, select how to change the dominance of 
interlaced material:

Same as input does not change the field dominance; disables the filter method option.

Switch to Top Field First changes the field dominance to top field dominant.

Switch to Bottom Field First changes the field dominance to bottom field dominant.

Interlaced to Progressive deinterlaces the input and creates progressive output; disables 
filter method option. If you select this option, do not use the Deinterlace Filter. The 
output frame rate from this filter is twice the input frame rate, so if you also use the 
Frame Rate Filter or Advanced Frame Rate Filter you must take account of this. 
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Filter Method. When Filter Action is set to Switch to Top Field First or Bottom Field First, 
select how to change the field order. Spatial shifts reorder the fields in situ and does not 
cause any problems for cuts, but loses one line of the image.

Spatial Shift Upwards moves both fields upward by one line (losing the topmost line).

Spatial Shift Downwards moves both fields downward by one line (losing the 
bottommost line).

Temporal Shift moves all fields towards the beginning of the clip, dropping the first field.
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Frame Rate Filter
The frame rate filter performs simple conversions of the frame rate of a clip. The 
Advanced Frame Rate Filter performs more complex conversions, suitable for video 
standard conversions (for example, PAL and NTSC).

A frame rate change that modifies the duration of the video requires you to use the 
Audio Speed Filter to adjust the speed of any audio track to match.

Frame Rate Filter Settings

Filter Mode. Select the filter mode from the dropdown menu:

Fixed Frame Rate utilizes the New Frame rate for the output file, using the conversion 
algorithm you specify in Framerate Preset.

Fractional Frame Rate specifies the resulting frame rate as the fraction of the original 
frame rate you specify in Change Framerate To.

Upper limit sets a maximum frame rate that to be used if the input frame rate is higher. If 
the input frame rate is lower, the input frame rate is used.

Framerate Preset. Select the filter mode from the dropdown menu:

Fast does not interpolate frames but reuses frames if needed to achieve the desired 
frame rate.

Automatic analyzes PAL or NTSC source video to determine the best algorithm for the 
specific conversion.

Telecine 24->29.97 | Telecine 23.976->29.97 | Inv.Telecine, Fixed Cadence 29.97->23.976 | 
Inv.Telecine 29.97->24 | Inv.Telecine 29.97->23.976 | Film => PAL 24->25 | PAL => Film 25-
>24 selections perform conversion between formats and deactivates New frame rate.

As explained in Video Scan, Episode automatically detects the cadence even when it is 
broken. But, if you know that the cadence is fixed for the entire length of the clip, the 
extra processing is unnecessary. 

You can select, for example, Inverse Telecine, Fixed cadence 29.97->23.98 to enable 
First interlaced Pair and set which frames have been derived from the first duplicated 
film frame. If the first frame is a single interlaced frame, this option cannot be used.

New Framerate (FPS). Select the desired frame rate of the output video from the 
dropdown menu.
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Change Framerate To. When Fractional Framerate is selected in Filter Mode, select the 
output frame rate as a fraction of the input frame rate from the dropdown menu.

This option simply selects from already existing frames without interpolating, and 
disables Framerate Preset. 2x speeds up the frame rate—useful when converting HD 
low frame rate video to SD high frame rate video, for example.

First Interlaced Pair. Select which frames have been derived from the first duplicated 
film frame, from the dropdown menu.

Gamma Filter
The gamma filter is a commonly used filter, providing an important correction in many 
video workflows. Gamma compensates for the color display differences between 
various display technologies and devices. For example, PDAs, iPods, handheld devices 
and terminals and MacOS X and Windows computers all have varying gamma.

The gamma filter is a non-linear filter. It only affects midrange tones, leaving the darkest 
and lightest parts unchanged. This enables you to darken or lighten your video without 
risk of distorting the darkest and brightest areas.

Gamma Filter Settings

Gamma. Use the slider to select (or manually enter) the gamma correction. Range: -100 
to 100. Positive numbers (1 to 100) lighten the image. Negative numbers (-1 to -100) 
darken the image. Larger numbers increase the effect.
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HSV Levels Filter
The HSV levels filter makes color adjustments in the Hue, Saturation and Brightness 
(Value) color space. This filter compliments the RGB Filter which adjusts in the Red, 
Green, Blue color space.

HSV Levels Filter Settings

Hue. Use the slider to select (or manually enter) how to alter the colors. The value is 
measured in degrees. Range: -180 degrees to +180 degrees. This is useful for correcting 
badly white-balanced material, for example.

Saturation. Use the slider to select (or manually enter) how to alter the intensity of the 
colors. Positive values intensify the colors, and vice versa. Range: -100% to +100%.

Brightness (Value). Use the slider to select (or manually enter) how dark (negative 
values) or bright (positive values) to make the video. It affects all pixels linearly, unlike 
the Contrast Filter, which makes dark pixels become darker and bright pixels brighter.

Interlace Filter
Use the interlace filter to convert progressive input to interlaced, at half the input frame 
rate.

Interlace Filter Settings

Field Order. Select the field dominance that is appropriate for the output format. See 
Video Scan for standard field orders for common formats.
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Matte Extractor Filter
Use the matte extractor filter to extract the alpha transparency channel of the source 
file and convert it to a grey-scale image, with completely opaque mapped to white and 
completely transparent mapped to black.

There are no user-settable options.

Noise Reduction Filter
Use the noise reduction filter to diminish visual noise in your video. The filter employs 
three methods to reduce noise in the clip:

■ Median Method

■ Average Method

■ Temporal Method

You can use one, two, or all three methods and specify how many times each method is 
to be applied.

Median Method
Use the median method when you want to replace each pixel value with the median 
value of the pixels in the filter box. This improves the quality of images with impulse 
noise, by mainly affecting pixels with values very different from those of their 
neighbors.

Noise Reduction Filter Settings—Median Method

Enable. Check to use this method in the filter.

Number Of Runs. Enter the number of times to run the filter.

Radius (pixels). Use the slider to set the size of the filter box (or enter it manually). 
Range: 0 to 7.

Only Filter Chroma. Check to filter only the color component of the material. Luma is 
left unchanged. This may be useful when encoding old VHS material, since much of the 
noise often resides in the chroma channel.
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Average Method
Use the average method when you want to replace each pixel value with the average 
value of the pixels in the filter box. This improves the quality of images with impulse 
noise, by mainly affecting pixels with values very different from those of their 
neighbors.

Noise Reduction Filter Settings—Average Method

Enable. Check to use this method in the filter.

Number Of Runs. Enter the number of times to run the filter.

Radius (pixels). Use the slider to set the size of the filter box (or enter it manually). 
Range: 0 to 7.

Threshold. Set the maximum pixel difference value, beyond which the filter should not 
alter the filtered pixel if the difference between the and its environment is larger than 
the threshold. This preserves text and other small objects with large contrast.

Temporal Method
Use the Temporal Method when you want to compare each pixel in the current frame 
with the corresponding pixel in the previous frame. If the difference is less than the 
threshold value the pixel value is left unchanged; otherwise it is replaced by the pixel 
value in the previous frame. This smooths a series of frames over time.

Noise Reduction Filter Settings—Temporal Method

Enable. Check to use this method in the filter.

Threshold. Select the threshold level (or enter it manually) for pixel value replacement.
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Resize Filter
The resize filter performs conversions on the pixel frame dimensions of a clip. In 
addition to crop and pad functions, resize also has controls for frame aspect ratio, pixel 
aspect ratio, and display aspect ratio.

On a Mac, the size and initial crop settings are in the General tab. The scaling details and 
aspect ratio settings are in the Advanced tab.

Size Settings

Resize Filter—Size Settings

Image Size. Select the output frame size from the options in the dropdown menu. 
Select Custom to enter specific (non-standard) values in the Width and Height fields 
and enable Image Proportions. Sizes now include 2K and 4K resolutions.

Width. When Custom is selected in Image Size, enter the width of the resized image in 
pixels.

Height. When Custom is selected in Image Size, enter the height of the resized image in 
pixels.

Image Proportions. Select the aspect ratio for the image. Width and Height settings 
will automatically conform to the selected aspect ratio, unless you select None 
(Unconstrained), in which case, you can enter any values for Width and Height. 

Aspect Width and Aspect Height. Displays the aspect ratio width and height 
dimensions.

Maintain Proportional Width. Select the options to determine how to process the 
original image to achieve the output size, from the dropdown menu. This affects the 
ratio between the number of pixels in the horizontal and vertical dimensions. This is 
not necessarily the same as the display aspect ratio, as explained in Picture Resolution 
and Aspect Ratio. 
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Cut keeps the image proportions of the material by cropping away parts of the image. 
For example, if encoding from a source clip with a 16:9 pixel relation to a clip with 4:3 
pixel relation, the sides of the source are cut, leaving the resulting image undistorted.

Letterbox (Pad) pads the image with black borders to fit the destination proportions. For 
example, a 16:9 clip encoded to 4:3 is padded at the top and bottom of the image.

None (Distort) stretches the output image to the desired size. This may cause distortion. 
The value in the Initial crop field (see below) is used. When coding anamorphic MPEG-2 
this is the option to use. Force the source material to PAL or NTSC size with this option, 
then select 16:9 display aspect ratio for playback in the MPEG-2 codec.

Initial Crop Settings
Before the image is scaled to the new size a cropping operation is applied to the source 
material. This can be used to remove black borders or edge artifacts from the source 
material.

Resize Filter—Initial Crop Settings

Top. Enter the number of pixels to trim from top of frame.

Bottom. Enter the number of pixels to trim from bottom of frame.

Left. Enter the number of pixels to trim from left of frame.

Right. Enter the number of pixels to trim from right of frame.
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Scaling Details

Resize Filter—Scaling Details Settings

Interpolation Method. Select the interpolation method to use for resizing:

Automatic uses bilinear for downsizing and bicubic for upsizing.

Bilinear usually best when downsizing the image.

Bicubic usually best when upsizing the image.

Lanczos a two-pass filtering method with increased sample rate and smoothness. 
Supports 10-bit.

Nearest Neighbor uses the fastest method but produces the lowest quality. It should 
only be used when speed is more important than quality.

Bicubic Sharpening. Use the slider (or enter the value manually) to specify the amount 
of post re-size edge sharpening to apply.

Preprocessing select how to implement lowpass filtering to reduce artifacts in 
downscaled images.

Nothing performs no filtering.

Lowpass for Large Downscales filters images where the ratio between in-size and out-
size is larger than 1.7 in either the horizontal or the vertical dimension. If the ratio is 
larger than 3.8 the images are filtered more.

Always Lowpass Source filters all images regardless of the amount of scaling.

Interlace Handling. Select how to handle interlaced source.

Automatic selects between Progressive Output and Scale Fields Independently based 
on the available field order information.

Progressive Output scales the image as a whole with no regard to interlacing. This is the 
default mode and works well in most cases.

Only Crop/Pad to Size—No Scale crops or pads the image to the new size, without 
stretching the image. This option is useful when scaling to a size which is only slightly 
larger or smaller in height than the source, especially if the contents are interlaced.

For example, when converting from NTSC 720 x 486 to MPEG-2 NTSC 720 x 480 you do 
not need to encode all the source lines to a format that does not use all the lines. By just 
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cropping the unnecessary 6 lines you do not have to interpolate lines which would lose 
quality.

Scale Fields Independently divides the image into two fields which are then scaled 
independently. This keeps the interlacing correct when, for example, downscaling from 
HD to SD material.

Aspect Ratio Settings
See Picture Resolution and Aspect Ratio for a discussion of display aspect ratios and pixel 
aspect ratios.

Resize Filter—Aspect Ratio Settings

Input Display Aspect Ratio. Select how to compensate for odd frame sizes and/or 
anamorphic source material, by indicating the actual display aspect ratio of the source 
data. For example, Video CD (VCD) material is usually encoded with 480 x 480 pixels, 
but displayed with 640 x 480 pixels, so you should indicate an input display aspect ratio 
of 4:3.

Pass Through (Keep Display Aspect Ratio) uses the display aspect ratio that results from 
the settings in the Size and Initial crop fields as explained above for Maintain 
Proportion With.

Derive From Source uses the display aspect ratio information in the source file, if 
available. D-10/IMX, DV, MPEG-2, and MPEG-4 contain display aspect ratio information. 
For all other formats, square pixels are assumed. For example, if the source material is 
480 x 480 pixels with its display aspect ratio field set to 4:3, Image size is set to 480 x 480 
and Maintain proportion with is set to Letterbox (Pad), the output is 480 x 480 pixels, 
but with a visible area of 480 x 360 pixels with black margins above and below.

Assume Square Pixels assumes that the source material has square pixels and that its 
display aspect ratio therefore is the same as width:height.

Assume 4:3 | Assume 5:4 | Assume 16:9 | Assume 2.21:1 use the selected value for the 
source display aspect ratio. This display aspect ratio is then used in the same manner as 
for Derive From Source.

Output Display Aspect Ratio. Select the display aspect ratio of the output file:

Same as Input Display Aspect Ratio uses the display aspect ratio of the source file.
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Automatic sets the display aspect ratio to Width:Height if Maintain Proportion With has 
been set to Cut or Letterbox (Pad), otherwise uses the display aspect ratio of the source 
file (i.e. assumes square pixels).

Square Pixels sets the display aspect ratio to Width:Height.

4:3 | 5:4 | 16:9 | 2.21:1 explicitly set the display aspect ratio.

Output Pixel Aspect Ratio (MOV only). Select the pixel aspect ratio for QuickTime 
output:

Custom enables you to explicitly set the Horizontal Pixel Spacing and Vertical Pixel 
Spacing. For example, a value of one in each field specifies a square, or 1:1 pixel. In 480 
SD video, you may use 10 horizontal, by 11 vertical pixels. In 576 SD video, you may use 
59 horizontal by 54 vertical pixels.

Automatic determines the pixel aspect ratio from the Image size and Output display 
aspect ratio.

Square sets a 1:1 pixel aspect ratio.

NTSC ITU-R Rec. 601 | NTSC ITU-R Rec. 601 (16:9) | PAL ITU-R Rec. 601 | PAL ITU-R Rec. 601 
(16:9) sets the appropriate pixel aspect ratios for television standards.

Horizontal Pixel Spacing. When Output Aspect Ratio is set to Custom, enter an integer 
value to shape the pixel as a ratio of height to width, in conjunction with the Vertical 
Pixel Spacing value.

Vertical Pixel Spacing. When Output Aspect Ratio is set to Custom, enter an integer 
value to shape the pixel as a ratio of height to width, in conjunction with the Horizontal 
Pixel Spacing value.
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RGB Filter
The RGB filter adjusts the colors in the Red Green Blue color space. For each color 
channel you specify how much to add or subtract from each pixel. 100% is the maximal 
value for the given color value. This contrasts with the HSV Levels Filter, which makes 
color adjustments in the Hue, Saturation and Value (Brightness) color space.

RGB Levels Filter Settings

Red (%). User the slider (or enter value manually) to determine what percent of this 
channel to add or subtract. Range: -100% to 100%.

Green (%). User the slider (or enter the value manually) to determine what percent of 
this color channel to add or subtract. Range: -100% to 100%.

Blue (%). User the slider (or enter the value manually) to determine what percent of 
this channel to add or subtract. Range: -100% to 100%.

Rotate Filter
Use the rotate filter to flip frames horizontally or vertically during encoding.

Rotate Filter Settings

Flip Operation. Select None | Horiziontally | Vertically to determine how each frame is 
rotated.
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Sharpen Filter
Use the sharpen filter to increase the contrast (or sharpen) between contrasting areas 
which appear as objects in the image, thereby creating a more crisp, differentiated 
appearance.

Sharpen Filter Settings

Strength (%). Use the slider (or manually enter the value) to set the percent of 
sharpening to apply. Range: 0 to 100. Higher values provide stronger sharpening.

Smoothing Filter
Use the smoothing filter to blur and interpolate the pixels. This makes the material look 
smoother (but loses some contrast).

Smoothing Filter Settings

Strength (%). Use the slider (or manually enter the value) to set the amount of 
smoothing to apply. Range: 0 to 100. Higher values provide stronger smoothing.

Size (Pixels). Select the size of the smoothing area: 3x3 | 5x5.
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Timecode Converter
The timecode converter filter enables Episode to carry timecode over to encoded 
outputs even when complex conversions have changed the encoded outputs frame 
rate. The options provided allow the user to select different methods of timecode 
calculation.

The filter is used when the encode contains a frame rate altering setting such as the 
frame rate filter, the advanced frame rate filter, or certain de-interlace modes.

There are several options you can choose to determine output timecode start times in 
the event the new start frame is not available based on the output timebase. In every 
case the hours and minutes TC values stay the same.

Timecode Converter Settings

Scale. Episode scales the output TC start frame so that it starts on the same relative 
frame as the input.

For example, if the input time code is 30NDF 01:00:00:27 and the new time base is 
24NDF, the output timecode start would be 01:00:00:23. (27/30)*24 (rounded off to the 
nearest frame)

Round Off. Episode rounds up to the next second as a new start frame. Using the 
above example, the output timecode start would be 01:00:01:00 (27 rounded up to the 
next second).

Keep Count. Adds the number of frames from the input to the output time base. Using 
the above example, the output timecode start would be 01:00:01:03 
(01:00:00:00+01:03) (27 frames at 24NDF timebase).

Allow drop frame <-> non-drop frame conversions. This allows the conversion 
between drop and nondrop timecode.
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VBI Exporter Filter
Use the VBI exporter filter to add Vertical Blanking Interval (VBI) data to the output file.

VBI Exporter Filter Settings

Output VBI Size. Select the method to specify the VBI size from the dropdown menu:

Same as Detected by Vertical Blanking Interval Importer causes the filter to determine the 
VBI size automatically, based on the size determined by the VBI Importer Filter when it 
ran earlier in the job.

Manually Specify Vertical Blanking Interval Size enables you to set the size for your own 
requirements, in Manual VBI Size.

Manual VBI Size. When manually specifying VBI, use the slider (or manually enter the 
value) to set the VBI size in pixels. Range: 0 to 64.
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VBI Importer Filter
Use the VBI importer filter to remove Vertical Blanking Interval (VBI) lines from video 
data. If necessary, use the VBI Exporter Filter to reinstate the VBI lines in the output. You 
can also use the VBI Importer Filter to extract closed captions from the input VBI for 
embedding on the output (see Caption Decoding below).

VBI Size

VBI Importer Filter—VBI Size Settings

Automatic VBI Size. Select the method to determine the VBI size from the dropdown 
menu:

Automatically Detect Vertical Blanking Interval Size causes the filter to determine the VBI 
size automatically, assuming the source video is NTSC or PAL. This option removes the 
32 top video lines.

Manually Specify Vertical Blanking Interval Size enables you to set the number of lines to 
remove for your own requirements, in Manual VBI Size. This option assumes the source 
file has a non-standard VBI size or is neither NTSC nor PAL and removes the number of 
lines specified in Manual VBI Size.

Manual VBI Size. When Manually Specify VBI Size is selected, set the number of lines to 
remove from the top of the source video.

Caption Decoding

VBI Importer Filter—Caption Decoding Settings

Decode Captions. Check to import in-band closed captions from VBI data. Episode can 
write these closed captions to these codecs and containers: MPEG-2 Codec, H.264 (x264) 
Codec, H.264 (MainConcept) Codec, MXF AS-11 (.mxf), MXF Op1a (.mxf), and MXF XDCAM 
(.mxf). Refer to those topics for details regarding the encoder output caption settings.
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Closed Captioning Location Mode. Select the mode for determining the closed 
captioning line.

Automatic enables the filter to determine which line closed captioning is on.

Manual allows you to specify which line to pull closed captioning from, in Closed 
Captioning Line.

Closed Captioning Line. When manually specifying the Closed Captioning Location 
Mode, use the slider (or manually enter the value) to specify the closed captioning line 
in the VBI. Range: 0 to 64.

Watermark Filter
Use the watermark filter to apply a brand, and mark your encoded clip to ensure that 
the viewers are aware of the origin of the material that they are watching.

You can use the Watermark Resize Filter to resize your watermark to better fit in the 
image.

Watermark Filter Settings

File. Click Browse/navigation button to navigate and select the file you intend to use as 
a watermark. The following file formats can be used as watermarks.
:

Supported Watermark File Formats

File Format Details (Pixel Depth)

BMP 16/24-bit RGB

JPEG EXIF metadata also supported

Targa 16/24/32-bit RGB

TIFF 16/24/32-bit RGB
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Corner. Select the corner of the frame to place the watermark in: Top Left | Top Right | 
Bottom Left | Bottom Right.

Loop Type. When the file is a clip, select how the watermark is burned into video 
frames from the dropdown menu. When the file is static (a single image), this option is 
ignored.

Play Once select to play through the animation once and stop on the last frame.

Loop select to play the animation repeatedly in the video.

X Offset (pixels). Enter the horizontal offset from the selected corner.

Y Offset (pixels). Enter the vertical offset from the selected corner.

Opacity (%). Set the opacity of the watermark. This is not to be confused with the 
transparency (alpha channel) of the image object itself.

Start time. Check the option, and use the slider (or enter the value manually) to select 
the time when to start applying the watermark from the start of the clip. If not set, the 
watermark is applied at the start of the clip.

End time. Check the option, and use the slider (or enter the value manually) to select 
the time when to stop applying the watermark. If not set, the watermark is applied to 
the end of the clip.
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Watermark Resize Filter
The watermark resize filter is a sub-filter of the watermark filter. Use the watermark 
resize filter to modify the size of the image that is applied to the video in the Watermark 
Filter.

On a Mac, the size and initial crop settings are in the General tab. The scaling details and 
aspect ratio settings are in the Advanced tab.

Size

Resize Filter—Size Settings

Image Size. Select the output frame size from the options in the dropdown menu. 
Select Custom to enter specific (non-standard) values in the Width and Height fields 
and enable Image Proportions.

Width. When Custom is selected in Image Size, enter the width of the resized image in 
pixels.

Height. When Custom is selected in Image Size, enter the height of the resized image in 
pixels.

Image Proportions. Select the aspect ratio for the image. Width and Height settings 
will automatically conform to the selected aspect ratio, unless you select None 
(Unconstrained), in which case, you can enter any values for Width and Height. 

Aspect Width and Aspect Height. Displays the aspect ratio width and height 
dimensions.

Maintain Proportional Width. Select the options to determine how to process the 
original image to achieve the output size, from the dropdown menu. This affects the 
ratio between the number of pixels in the horizontal and vertical dimensions. This is 
not necessarily the same as the display aspect ratio, as explained in Picture Resolution 
and Aspect Ratio. 
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Cut keeps the image proportions of the material by cropping away parts of the image. 
For example, if encoding from a source clip with a 16:9 pixel relation to a clip with 4:3 
pixel relation, the sides of the source are cut, leaving the resulting image undistorted.

Letterbox (Pad) pads the image with black borders to fit the destination proportions. For 
example, a 16:9 clip encoded to 4:3 is padded at the top and bottom of the image.

None (Distort) stretches the output image to the desired size. This may cause distortion. 
The value in the Initial crop field (see below) is used. When coding anamorphic MPEG-2 
this is the option to use. Force the source material to PAL or NTSC size with this option, 
then select 16:9 display aspect ratio for playback in the MPEG-2 codec.

Initial Crop
Before the image is scaled to the new size a cropping operation is applied to the source 
material. This can be used to remove black borders or edge artifacts from the source 
material.

Resize Filter—Initial Crop Settings

Top. Enter the number of pixels to trim from top of frame.

Bottom. Enter the number of pixels to trim from bottom of frame.

Left. Enter the number of pixels to trim from left of frame.

Right. Enter the number of pixels to trim from right of frame.

Scaling Details

Resize Filter—Scaling Details Settings
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Interpolation Method. Select the interpolation method to use for resizing:

Automatic uses bilinear for downsizing and bicubic for upsizing.

Bilinear usually best when downsizing the image.

Bicubic usually best when upsizing the image.

Nearest Neighbor uses the fastest method but produces the lowest quality. It should 
only be used when encoding speed is more important than quality.

Bicubic Sharpening. Use the slider (or enter the value manually) to enhance object 
edges in the image.

Preprocessing. Select how to implement lowpass filtering to reduce artifacts in 
downscaled images.

Nothing performs no filtering.

Lowpass for Large Downscales filters images where the ratio between in-size and out-
size is larger than 1.7 in either the horizontal or the vertical dimension. If the ratio is 
larger than 3.8 the images are filtered more.

Always Lowpass Source filters all images regardless of the amount of scaling.

Interlace Handling. Select how to handle interlaced source.

Automatic selects between Progressive Output and Scale Fields Independently based 
on the available field order information.

Progressive Output scales the image as a whole with no regard to interlacing. This is the 
default mode and works well in most cases.

Only Crop/Pad to Size—No Scale crops or pads the image to the new size, without 
stretching the image. This option is useful when scaling to a size which is only slightly 
larger or smaller in height than the source, especially if the contents are interlaced.

For example, when converting from NTSC 720 x 486 to MPEG-2 NTSC 720 x 480 you do 
not need to encode all the source lines to a format that does not use all the lines. By just 
cropping the unnecessary 6 lines you do not have to interpolate lines which would lose 
quality.

Scale Fields Independently divides the image into two fields which are then scaled 
independently. This keeps the interlacing correct when, for example, downscaling from 
HD to SD material.

Black Level. Sets video black level from 0 (super black) to 16 (7.5 IRE setup).
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Aspect Ratio
See Picture Resolution and Aspect Ratio for a discussion of display aspect ratios and pixel 
aspect ratios.

Resize Filter—Aspect Ratio Settings

Input Display Aspect Ratio. Select how to compensate for odd frame sizes and/or 
anamorphic source material, by indicating the source data actual display aspect ratio. 
For example, since Video CD (VCD) material is usually encoded with 480 x 480 pixels, 
but displayed with 640 x 480 pixels, indicate an input display aspect ratio of 4:3.

Pass Through (Keep Display Aspect Ratio) uses the display aspect ratio that results from 
the settings in the Size and Initial crop fields as explained above for Maintain 
Proportion With.

Derive From Source uses the display aspect ratio information in the source file, if 
available. D-10/IMX, DV, MPEG-2, and MPEG-4 contain display aspect ratio information. 
For all other formats, square pixels are assumed. For example, if the source material is 
480 x 480 pixels with its display aspect ratio field set to 4:3, Image size is set to 480 x 480 
and Maintain proportion with is set to Letterbox (Pad), the output is 480 x 480 pixels, 
but with a visible area of 480 x 360 pixels with black margins above and below.

Assume Square Pixels assumes that the source material has square pixels and that its 
display aspect ratio therefore is width = height.

Assume 4:3 | Assume 5:4 | Assume 16:9 | Assume 2.21:1 use the selected value for the 
source display aspect ratio. This display aspect ratio is then used in the same manner as 
for Derive From Source.

Output Display Aspect Ratio. Select the display aspect ratio of the output file:

Same as Input Display Aspect Ratio uses the display aspect ratio of the source file.

Automatic sets the display aspect ratio to Width:Height if Maintain Proportion With has 
been set to Cut or Letterbox (Pad), otherwise uses the display aspect ratio of the source 
file (i.e. assumes square pixels).

Square Pixels sets the display aspect ratio to Width = Height.

4:3 | 5:4 | 16:9 | 2.21:1 explicitly sets the display aspect ratio.

Output Pixel Aspect Ratio (MOV only). Select the pixel aspect ratio for QuickTime 
output:
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Custom enables you to explicitly set the Horizontal Pixel Spacing and Vertical Pixel 
Spacing. For example, a value of one in each field specifies a square, or 1:1 pixel. In 480 
SD video, you may use 10 horizontal, by 11 vertical pixels. In 576 SD video, you may use 
59 horizontal by 54 vertical pixels.

Automatic determines the pixel aspect ratio from the Image size and Output display 
aspect ratio.

Square sets a 1:1 pixel aspect ratio.

NTSC ITU-R Rec. 601 | NTSC ITU-R Rec. 601 (16:9) | PAL ITU-R Rec. 601 | PAL ITU-R Rec. 601 
(16:9) sets the appropriate pixel aspect ratios for television standards.

Horizontal Pixel Spacing. When Output Aspect Ratio is set to Custom, enter an integer 
value to shape the pixel as a ratio of height to width, in conjunction with the Vertical 
Pixel Spacing value. 

Vertical Pixel Spacing. When Output Aspect Ratio is set to Custom, enter an integer 
value to shape the pixel as a ratio of height to width, in conjunction with the Horizontal 
Pixel Spacing value.
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Audio Codecs
This chapter describes each of the audio codecs provided in Episode, including a 
description of each user-configurable parameter.

Note: For a complete list of supported formats, see the Specifications document at 
http://www.telestream.net/episode/tech-specs.htm.

Some codecs require an Episode Pro or Episode Engine license, as indicated.

■ AAC Codec

■ AC-3 (ATSC A/52) Codec

■ AES Codec

■ AMR Codec

■ BWF Codec

■ Discard Option (Windows)

■ DV Audio Codec

■ Lame MP3 Codec

■ MPEG Audio Codec

■ Pass-through Option

■ PCM Audio Codec

■ OGG Vorbis Codec

■ WMA 9 Codec

http://www.telestream.net/episode/tech-specs.htm
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AAC Codec
Episode offers two levels of AAC codec support. Episode (standard version) includes 
AAC by Media Foundation (on Windows) or Core Audio (on Mac). These codecs support 
sample rates of 44.1 and 48 kHz only and low complexity. Episode Pro includes Pro AAC 
from Main Concept, which supports a wide range of sample rates and HE-AAC. 

AAC (Advanced Audio Coding) is one of two audio codecs specified in the 3GPP 
standard (the other is AMR). AAC is an excellent audio codec for music.

High Efficiency AAC HE-AAC, also known as aacPlus, is an extension of the AAC file 
format using two new coding techniques: Spectral Band Replication (SBR) and 
Parametric Stereo. HE-AAC is only partly backwards compatible, as playback of HE-AAC 
files on AAC decoders is possible, but high frequencies are not reconstructed, and only 
mono playback is performed, even if Parametric Stereo is used.

In High Efficiency mode, Spectral Band Replication is always used. SBR is a technique 
which copies the lower half of the audio frequencies to the higher half. A small amount 
of control data (about 2-4 Kbps) is added to make sure the reconstruction of the high 
frequencies are correct, or at least perceived to be correct. By doing so, the AAC 
encoder only has to encode the lower half of the spectrum, which enables encoding at 
lower bit rates. SBR is recommended for source files with sample rates of 32 kHz or 
higher, and target bit rates of 20-80 Kbps1. (At higher bit rates, regular AAC yields 
higher sound quality.) 

Note: Settings shown below are for Pro AAC. Standard AAC defaults to low 
complexity and cannot be changed. 

Pro AAC Codec Settings

Bit Rate. Select the output bit rate based on your input sample rate, determined by the 
table below. The bit rate and sample rate should be matched according to the 
following table.

1. Martin Dietz and Stefan Meltzer. CT-aacPlus—a state-of-the-art audio coding system. EBU Technical Review, July 
2002
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:

Mono sound is supported in the range of 8-160 Kbps, 2-channel stereo sound in the 
range 16-320 Kbps, surround sound in the range 160-640 Kbps, and 7.1channel 
surround sound in the range 224-640 Kbps.

AAC Mode. Select Low Complexity | High Efficiency. 

Keep Codec Delay. Check to enable codec delay. By design, AAC players skip a 
segment of data at the start of a file. This can be compensated by inserting empty data 
at the beginning—codec delay. This option should normally be enabled, but if your 
target player does not handle this well (your audio plays out of synch), test by encoding 
with Keep Codec Delay unchecked.

Parametric Stereo. When AAC Mode is set to High Efficiency, check to enable 
parametric stereo, an extension to SBR, which encodes stereo information in a very 
compact way (about 1-3 kb/s). The source file is converted to mono and encoded to 
AAC. Depending on the source material, parametric stereo can sometimes improve 
audio quality at very low bit rates. PS is only available for bit rates up to 56 kb/s. As the 
name implies, PS can only be applied to stereo source files. HE-AAC with PS is also 
known as EAAC+.

The bit rate and sample rate have to be matched, according to , Pro AAC Bit Rate and 
Sample Rates.

Pro AAC Bit Rate and Sample Rates

Bit Rate (Kbps) Mono Sample Rate (kHz) Stereo Sample Rate (kHz)

8 8-12 Mono only

16 8-24 8-12

20 11-24 8-12

24 11-32 11-24

28 11-32 11-24

32 11-48 11-24

40 16-48 16-32

48 22-48 22-32

56 22-48 22-48

64 32-48 32-48
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AC-3 (ATSC A/52) Codec
This codec is available only with the Episode Pro Audio option. AC-3 (ATSC A/52) is used 
on DVDs and is a leading format in movie theaters.

AC-3 (ATSC A/52) Settings

Bit Rate. Select the output bit rate from the dropdown menu. Range: 64 to 640 kbps.

Note: Only bit rates above 80 Kbps can be encoded as stereo or surround sound. 
Recommended bit rates for encoding without audible artifacts are 192 Kbps for stereo 
and 448 Kbps for 5.1 surround sound.

Dialog Normalization. Use the slider to select (or manually enter the value) to set the 
average audio level so that media players can adjust the gain. 

When combining material from different sources, ensure that the audio levels are 
normalized across sources. Typically the audio level of speech is considered as the base 
level. Set the value the average dialogue level in dB of full scale in the source material as 
indicated by your editor. 

A value of -31 is defined as a unit gain. For example, 0 dB attenuation, -1 = 30 dB 
attenuation.

Note: Setting the level does not modify audio content. It provides a gain value for the 
media player. If you need to adjust the audio levels within the track, use the Volume 
Filter.

DVB Style PMT Descriptor. Select for European System B standard audio coding for 
terrestrial broadcasting according to the ITU-R BS.1196-1 recommendation. 
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AES Codec

Note: This codec is available only in Episode Pro and Episode Engine.

The AES codec was designed by the Audio Engineering Society for serial digital 
transmission of stereo sound. Episode uses the SMPTE331M version.

AES Codec Settings

Bit Depth. Select 16 bit | 24 bit from the dropdown menu.
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AMR Codec

Note: The AMR codec is available only with Pro Audio Option.

AMR (Adaptive Multi-Rate) is a standard, mandatory audio codec in 3GPP.1 AMR is a 
speech format, designed for storing the spoken word but unlikely to give acceptable 
results for music audio.

Codecs

Mode: Sets the audio bit rate from 4.75 to 12.2 kbit/s (Mode 0 - Mode 7).

SID: Check to enable Silence Descriptor, a 1.8 kbit/s background noise non-
transmission mode.

1. Internet Engineering Task Force. RTP Payload Format and File Storage Format for Adaptive Multi-Rate (AMR) & 
Adaptive Multi-Rate Wideband Audio Codecs, 2007. www.rfc-editor.org

AMR (.amr) Codecs

Codec Episode Episode Pro Episode Engine Notes

AMR out out out Requires Pro Audio Option

http://www.rfc-editor.org/rfc/rfc4867.txt
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BWF Codec
The Broadcast Wave Format is based on the WAV format, extended with metadata 
fields.

BWF Codec Settings

Bit Depth. Select 16 bit | 24 bit from the dropdown menu.

Discard Option (Windows)
When the Discard option is selected from the Audio Codec dropdown menu, Episode 
does not decode the audio or pass it to the encoder. Thus, there is no audio stream in 
the output.

DV Audio Codec
DV Audio settings are dictated by the DV video settings. 

DV Audio Codec Settings

Sample Size. Select 12 bit | 16 bit from the dropdown menu.
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Lame MP3 Codec
MPEG-1 Layer III audio is popularly known as MP3. The Lame codec is one of the most 
extensively used implementations—see lame.sourceforge.net.

LAME MP3 Codec Settings

Encoding Type. Select from these options:

Bit Rate Based. Sets the average bit rate of the data and make other adjustments.

Lame Preset. Enables the Preset menu. Choose one of the options in the Preset menu, 
which sets all parameters to predefined values.

Preset. When encoding is set to Lame Preset, choose one of these options to set all 
parameters to predefined values.

R3Mix is a legacy setting used at http://www.r3mix.net/. It provides slightly better 
quality than the Medium setting.

Medium is an acceptable audio quality for most uses.

Medium Fast is a faster algorithm than Medium, but should give almost as good audio 
quality.

Standard is a good audio quality for normal use.

Fast Standard is a faster algorithm than Standard, but should give almost as good audio 
quality.

Extreme is the best audio quality for high-quality equipment.

http://lame.sourceforge.net/
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Fast Extreme is a faster algorithm than Extreme but usually provides almost as good 
audio quality.

Insane is the absolutely best audio quality, requiring very high bandwidth.

Bit Rate. When encoding is set to Bit Rate Based, select the bit rate from the dropdown 
menu. Range: 16 to 320 kbit/s.

Setting Type. Select from these options:

Standard Settings use suitable default settings for your chosen bit rate. and disable all 
advanced settings in this codec.

Advanced Settings enable all advanced settings and allow you to adjust the following 
parameters:

Quality. Use the slider (or manually enter the value) to set the quality of the encoding. 
Better quality implies slower algorithms. Range: 0 (Best) to 9 (Worst), in Lame parlance.

Mode. Select Constant Bit Rate (CBR) | Variable Bit Rate (VBR).

Minimum VBR Bit Rate. When VBR is selected, select the minimum bit rate from the 
dropdown menu.

Maximum VBR Bit Rate. When VBR is selected, select the maximum bit rate from the 
dropdown menu.

Stereo Mode. Select from these options: 

Stereo encodes each stereo channel separately.

MS Stereo Uses mid/side encoding, where the shared content of the stereo channels are 
coded in higher resolution than the difference between them; this decreases the 
bandwidth requirements for low bit rates (< 128 Kbps) and small stereo separations.

Joint Stereo decides, frame by frame, whether to use separated stereo or MS stereo.

Copyright Flag. Check to tag the material as copyrighted.

Original Flag. Check to tag the material as original, When unchecked, the material is 
tagged as a copy.

Lame Tag. Check to write metadata on the encoding to the output. The Lame tag is 
backwards compatible with the Xing header.

Error Protection. Check to activate CRC error protection. This allows reconstruction of 
lost packets, but requires slightly more bandwidth to encode the error protection data.
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MPEG Audio Codec
The MPEG-1 standard defines three layers of audio encoding (ISO11172-3).The first two 
layers, sometimes known as MP1 and MP2, are encoded with this codec. Layer III, MP3, 
is encoded with the Lame encoder. See MP3 (.mp3).

An accessible introduction to MPEG audio encoding is provided in an MPEG tutorial by 
Davis Pan1.

MPEG Audio Codec Settings

Bit Rate. Select the bit rate from the dropdown menu.

Note: Not all bit rates are available for both layers.

Layer. Select from these options:

Layer I uses a simpler encoding method that works best for higher bit rates.

Layer II uses a more complex encoding method that compresses better.

Psycho model. The psycho-acoustic model is used to determine the features of the 
sound that are inaudible and therefore can be compressed away. Select from these 
options:

Model uses a simpler model which provides slightly lower quality results for less 
computation.

Model 2 uses a model that requires more computation but provides better results.

The setting of the Sample Rate Filter determines the sample rates. Rates from 16 to 24 
kHz are encoded as MPEG-2 audio, sample rates from 32 to 48 kHz are encoded as 
MPEG-1.

1. Davis Pan. A tutorial on MPEG/audio compression. IEEE Multimedia, 2(2):60—74, Summer 1995.
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Pass-through Option
When the Pass-through option is selected from the Audio Codec dropdown menu, 
Episode extracts the audio stream from the input file, and passes it through untouched, 
and inserts it into the output file. That is, no decoding or encoding of the audio stream 
occurs.

PCM Audio Codec
PCM is an uncompressed audio format.

PCM Audio Codec Settings

PCM Format. Select the PCM encoding format from the dropdown menu.

Note: Not all container formats support all forms of PCM encoding. The selected 
encoding may be quietly converted into another encoding supported by the selected 
output format.

Split Channels In Output. Select from the drop-down menu to place stereo and 
surround sound channels in separate audio tracks. This applies only when producing 
QuickTime (mov) files. For all other formats the setting is ignored.

No - Outputs audio with 7.1 labels

Yes - Outputs audio as discrete channels without labels (channel positions).

Yes, and flag as discrete - Outputs as discrete channels with labels (channel positions) as 
Discrete- x where x is 0 to 7 (that is, Discrete-0, Discrete-1... Discrete-7).

Note: The Split Channels in Output feature should not be used with the Channel or 
Channel Mapper audio filters.
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OGG Vorbis Codec
Vorbis is a free audio codec for lossy compression (Vorbis-I).

Vorbis Codec Settings

Encoding Type. Select from the following options:

Bit Rate Based. Uses the average rate over the period set by the values specified in Bit 
Rate, Max. Bit Rate, and Min. Bit Rate fields.

Quality based uses the value set in the Quality field.

Quality. When using quality-based encoding, use the slider (or enter the value 
manually) to specify the audio quality as a percent, from 0 (most compression, lowest 
quality) to 100 (least compressed, highest quality). A lower quality setting requires less 
bandwidth, but lowers the quality of sound reproduction.

Bit Rate. When using bit rate-based encoding, use the slider (or enter the value 
manually) to specify the target bit rate for the audio. The codec generates the best 
audio quality possible for this bit rate.

Max Bit Rate. When using bit rate-based encoding, use the slider (or enter the value 
manually) to specify the maximum allowed bit rate.

Min Bit Rate. When using bit rate-based encoding, use the slider (or enter the value 
manually) to specify the minimum allowed bit rate.
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WMA 9 Codec
Episode supports Windows Media Audio 9 with Standard, Professional, and Lossless 
output selections and constant or variable bit rate selections. 

WMA9 Codec Settings

Windows Media Audio Version. Select from the following options:

Windows Media Audio 9 Standard encodes the audio in WMA 9 Standard format. WMA 9 
Standard supports One Pass, Constant Bit Rate (CBR) and One Pass, Variable Bit Rate (VBR) 
encoding methods with up to two discrete channels (stereo). 

Windows Media Audio 9 Professional encodes the audio in WMA 9 Professional format. 
WMA 9 Professional supports multiple channels, at sample rates above 48 kHz and 
wider than 16 bit samples and up to eight discrete channels for 7.1 channel surround 
sound. However, it is often not available on lower-end platforms, such as mobile 
phones. Offers selection of constant or variable bit rate.

Windows Media Audio 9 Lossless encodes the audio as uncompressed, thus preserving 
all of the original content. The final bit rate is dependent on the source. WMA 9 Lossless 
supports One Pass, Variable Bit Rate (VBR) encoding.

Method/Coding Mode. Selections are one-pass constant bit rate (CBR) or one-pass 
variable bit rate (VBR).

Settings. Selects the bit rate, sample rate, and number of channels. Choose a profile, 
consisting of fixed combinations of audio quality, bit rate, bit depth and sampling 
frequency.
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Audio Filters
This chapter describes each of the audio filters in Episode.

■ Audio Speed Filter

■ Balance Filter

■ Channel Configurator Filter

■ Equalizer Filter

■ Fade Filter

■ High Pass/Low Pass Filter

■ Offset Filter

■ Sample Rate Filter

■ Volume Filter

■ Appendix: Default Channel Maps

Audio filters apply transformations to the audio track(s) in the source file, before it is 
encoded. Activated filters are applied to your audio in the order they are listed in the 
Inspector panel, from top to bottom.

You select a filter to display its properties in the inspector. You activate a filter by 
checking its checkbox, and de-activate it by unchecking the box. You can only alter the 
values of an active filter.

Note: Codecs encode the output after audio filters have been applied to your input 
media (as it is being decoded). Thus, if you set the channels filter to mono and your 
codec is set to produce stereo, the audio track is first folded into mono, and this mono 
track is then replicated to make two stereo tracks—probably not the result you 
intended.

Click the question mark to display online help  for the filter.
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Audio Filters are Applied Sequentially
Only activated filters are applied to your audio, and they are applied in the order they 
are listed in the Inspector panel, from top to bottom.

This process is depicted in the figure below:

Audio Filter Application to Audio Stream

In this example, the High Pass, Low Pass, and Volume filters are activated (and 
configured). First the High Pass filter is applied, knocking the high points off the audio. 
Next, the Low Pass filter knocks the low points off. Finally the Volume filter increases the 
overall volume of the altered audio stream.

With all the audio filters applied, the audio stream is passed to the encoder for 
encoding into the output stream.

Audio Speed Filter
Use the audio speed filter to adjust the speed of the audio track to match the video 
frame rate. In some cases, transcoding—decoding and encoding—may speed up or 
slow down the video speed (see Frame Rate Filter and Advanced Frame Rate Filter).

Audio Speed Filter Settings

Speed Change. Select a predefined speed conversion, or select Custom to specify a 
conversion rate not predefined.

Custom Speed (times original). When Custom is selected, enter a real number or 
integer multiplier for the speed change. Use negative values to slow the audio.
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Balance Filter
Use the balance filter to increase or attenuate the volume of one side of stereo audio 
over the other, to improve balance.

Balance Filter Settings

Panning. Use the slider (or set the value manually) to set the stereo panning towards 
the left or right audio channel, thus raising the volume of one pair over the other as 
specified, to improve balance. Range: -100 to 100.

The results of panning surround sound are undefined.

Channel Configurator Filter
Episode automatically maps audio channels from source to output during encoding 
according to the settings of the audio Channel Configurator filter. The Configurator lets 
you select Automatic or Manual channel mapping. 

Automatic Overview
• When Channel Mapping Mode is set to Automatic, Episode automatically maps the 

selected input audio channel layout (Input Channel Layout) to the selected output 
audio channel layout (Mix To). 

• The default is to automatically detect the inputs and mix to stereo at the outputs. 
You can easily change the input and output layouts using the dropdown menus.

• Automatic mode automatically maps the channels according to industry audio 
standards. See the chapter appendix for the standard mappings.

Manual Overview
• If your channel layout differs from industry standards, or you simply want to do 

your own mapping, you can change Channel Mapping Mode to Manual.

• Manual Channel Mapping lets you select a standard Channel Order (Episode or 
SMPTE), number of Input Channels, number of Maximum Output Channels Per Track, 
and number of Output Tracks. 

• Finally, you can Add Mapping (+ sign on Mac) one at a time to specify the exact 
mapping you want of each Channel In to each Channel Out and Track Out.
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Automatic Channel Mapping
Setting Channel Mapping Mode to enable the Automatic filter makes it easy to map 
standard input audio formats directly to standard output audio formats without setting 
up individual channels. Formats such as Stereo, 5.1, and 7.1 are already mapped for you 
and are available in the Input Channel Layout (input) and Mix To (output) drop-down 
menus.

To map input audio to output audio, follow these simple steps:

1. Assign an encoder to the workflow Encoder task, if you have not already done so.

2. In the Inspector, select Audio, check the Channel Configurator box, and click Channel 
Configurator to highlight it and open the channel configuration menus.

3. Leave the Channel Mapping Mode set to Automatic (default).

4. Use the Input Channel Layout drop-down menu to select the input channel 
configuration. 

Auto detect is usually the best choice if the input is a standard audio format. Episode 
detects the format automatically by examining the actual audio stream.

5. Use the Mix To drop-down menu to select the output channel configuration. 

That’s all there is to setting up audio channel mapping in most cases. Episode “knows” 
all of the audio encoder formats and automatically maps the correct input channels to 
the correct output channels. Usually if any input channels cannot be mapped to output 
channels, mapping fails and an error message indicates the cause.

Channel Mapping Mode. Select Automatic to allow Episode to map audio inputs to 
outputs using the input/output channel layouts you choose. Select Manual to map 
audio inputs to outputs yourself using the Manual Channel Mapping panel.

Input Channel Layout. Select Auto detect to let Episode automatically discover the 
source audio format by examining incoming audio, or select an input audio format: 
Auto detect | Mono | Stereo | Dual Stereo | 5.0 | 5.1 | Triple Stereo | 7.1 | 5.1 + Stereo | Quad 
Stereo | Discrete channels.

Mix to. Select an audio output format from the dropdown menu: Mono | Stereo | Dual 
Stereo | 5.0 | 5.1 | Triple Stereo | 7.1 | 5.1 + Stereo | Quad Stereo | Extract First Stereo Pair | 
Extract Second Stereo Pair | Extract Third Stereo Pair | Extract Fourth Stereo Pair. Not all 
selections are available for all codecs. The extract options allow you to select and 
extract audio from stereo pairs, used for purposes such as multiple languages.
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Automatic Channel Mapping Settings

Under the Hood of Automatic Channel Mapping
Audio mapping can be confusing with so many different audio formats. Episode 
automatic channel mapping is intended to simplify audio configuration. A brief 
discussion of Episode audio mapping may make this topic easier to understand.

Episode is a batch encoding system, not a one-shot conversion application. Its purpose 
is to allow users to set up the audio conversion in a workflow one time and then forget 
it. The audio mapping in the workflow should “just work” every time. 

Even though different input formats have different channel orders, all different input 
orders are transformed within Episode into a single internal format which is the same as 
AAC. That way the encoder always knows exactly what it's getting. When processing is 
complete, the audio channels are mapped back to each encoder’s native format.

Thus, no matter what your input format (such as PCM, AAC, or AC-3) and no matter 
what your target format, Episode handles the conversion automatically. You simply set 
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the Input Channel Layout to Auto detect or specify the input format and set the output 
format, and Episode handles the conversion and channel mapping automatically.

Note: Multiple track output is currently only supported by the PCM, AES and BWF 
audio codecs. If you choose a different codec, only the first track will be used. For 
example, if you choose 5.1 + Stereo in AAC, only a 5.1 track will be created.

For a complete listing of the default Channels filter mappings, please see Appendix: 
Default Channel Maps at the end of this chapter. For those who understand audio 
channel mapping, a quick look at the map list will tell you whether you can use the 
default Automatic Channel Mapping Mode or you must create your own map using 
Manual Channel Mapping.

Manual Channel Mapping
Generally, you should not have to set the Channel Mapping mode to Manual, since the 
Automatic setting includes virtually all the audio formats you need. The Automatic 
setting provides automatic source detection, conversion, and mapping from any 
standard input format to any standard output format. 

However, you may have workflows where you want to alter the channel mapping in a 
non-standard way. That is the purpose of the Manual mode. It allows you to map each 
input channel to each output channel and track.

CAUTION: Unless you must map custom channels, Telestream recommends that you 
use the Automatic mode to map one audio standard to another, eliminating the need 
for individual channel mapping. If you choose to use the Manual mode instead, you 
must manually map each channel. Channels that are not mapped are lost. 

To create manual mappings for audio channels, follow these steps:

1. Assign an encoder to the workflow Encoder task, if you have not already done so, 
and click the Encoder task to highlight it.

2. In the Inspector, select Audio.

3. Check the Channel Configurator box, and click Channel Configurator to highlight it. 

4. Change the Channel Mapping dropdown menu to Manual.

5. Select the Channel Order: Episode or SMPTE. 

Episode configures multichannel audio in AAC channel order:

5.1—1-C, 2-L, 3-R, 4-Ls, 5-Rs, 6-LFE

7.1—1-C, 2-L, 3-R, 4-Ls, 5-Rs, 6-Lsd, 7-Rsd, 8-LFE

SMPTE configures multichannel audio in SMPTE-320M channel order:
5.1—1-L, 2-R, 3-C, 4-LFE, 5-Ls, 6-Rs

7.1—1-L, 2-R, 3-C, 4-LFE, 5-Ls, 6-Rs, 7-Lsd, 8-Rsd
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6. Select the number of inputs from the Input Channels drop-down menu.

The standard channel assignments for the number of channels you select are 
displayed at the bottom of the panel. If your input channels do not match these 
standard 7.1 channel assignments, map them to the outputs according to their 
actual functions and your desired output configuration.

7. Select the maximum number of output channels per track from the Max Output 
Channels Per Track drop-down menu.

8. Select the number of output tracks from the Output Tracks drop-down menu.

9. Click + ( Mac) or Add Mapping (Win) to add as many mappings as the number of 
input channels you want to map. For example, add eight mappings for eight audio 
inputs.

10. For each mapping, select the input channel you want to map. Typically, for 8 
channels, your input selections will be 1–8.

11. For each input channel, map to (select) the desired output channel and track. 

Manual Channel Mapping Settings
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Channel Order—Selects Episode or SMPTE input channel order. A line of text at the 
bottom of the map shows the channel order for the selected number of inputs.

Input Channels—Selects the number of input channels to map. If the source has more 
channels than specified, additional channels are ignored.

Max Channels Out Per Track—Selects the maximum number of output channels to 
map in each track. The maximum is 24 channels. Even if you select the maximum, you 
do not have to map that many channels—fewer than the maximum are allowed.

Output Tracks—Selects the number of tracks. 

Add Mapping (Win)/+ (Mac)—Each click adds another channel mapping. For eight 
channels, click this button until eight mappings are added, and then map each channel. 
You can map any number of channels up to the maximum—fewer channels than the 
maximum are allowed.

Delete Mapping (Win)/X (Mac)—Click to delete the selected channel map.

Channel In/Channel Out/Track Out—Select the input channel number and then 
select the output channel number and track to which you want the input mapped.

Save—Saves the Inspector configuration.

Revert—Reverts to the previously saved Inspector configuration.
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Equalizer Filter
Use the equalizer filter to boost or cut each frequency band individually. The Equalizer 
Filter is a set of five filters, each with a fixed center frequency that cannot be changed.

Equalizer Filter Settings

Frequency Band (dB). Use the slider (or enter the value manually) to control the 
amount of boost (peak) or cut (notch) in each frequency band: 0.1, 0.3, 1.0, 3.0, and 10 
kHz. Range: -12 to 12.

Fade Filter
Use the fade filter to fade the audio in or out in the output file, up to 10 seconds at the 
beginning and end of the file.

Fade Filter Settings

Fade In Time. Use the slider (or set the integer value manually) to set the fade-in time 
in seconds from the beginning of the clip.

Fade Out Time. Use the slider to set the fade-out time in seconds from the end of the 
clip.
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High Pass/Low Pass Filter
Use the high pass/low pass filter to trim selected frequency thresholds from your 
output audio file. For example, you may want to enable high pass filtering and trim 
frequencies near the top range to eliminate hiss in the recording.

High Pass/Low Pass Filter Settings.

High Pass. Check to activate high pass filtering and cut off all frequencies below the 
specified threshold value you enter. Range: 10 Hz to 1000 Hz.

Low Pass. Check to activate low pass filtering, and cut off all frequencies above the 
threshold value you enter. Range: 1 to 20 kHz.

Offset Filter
Use the offset filter to advance or retard the audio track in the output file.

If the audio in your source is ahead or behind the video track, you can synch it using 
this filter.

Offset Filter Settings

Offset (ms). Use the slider (or enter the value manually) to provide a negative or 
positive offset (in milliseconds) to the audio track to compensate for timing differences 
between audio and video tracks.
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Sample Rate Filter
Use the sample rate filter to specify the audio sample rate in the output file. The audio 
sample rate is the number of samples per second in the audio track. Higher sample 
rates allow higher sound frequencies to be reproduced.

The Nyqvist frequency is the highest reproducible sound frequency, which is half the 
frequency at which the clip is sampled. For example, choosing 16 kHz as the sample 
frequency allows you to encode audible frequencies up to 8 kHz.

Note: Not all formats allow all sample rates supported by a given codec.

Sample Rate Filter Settings

Sample Rate. Select the audio sample rate to use in the output file from the options in 
the dropdown menu.
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Volume Filter
Use the volume filter to modify the volume of the audio tracks in the file.

Volume Filter Settings

Adjustment Mode. Select Normalize | Adjust in Percent | Adjust in dB from the dropdown 
menu.

Normalize. Select to analyze the audio stream by looking for the loudest peak in the 
audio channel and then encodes with this value as a reference, to avoid any clipping or 
distortion in the sound. Specify the percent in the slider below. For example, if set to 
90%, this option sets the highest peak in any audio channel at 90% of full volume and 
adjusts the rest of the channels in linear correspondence.

Adjust in percent. Select to change the volume by the percent you specify in the 
percent slider below. Set the slider to select the percent of change. The default value is 
0% (no change).

Adjust in dB. Select to change the volume by the dB you specify. Set the slider to select 
the dB of change. The default is 0 dB (no change).
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Appendix: Default Channel Maps
For advanced users who want the details of audio channel mapping, the following 
appendix presents the default mappings of the Channel Configurator filter.  

Channel Configurator Filter Notes
• Multiple track output is only supported by PCM, AES, and BWF audio.

• Automatic mapping should always be preferred over manual mapping. 

• When converting to Dual or Triple Stereo from sources that have more than 4 or 6 
channels, the extra channels will be dropped.

Channel Configurator Filter Mappings
The following pages list the built-in audio channel mappings.

MONO source to MONO:  
1 => Track 1, Channel 1 (Unused)

MONO source to STEREO: 
1 => Track 1, Channel 1 (Left)

1 => Track 1, Channel 2 (Right)

MONO source to DUAL STEREO:
1 => Track 1, Channel 1 (Left)

1 => Track 1, Channel 2 (Right)

1 => Track 2, Channel 1 (Left)

1 => Track 2, Channel 2 (Right)

MONO source to 5.0:
1 => Track 1, Channel 1 (Left)

1 => Track 1, Channel 2 (Right)

1 => Track 1, Channel 3 (Center)

1 => Track 1, Channel 4 (Left Surround)

1 => Track 1, Channel 5 (Right Surround)

MONO source to 5.1:
1 => Track 1, Channel 1 (Left)
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1 => Track 1, Channel 2 (Right)

1 => Track 1, Channel 3 (Center)

1 => Track 1, Channel 5 (Left Surround)

1 => Track 1, Channel 6 (Right Surround)

Channel 4 (LFE) out is empty (silent)

MONO source to TRIPLE STEREO:
1 => Track 1, Channel 1 (Left)

1 => Track 1, Channel 2 (Right)

1 => Track 2, Channel 1 (Left)

1 => Track 2, Channel 2 (Right)

1 => Track 3, Channel 1 (Left)

1 => Track 3, Channel 2 (Right)

MONO source to 7.1:
1 => Track 1, Channel 1 (Left)

1 => Track 1, Channel 2 (Right)

1 => Track 1, Channel 3 (Center)

1 => Track 1, Channel 5 (Left Surround)

1 => Track 1, Channel 6 (Right Surround)

1 => Track 1, Channel 7 (Left Surround Direct)

1 => Track 1, Channel 8 (Right Surround Direct)

Channel 4 (LFE) out is empty (silent)

MONO source to 5.1+Stereo:
1 => Track 1, Channel 1 (Left)

1 => Track 1, Channel 2 (Right)

1 => Track 1, Channel 3 (Center)

1 => Track 1, Channel 5 (Left Surround)

1 => Track 1, Channel 6 (Right Surround)

1 => Track 2, Channel 1 (Left)

1 => Track 2, Channel 2 (Right)

Channel 4 (LFE) out is empty (silent).
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MONO source to QUAD STEREO:
1 => Track 1, Channel 1 (Left)

1 => Track 1, Channel 2 (Right)

1 => Track 2, Channel 1 (Left)

1 => Track 2, Channel 2 (Right)

1 => Track 3, Channel 1 (Left)

1 => Track 3, Channel 2 (Right)

1 => Track 4, Channel 1 (Left)

1 => Track 4, Channel 2 (Right)

STEREO source to MONO:  
1 => Track 1, Channel 1 (Unused)

2 => Track 1, Channel 1 (Unused)

STEREO source to STEREO: 
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

STEREO source to DUAL STEREO:
1 => Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right)

STEREO source to 5.0:
1 => Track 1, Channel 1 (Left) + Channel 3 (Center) + Channel 4 (Left Surround) + 
Channel 5 (Right Surround)

2 => Track 1, Channel 2 (Right) + Channel 3 (Center) + Channel 4 (Left Surround) + 
Channel 5 (Right Surround)

STEREO source to 5.1:
1 => Track 1, Channel 1 (Left) + Channel 3 (Center) + Channel 5 (Left Surround) + 
Channel 6 (Right Surround)

2 => Track 1, Channel 2 (Right) + Channel 3 (Center) + Channel 5 (Left Surround) + 
Channel 6 (Right Surround)

Channel 4 (LFE) out is empty (silent)
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STEREO source to TRIPLE STEREO:
1 => Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left) + Track 3, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right) + Track 3, Channel 2 (Right)

STEREO source to 7.1:
1 => Track 1, Channel 1 (Left) + Channel 3 (Center) + Channel 5 (Left Surround) + 
Channel 7 (Left Surround Direct) + Channel 8 (Right Surround Direct)

2 => Track 1, Channel 2 (Right) + Channel 3 (Center) + Channel 6 (Right Surround) + 
Channel 7 (Right Surround Direct) + Channel 8 (Right Surround Direct)

Channel 4 (LFE) out is empty (silent).

STEREO source to 5.1+Stereo:
1 => Track 1, Channel 1 (Left) + Channel 3 (Center) + Channel 5 (Left Surround) + 
Channel 6 (Right Surround) + Track 2, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Channel 3 (Center) + Channel 5 (Left Surround) + 
Channel 6 (Right Surround) + Track 2, Channel 2 (Right)

Channel 4 (LFE) out is empty (silent).

STEREO source to QUAD STEREO:
1 => Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left) + Track 3, Channel 1 (Left) + 
Track 4, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right) + Track 3, Channel 2 (Right) 
+ Track 4, Channel 2 (Right)

DUAL STEREO source to MONO:  
1 => Track 1, Channel 1 (Unused)

2 => Track 1, Channel 1 (Unused)

3 => Track 1, Channel 1 (Unused)

4 => Track 1, Channel 1 (Unused)

DUAL STEREO source to STEREO: 
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 1 (Left)

4 => Track 1, Channel 2 (Right)
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DUAL STEREO source to DUAL STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

DUAL STEREO source to 5.0:
1 => Track 1, Channel 1 + Channel 3

2 => Track 1, Channel 2 + Channel 3

3 => Track 1, Channel 4

4 => Track 1, Channel 5

DUAL STEREO source to 5.1:
Not supported; Episode job will fail.

DUAL STEREO source to TRIPLE STEREO:
1 => Track 1, Channel 1 (Left) + Track 3, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 3, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

DUAL STEREO source to 7.1:
Not supported; Episode job will fail.

DUAL STEREO source to 5.1+Stereo:
Not supported; Episode job will fail.

DUAL STEREO source to QUAD STEREO:
1 => Track 1, Channel 1 (Left) + Track 3, Channel 1 (Left) + Track 4, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 3, Channel 2 (Right) + Track 4, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5.0 source to MONO:  
1 => Track 1, Channel 1 (Unused)
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2 => Track 1, Channel 1 (Unused)

3 => Track 1, Channel 1 (Unused)

4 => Track 1, Channel 1 (Unused)

5 => Track 1, Channel 1 (Unused)

5.0 source to STEREO: 
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 1 (Left) + Channel 2 (Right)

4 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5.0 source to DUAL STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 1 + Channel 2

4 => Track 2, Channel 1 (Left)

5 => Track 2, Channel 2 (Right)

5.0 source to 5.0:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (Left Surround)

5 => Track 1, Channel 5 (Right Surround)

5.0 source to 5.1:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 5 (Left Surround)

5 => Track 1, Channel 6 (Right Surround)

Channel 4 (LFE) out is empty (silent).
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5.0 source to TRIPLE STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left) + Track 2, Channel 2 (Right)

4 => Track 3, Channel 1 (Left)

5 => Track 3, Channel 2 (Right)

5.0 source to 7.1:
1 => Track 1, Channel 1 (Left)+ Channel 7 (Left Surround Direct)

2 => Track 1, Channel 2 (Right) + Channel 8 (Right Surround Direct)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 5 (Left Surround) + Channel 7 (Left Surround Direct)

5 => Track 1, Channel 6 (Right Surround) + Channel 8 (Right Surround Direct)

Channel 4 (LFE) out is empty (silent).

5.0 source to 5.1+Stereo:
1 => Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right) 

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 5 (Left Surround)

5 => Track 1, Channel 6 (Right Surround)

Channel 4 (LFE) out is empty (silent).

5.0 source to QUAD STEREO:
1 => Track 1, Channel 1 (Left) + Track 4, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 4, Channel 2 (Right)

3 => Track 2, Channel 1 (Left) + Track 2, Channel 2 (Right)

4 => Track 3, Channel 1 (Left)

5 => Track 3, Channel 2 (Right)

5.1 source to MONO:  
1 => Track 1, Channel 1 (Unused)

2 => Track 1, Channel 1 (Unused)
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3 => Track 1, Channel 1 (Unused)

4 => Track 1, Channel 1 (Unused)

5 => Track 1, Channel 1 (Unused)

6 => Track 1, Channel 1 (Unused)

5.1 source to STEREO: 
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 1 (Left) + Channel 2 (Right)

4 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5 => Track 1, Channel 1 (Left) + Channel 2 (Right)

6 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5.1 source to DUAL STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

Channels 5 and 6 are dropped.

5.1 source to 5.0:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

5 => Track 1, Channel 4 (Left Surround)

6 => Track 1, Channel 5 (Right Surround)

Channel 4 (LFE) is dropped.

5.1 source to 5.1:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)
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5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

5.1 source to TRIPLE STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

5.1 source to 7.1:
1 => Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

2 => Track 1, Channel 2 (Right) + Channel 6 (Right Surround)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround) + Channel 7 (Left Surround Direct)

6 => Track 1, Channel 6 (Right Surround) + Channel 8 (Right Surround Direct)

5.1 source to 5.1+Stereo:
1 => Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

5.1 source to QUAD STEREO:
1 => Track 1, Channel 1 (Left) + Track 4, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 4, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)
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6 => Track 3, Channel 2 (Right)

TRIPLE STEREO source to MONO: 
1 => Track 1, Channel 1 (Unused)

2 => Track 1, Channel 1 (Unused)

3 => Track 1, Channel 1 (Unused)

4 => Track 1, Channel 1 (Unused)

5 => Track 1, Channel 1 (Unused)

6 => Track 1, Channel 1 (Unused)

TRIPLE STEREO source to STEREO: 
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 1 (Left)

4 => Track 1, Channel 2 (Right)

5 => Track 1, Channel 1 (Left)

6 => Track 1, Channel 2 (Right)

TRIPLE STEREO source to DUAL STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

Channels 5 and 6 are dropped.

TRIPLE STEREO source to 5.0:
1 => Track 1, Channel 1 (Left) + Channel 3 (Center)

2 => Track 1, Channel 2 (Right) + Channel 3 (Center)

3 => Track 1, Channel 1 (Left)

4 => Track 1, Channel 2 (Right)

5 => Track 1, Channel 4 (Left Surround)

6 => Track 1, Channel 5 (Right Surround)

Channel 4 is dropped.
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TRIPLE STEREO source to 5.1:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

TRIPLE STEREO source to TRIPLE STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

TRIPLE STEREO source to 7.1:
1 => Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

2 => Track 1, Channel 2 (Right) + Channel 6 (Right Surround)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround) + Channel 7 (Left Surround Direct)

6 => Track 1, Channel 6 (Right Surround) + Channel 8 (Right Surround Direct)

TRIPLE STEREO source to 5.1+Stereo:
1 => Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)
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TRIPLE STEREO source to QUAD STEREO:
1 => Track 1, Channel 1 (Left) + Track 4, Channel 1 (Left)

2 => Track 1, Channel 2 (Right) + Track 4, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

7.1 source to MONO:  
1 => Track 1, Channel 1 (Unused)

2 => Track 1, Channel 1 (Unused)

3 => Track 1, Channel 1 (Unused)

4 => Track 1, Channel 1 (Unused)

5 => Track 1, Channel 1 (Unused)

6 => Track 1, Channel 1 (Unused)

7 => Track 1, Channel 1 (Unused)

8 => Track 1, Channel 1 (Unused)

7.1 source to STEREO: 
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 1 (Left) + Channel 2 (Right)

4 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5 => Track 1, Channel 1 (Left)

6 => Track 1, Channel 2 (Right)

7 => Track 1, Channel 1 (Left) + Channel 2 (Right)

8 => Track 1, Channel 1 (Left) + Channel 2 (Right)

7.1 source to DUAL STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)
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Channels 5, 6, 7, and 8 are dropped.

7.1 source to 5.0:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

5 => Track 1, Channel 1 (Left) + Channel 4 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 5 (Right Surround)

7 => Track 1, Channel 4 (Left Back)

8 => Track 1, Channel 5 (Right Back)

7.1 source to 5.1:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 6 (Right Surround)

7 => Track 1, Channel 5 (Left Surround)

8 => Track 1, Channel 6 (Right Surround)

7.1 source to TRIPLE STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

Channels 7 and 8 are dropped.

7.1 source to 7.1:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)
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3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

7 => Track 1, Channel 7 (Left Surround Direct)

8 => Track 1, Channel 8 (Right Surround Direct)

7.1 source to 5.1+Stereo:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

7 => Track 2, Channel 1 (Left)

8 => Track 2, Channel 2 (Right)

7.1 source to QUAD STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

7 => Track 4, Channel 1 (Left)

8 => Track 4, Channel 2 (Right)

5.1+STEREO source to MONO:  
1 => Track 1, Channel 1 (Unused)

2 => Track 1, Channel 1 (Unused)

3 => Track 1, Channel 1 (Unused)

4 => Track 1, Channel 1 (Unused)

5 => Track 1, Channel 1 (Unused)
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6 => Track 1, Channel 1 (Unused)

7 => Track 1, Channel 1 (Unused)

8 => Track 1, Channel 1 (Unused)

5.1+STEREO source to STEREO: 
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 1 (Left) + Channel 2 (Right)

4 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5 => Track 1, Channel 1 (Left)

6 => Track 1, Channel 2 (Right)

7 => Track 1, Channel 1 (Left) + Channel 2 (Right)

8 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5.1+STEREO source to DUAL STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

Channels 5, 6, 7, and 8 are dropped.

5.1+STEREO source to 5.0:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

5 => Track 1, Channel 1 (Left) + Channel 4 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 5 (Right Surround)

7 => Track 1, Channel 4 (Left Surround)

8 => Track 1, Channel 5 (Right Surround)

Channel 4 (LFE) is dropped.

5.1+STEREO source to 5.1:
1 => Track 1, Channel 1 (Left)
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2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

5 => Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 6 (Right Surround)

7 => Track 1, Channel 5 (Left Surround)

8 => Track 1, Channel 6 (Right Surround)

Channel 4 (LFE) is dropped.

5.1+STEREO source to TRIPLE STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

Channels 7 and 8 are dropped.

5.1+STEREO source to 7.1:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

7 => Track 1, Channel 7 (Left Surround Direct)

8 => Track 1, Channel 8 (Right Surround Direct)

5.1+STEREO source to 5.1+Stereo:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)
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6 => Track 1, Channel 6 (Right Surround)

7 => Track 2, Channel 1 (Left)

8 => Track 2, Channel 2 (Right)

5.1+STEREO source to QUAD STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

7 => Track 4, Channel 1 (Left)

8 => Track 4, Channel 2 (Right)

QUAD STEREO source to MONO:  
1 => Track 1, Channel 1 (Unused)

2 => Track 1, Channel 1 (Unused)

3 => Track 1, Channel 1 (Unused)

4 => Track 1, Channel 1 (Unused)

5 => Track 1, Channel 1 (Unused)

6 => Track 1, Channel 1 (Unused)

7 => Track 1, Channel 1 (Unused)

8 => Track 1, Channel 1 (Unused)

QUAD STEREO source to STEREO: 
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 1 (Left)

4 => Track 1, Channel 2 (Right)

5 => Track 1, Channel 1 (Left)

6 => Track 1, Channel 2 (Right)

7 => Track 1, Channel 1 (Left)

8 => Track 1, Channel 2 (Right)
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QUAD STEREO source to DUAL STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

Channels 5, 6, 7, and 8 are dropped.

QUAD STEREO source to 5.0:
1 => Track 1, Channel 1 (Left) + Channel 3 (Center)

2 = > Track 1, Channel 2 (Right) + Channel 3 (Center)

3 = > Track 1, Channel 1 (Left)

4 => Track 1, Channel 2 (Right)

5 => Track 1, Channel 4 (Left Surround))

6 => Track 1, Channel 5 (Right Surround)

7 => Track 1, Channel 4 (Left Surround)

8 => Track 1, Channel 5 (Right Surround)

Channel 4 is dropped.

QUAD STEREO source to 5.1:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 6 (Right Surround)

7 => Track 1, Channel 5 (Left Surround)

8 => Track 1, Channel 6 (Right Surround)

QUAD STEREO source to TRIPLE STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)
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3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

Channels 7 and 8 are dropped.

QUAD STEREO source to 7.1:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

7 => Track 1, Channel 7 (Left Surround Direct)

8 => Track 1, Channel 8 (Right Surround Direct)

QUAD STEREO source to 5.1+Stereo:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

7 => Track 2, Channel 1 (Left)

8 => Track 2, Channel 2 (Right)

QUAD STEREO source to QUAD STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)
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7 => Track 4, Channel 1 (Left)

8 => Track 4, Channel 2 (Right)

8 CHANNEL DISCRETE source to MONO:  
1 => Track 1, Channel 1 (Unused)

2 => Track 1, Channel 1 (Unused)

3 => Track 1, Channel 1 (Unused)

4 => Track 1, Channel 1 (Unused)

5 => Track 1, Channel 1 (Unused)

6 => Track 1, Channel 1 (Unused)

7 => Track 1, Channel 1 (Unused)

8 => Track 1, Channel 1 (Unused)

8 CHANNEL DISCRETE source to STEREO: 
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 1 (Left) + Channel 2 (Right)

4 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5 => Track 1, Channel 1 (Left)

6 => Track 1, Channel 2 (Right)

7 => Track 1, Channel 1 (Left) + Channel 2 (Right)

8 => Track 1, Channel 1 (Left) + Channel 2 (Right)

8 CHANNEL DISCRETE source to DUAL STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

Channels 5, 6, 7, & 8 are dropped

8 CHANNEL DISCRETE source to 5.0:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)
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3 => Track 1, Channel 3 (Center)

5 => Track 1, Channel 1 (Left) + Channel 4 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 5 (Right Surround)

7 => Track 1, Channel 4 (Left Surround)

8 => Track 1, Channel 5 (Right Surround)

Channel 4 is dropped.

8 CHANNEL DISCRETE source to 5.1:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 6 (Right Surround)

7 => Track 1, Channel 5 (Left Surround)

8 => Track 1, Channel 6 (Right Surround)

8 CHANNEL DISCRETE source to TRIPLE STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

Channels 7 and 8 are dropped.

8 CHANNEL DISCRETE source to 7.1:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)
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7 => Track 1, Channel 7 (Left Surround Direct)

8 => Track 1, Channel 8 (Right Surround Direct)

8 CHANNEL DISCRETE source to 5.1+Stereo:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 => Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

7 => Track 2, Channel 1 (Left)

8 => Track 2, Channel 2 (Right)

8 CHANNEL DISCRETE source to QUAD STEREO:
1 => Track 1, Channel 1 (Left)

2 => Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

7 => Track 4, Channel 1 (Left)

8 => Track 4, Channel 2 (Right)

Channel Configurator Filter Details
Episode stores multichannel audio in AAC format:

• AAC 5.1 - C, L, R, Ls, Rs, LFE

• AAC 7.1 - C, L, R, Ls, Rs, Lsd, Rsd, LFE

QuickTime format for multichannel audio is different. Center is usually channel 3, and 
LFE is channel 4.

• QT 5.1 - L, R, C, LFE, Ls, Rs

• QT 7.1 - L, R, C, LFE, Ls, Rs, Lsd, Rsd

A rule of thumb when mapping channels is that Center channel is first, and LFE is 
always last.
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When mapping channels, consider the channel labels and not the specific channel 
numbers. 

Channel Mapping Examples
When mapping 5.1 to 5.1, or 7.1 to 7.1, while no channel mapper is needed, you would 
map all channels 1 to 1:

1 => Track 1, Channel 1

2 => Track 1, Channel 2

3 => Track 1, Channel 3

4 => Track 1, Channel 4

5 => Track 1, Channel 5

6 => Track 1, Channel 6

7 => Track 1, Channel 7

8 => Track 1, Channel 8

Example Mapping 7.1 to 5.1+Stereo: 

The Channel filter should be used. The mappings would be as follows:

1 => Track 1, Channel 1 (Center)

2 => Track 1, Channel 2 (Left)

3 => Track 1, Channel 3 (Right)?

4 => Track 1, Channel 4 (Left Surround)

5 => Track 1, Channel 5 (Right Surround)

6 => Track 2, Channel 1 (Left Surround Direct)

7 => Track 2, Channel 2 (Right Surround Direct)

8 => Track 1, Channel 6 (LFE)

Example Mapping 8 Channels to 8 Tracks, 1 Channel Each:

1 => Track 3, Channel 1

2 => Track 1, Channel 1

3 => Track 2, Channel 1

4 => Track 5, Channel 1

5 => Track 6, Channel 1

6 => Track 7, Channel 1

7 => Track 8, Channel 1
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8 => Track 4, Channel 1
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Troubleshooting Episode
The following topics explain how to resolve typical troubleshooting questions. If the 
suggested fixes don’t resolve an issue, or if you have an issue that is not listed below, 
please contact Telestream Customer Service (see Preface for contact information).

■ Episode won’t install.

■ Episode won’t run from my user account (Win).

■ Episode won’t transcode some of my files.

■ Episode supports my file type but won’t transcode it.

■ Episode reports a license error, but I have a valid license.

■ A preview error occurred: Could not find DefaultSource.mov.

■ Access Denied IOServer issues

■ Where should I direct my Pipeline stream?

■ Episode clustering and file sharing don’t work.

Episode won’t install.
Before you can install Episode, your system must meet certain prerequisites, including 
the correct operating system and supporting application versions. Review Installing 
Episode or the Episode download page at Telestream.net for a list of prerequisites, and 
make sure the required OS and software are installed before you attempt to install 
Episode.

Episode won’t run from my user account (Win).
If Episode indicates you do not have the proper privileges to run it, see the 
Configuration topic in Installing Episode. 

http://www.telestream.net
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Episode won’t transcode some of my files.
See Media Containers/Formats for a list of file types supported by Episode. Episode 
includes a very wide variety of codecs for most formats, but the file format you are 
attempting to decode or encode may not be supported.

Episode supports my file type but won’t transcode 
it.

If the file type is listed in Media Containers/Formats and the file still won’t transcode, 
verify that the file itself is not damaged by playing it in the appropriate player 
application. If the file is good, try transcoding it in Episode to a different output file 
format. Then transcode the resulting file in Episode to the desired output file format.

Note that Media Foundation Libraries require Windows Desktop Experience to be 
installed. If Desktop Experience is not installed, attempts to encode using AAC will fail 
with the following error message: “Failed: The AAC encoder requires "Desktop 
Experience" to be installed.” See the Installing Episode chapter, Pre-requisite Subsystems 
(Windows only), Desktop Experience for Desktop Experience installation details.

Episode reports a license error, but I have a valid 
license.

The license file may be corrupted. 

First, deactivate your license—select Preferences > License menu. Then, close Episode.

Next, delete the Episode Node.XML file from the Episode application data folder: 

• Windows: C:\ProgramData\Telestream\Episode 7\Node.xml

• Mac: ~/Library/Application Support/Episode/

Now, restart Episode, and reactivate your license using Preferences > License.

A preview error occurred: Could not find 
DefaultSource.mov.

Go to Episode Preferences and change Default Preview Source to DefaultSource.mov. 

• Windows: C:\Program Files\Telestream\Episode 7\bin\resources\Default-
Source.mov.

• Mac: Applications/Episode/Contents/Resources folder. 
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Access Denied IOServer issues
Active watch folder workflows may have their IOServer (the service that handles the 
actual sharing of locations in the cluster) time out because of inactivity if they are 
completely idle and haven't picked up any files for extended periods of time (default 7 
days). If this occurs, files dropped into the monitored location are picked up by the 
monitor service, but the IOServer no longer recognizes the location as a valid share and 
fails to process the files, causing an Access Denied error in the job. 

To resolve this issue, modify the <dynamic-share-keep-time> option in the 
IOServer.xml file to a higher value (in seconds).

The IOServer.xml file resides in these locations:

• MacOS X: ~/Library/Application Support/Episode/
(Lion users: if your library is hidden, run this terminal command:
chflags nohidden ~/Library)

• Windows 7|8|Server 2012: C:\ProgramData\Telestream\Episode 7\IOServer.xml

Change the number in this line of the IOServer.xml file to specify a timeout greater than 
604800 seconds (7 days—the current default value):

<dynamic-share-keep-time>604800</dynamic-share-keep-time>

For example, to set this option to one year, change it to 31449600.

Where should I direct my Pipeline stream?
Point your Pipeline output, which must be set to deliver TIFO files, to the same folder 
that will be watched by your Episode workflow. Episode's watch folder must be 
configured with the Encode While Ingest option enabled so it will pick up the TIFO file 
right away instead of waiting for it to be completed first. These are the steps:

1. Set Pipeline to deliver TIFO wrapped content.

2. Point the TIFO Pipeline output to the folder monitored by Episode. 

3. Set your Episode workflow to watch the Pipeline output folder, and select the 
Encode While Ingest option. This ensures the file is transcoded by Episode while it is 
being built by Pipeline instead of waiting until the file is complete.

Episode clustering and file sharing don’t work.
If the ports Episode uses for file sharing and clustering are blocked by the firewall, 
clustering and IO server file sharing are prevented. Episode may display, “Node Won’t 
Connect Error”.

Episode uses many ports between 40410 and 40440. Open your computer’s firewall 
configuration and set it to open these ports for Episode. The easiest way to do this is to 
specify that the range of ports from 40410 to 40440 should be open to Episode.

Also, try uninstalling and re-installing Bonjour if the issue is not the firewall.
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